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FOREWORD

The Government of India has set an ambitious target of imparting skills to 30 crores people, one out of every

four Indians, by 2020 to help them secure jobs as part of the National Skills Development Policy. Industrial

Training Institutes (ITIs) play a vital role in this process especially in terms of providing skilled manpower.

Keeping this in mind, and for providing the current industry relevant skill training to Trainees, ITI syllabus

has been recently updated with the help of Mentor Councils comprising various stakeholder's viz. Industries,

Entrepreneurs, Academicians and representatives from ITIs.

The National Instructional Media Institute (NIMI), Chennai has now come up with instructional material to

suit the revised curriculum for Interior Design & Decoration Trade Practical NSQF Level - 3

(Revised 2022) in Construction Sector. The NSQF Level - 3 (Revised 2022) Trade Practical will help the

trainees to get an international equivalency standard where their skill proficiency and competency will be

duly recognized across the globe and this will also increase the  scope of recognition of prior learning.

NSQF Level - 3 (Revised 2022) trainees will also get the opportunities to promote life long learning and skill

development. I have no doubt that with NSQF Level - 3 (Revised 2022)  the trainers and trainees of ITIs, and

all stakeholders will derive maximum benefits from these IMPs and that NIMI's effort will go a long way in

improving the quality of Vocational training in the country.

The Executive Director & Staff of NIMI and members of Media Development Committee deserve appreciation

for their contribution in bringing out this publication.

Jai Hind

Addl. Secretary/Director General (Training)
Ministry of Skill Development & Entrepreneurship,

Government of India.

         New Delhi - 110 001
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PREFACE

The National Instructional Media Institute (NIMI) was established in 1986 at Chennai by then Directorate

General of Employment and Training (D.G.E & T), Ministry of Labour and Employment, (now under Ministry

of Skill Development and Entrepreneurship) Government of India, with technical assistance from the Govt.

of the Federal Republic of Germany. The prime objective of this institute is to develop and provide instructional

materials for various trades as per the prescribed syllabi (NSQF LEVEL - 4) under the Craftsman and

Apprenticeship Training Schemes.

The instructional materials are created keeping in mind, the main objective of Vocational Training under

NCVT/NAC in India, which is to help an individual to master skills to do a job. The instructional materials are

generated in the form of Instructional Media Packages (IMPs). An IMP consists of Theory book, Practical

book, Test and Assignment book, Instructor Guide, Audio Visual Aid (Wall charts and Transparencies) and

other support materials.

The trade practical book consists of series of exercises to be completed by the trainees in the workshop.

These exercises are designed to ensure that all the skills in the prescribed syllabus are covered. The trade

theory book provides related theoretical knowledge required to enable the trainee to do a job. The test and

assignments will enable the instructor to give assignments for the evaluation of the performance of a trainee.

The wall charts and transparencies are unique, as they not only help the instructor to effectively present a

topic but also help him to assess the trainee's understanding. The instructor guide enables the instructor to

plan his schedule of instruction, plan the raw material requirements, day to day lessons and demonstrations.

In order to perform the skills in a productive manner instructional videos are embedded in QR code of the

exercise in this instructional material so as to integrate the skill learning with the procedural practical steps

given in the exercise. The instructional videos will improve the quality of standard on practical training and

will motivate the trainees to focus and perform the skill seamlessly.

IMPs also deals with the complex skills required to be developed for effective team work. Necessary care

has also been taken to include important skill areas of allied trades as prescribed in the syllabus.

The availability of a complete Instructional Media Package in an institute helps both the trainer and

management to impart effective training.

The IMPs are the outcome of collective efforts of the staff members of NIMI and the members of the Media

Development Committees specially drawn from Public and Private sector industries, various training institutes

under the Directorate General of Training (DGT), Government and Private ITIs.

NIMI would like to take this opportunity to convey sincere thanks to the Directors of Employment & Training

of various State Governments, Training Departments of Industries both in the Public and Private sectors,

Officers of DGT and DGT field institutes, proof readers, individual media developers and coordinators, but for

whose active support NIMI would not have been able to bring out this materials.

Chennai - 600 032      EXECUTIVE DIRECTOR
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INTRODUCTION

TRADE PRACTICAL

The trade practical manual is intented to be used in workshop . It consists of a series of practical exercises to be
completed by the trainees during the  course of the Interior Design & Decoration Trade  supplemented and
supported by instructions/ informations to assist in performing the exercises. These exercises are designed to
ensure that all the skills in compliance with NSQF LEVEL - 3

Module 1 - Basics of Interior Design and Functional Aspects

Module 2 - Furniture Design and Details

Module 3 - Planning of Residential Interior Spaces

Module 4 - Civil Components

Module 5 - Perspective Drawing and Basics of Computer

Module 6 - Basic of Auto CAD software and Preliminary Auto CAD Software

Module 7 - Civil Components (Ceiling & Flooring)

Module 8 - Joinery Details and Paints

Modfule 9 - Civil Components (Partition)

Module 10 - Plumbing and Sanitation, Lighting, Electrical & Air Conditioning

Module 11 - Commercial Interior Guidelines and Design

The skill training in the shop floor is planned through a series of practical exercises centred  around some practical
project. However, there are few instances where the individual exercise does not form a part of project.

While developing the practical manual a sincere effort was made to prepare each exercise which will be easy to
understand and carry out even by below average trainee. However the development team accept that there  is a scope
for further improvement.  NIMI, looks forward  to the suggestions from the experienced training faculty for improving
the manual.

TRADE THEORY

The manual of trade theory consists of  theoretical  information for the course of the Interior Design & Decoration
Trade.  The contents are sequenced according to the practical exercise contained in the manual on Trade practical.
Attempt has been made to relate the theortical aspects with the skill  covered in each exercise to the extent possible.
This co-relation is maintained to help the trainees to develop the perceptional capabilities for performing the skills.

The Trade theory has to be taught and learnt along with the corresponding exercise contained in the manual on trade
practical. The indicating about the corresponding practical exercise are given in every sheet of this manual.

It will be preferable to teach/learn the trade theory connected to each exercise atleast one class before performing
the related skills in the shop floor. The trade theory is to be treated as an integrated part of each exercise.

The material is not the purpose of self learning and should be considered as supplementary to class room  instruction.
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CONTENTS

Module 1 : Basics of Interior Design and Functional Aspects

1.1.01 Familarization with trade and institute 1
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geometrical solids 28
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1.1.13 How to make design 38

1.1.14 Design knowledge of interior in residential and commercial space
(i) Basic layout plan, (ii)  Elevation 40

1.1.15 Free hand sketches of graphic symbols for carpentry, plumbing and
electrical landscape 43

1.1.16 Rendering with pencil and pencil colour 47

Module 2 : Furniture Design and Details

1.2.17 Residential furniture design and detail 53

1.2.18 Commercial furnitures design and detail 56

1.2.19 Free hand sketches of graphic symbols of furniture 59

Module 3 : Planning of Residential Interior Spaces
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  Exercise No. Title of the Exercise                                      Learning   Page No.
                                                                     Outcome

1,2,3

4

5

6,7,8

9,10
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  Exercise No. Title of the Exercise                                      Learning   Page No.
                                                                     Outcome
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V-ray and Luminous software and prepare the power point skill
presentation 114

1.5.37 Prepare the power point animated presentation 136
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1.8.49 Recognize the tool &equipments uses in paints 218

1.8.50 Estimate quantity of materials used on surface and labour cost
for painting 222

Module 9 : Civil Components (Partition)

1.9.51 Design the full height and low height partition wall with different
construction and finishing material 224

1.9.52 Draw plan, Sectional plan front elevation of block board partition wall
with specification and dimension 230

Module 10 : Plumbing and Sanitation, Lighting, Electrical &

Air Conditioning

1.10.53 Layout the plumbing/Drainage/Sanitary plan 232

1.10.54 Make top plan, side & front elevation of santitary fittings with dimension 236

1.10.55 Free hand sketches of graphic symbols for plumbing 241

1.10.56 Layout plan of false ceiling with lighting position 243

1.10.57 Layout of electrical Accessories plan & elevation 245

1.10.58 Free hand sketches of graphic symbols for electrical 247

1.10.59 Layout plan of window and split A/C with Specification 249

Module 11 : Commercial Interior Guidelines and Design

1.11.60 Office design layout plan 252

1.11.61 Working details to furniture layout of office design project 257

1.11.62 Free hand sketch for office design project details 259

1.11.63 Rendering with Gradient & Hatches 261

11

12,13

14,15

16

17,18,19

20
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S.No. Learning Outcome Ref. Ex.No.

1 Appraise the importance of interior designing & drawing instruments,
drawing sheets, Lettering following safety precautions.
(Map Nos:IES/N9454) 1.1.01 - 1.1.06

2 Draft the Geometrical shapes and projection with the help of
engineering scale and free hand sketches. (Map Nos:IES/N9455) 1.1.07 - 1.1.12

3 Draft the design with the help of color scheme and apply with rules
and calculations. Analysis and uses of building materials.
(Map Nos:IES/N9456) 1.1.13 - 1.1.16

4 Draw furniture designing & detailing. (Map Nos:IES/N9457) 1.2.17 - 1.2.19

5 Draw residential plan with necessary working drawing.
(Map Nos:IES/N9458) 1.3.20 - 1.3.24

6 Draw different types of staircase. (Map Nos:IES/N9459) 1.4.25 - 1.4.27

7 Apply basic knowledge of structural part of building. (Map Nos:IES/N9460) 1.4.28 - 1.4.29

8 Draw doors and windows & details. (Map Nos:IES/N9461) 1.4.30 - 1.4.33

9 Draw one and two points perspective view. (Map Nos:IES/N9462) 1.5.34 - 1.5.35

10 Prepare power point presentation with animation. (Map Nos:IES/N9463) 1.5.36 - 1.5.37

11 Create object on 2D using tool bars, commands. (Map Nos:IES/N9464) 1.6.38 - 1.6.40

12 Draw different types of false ceiling by using CAD. (Map Nos:IES/N9465) 1.7.41 - 1.7.42

13 Draw different types of flooring by using CAD. (Map Nos:IES/N9466) 1.7.43 - 1.7.44

14 Draw different types of carpentry joints by using CAD. (Map Nos:IES/N9467) 1.8.45 - 1.8.47

15 Analyse and uses of paints polish and varnish. (Map Nos:IES/N9468) 1.8.48 - 1.8.50

16 Draw different types of partition wall by using CAD. (Map Nos:IES/N9469) 1.9.51 - 1.9.52

17 Draw plumbing and drainage details and sanitary fittings by using CAD.
(Map Nos:IES/N9470) 1.10.53 - 1.10.55

18 Draw lighting and electrical layout plan by using CAD.
(Map Nos:IES/N9471) 1.10.56 - 1.10.58

19 Draw air conditioning layout by using CAD./other software.
(Map Nos:IES/N9472) 1.10.59

20 Draw commercial interiors by using CAD. other software.
(Map Nos:IES/N9473) 1.11.60 - 1.11.63

LEARNING / ASSESSABLE OUTCOME

On completion of this book you shall be able to
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SYLLABUS

Duration Reference Learning
Outcome

Professional Skills
(Trade Practical)

with Indicative hours

Professional Knowledge
(Trade Theory)

Professional
Skill 10 Hrs;

Professional
Knowledge
06 Hrs

Appraise t h e
importance o f
interior designing &
drawing instruments,
drawing sheets, Lettering
following safety
precautions. (Map
Nos:IES/N9454)

1. Familiarization with the trade &
institute. (01 hrs)

2. Importance of trade training. (01
hrs)

3. Uses of tools, equipments &
instruments. (01 hrs)

4. Free hand sketches of objects.
(02 hrs)

5. Recognize & Layout of drawing
sheet including title card as an
example portrait & landscape.
(03 hrs)

6. Importance of Lettering with the
help of single stroke Gothic
Letter. (02 hrs)

Importance OF TRADE & necessity
of interior designing. In industry
Interior design as a profession
Modern interior design feature
Introduction of
tools and equipments, and raw
material their used. like drafting
board, T scale mini drafter (M.D.),
Set Square etc. p e n c i l l
etc(06 hrs.)

Professional
Skill 34 Hrs;

Professional
Knowledge
10 Hrs

Draft the Geometrical
shapes and projection
with the help of engineering
scale and free hand
sketches. (Map Nos:IES/
N9455)

Introduction to I n d i a n
Standards Institution
Code of practice for general interior
drawing.
Introduction & Importance of lines
i. Continuous thick & thin
line
ii. Dashed thin line
iii. Cutting plan line
iv. Long & short break line thick line
Basic knowledge of geometrical
shapes & lines. Definition of projection
Types of projection Parallel projection
i. Oblique
ii. Orthographic
iii. Axonometric
iv. Isometric
Definition: -
i. Layout of plan
ii. Elevation (Front & side elevation)
(10 hrs.)

7. Draw different types of lines by
Free hand. (04 hrs)

8. Introduce the scale MKS and FPS
for making the drawing. (06 hrs)

9. Draw the simple composition o f
geometrical object with help of
scale. (06 hrs)

10.Draw the simple exercise using
lines in different angles. (04 hrs)

11. Draft the plan, elevation
& sectional elevation & isometric view

of geometrical s o l i d s .
Regular, Irregular shapes. (10 hrs)
i. Cube
ii. Cuboids
iii. Triangular prism
iv. Cylinder
v. Pyramid
vi. Hexagonal prism
vii. Hexagonal Pyramid
viii.Cone

12. Free hand sketches
of graphic symbols. (04 hrs)

Professional
Skill 50 Hrs;

Professional
Knowledge
12 Hrs

Draft the design with the
help of color scheme and
apply with rules and
calculations.

Analysis and uses of
building materials. (Map
Nos:IES/N9456)

Functional designing of
interiors:

13.How to make design: - (12 hrs)
i. Flow of circulation chart

(Bubble diagram)
ii. Concept of d e s i g n ,

pattern, colour
iii. Designing of space with furniture

layout
14.Design knowledge of interior in

residential & commercial. (20 hrs)

Principle of elements and interior
design:
Introduction of basic interior design.
i. Elements- example: line, etc.
ii. Principle of design example:
balance, emphasis etc.
Colors:
Types of color schemes based on the
color wheel.
i. triad colour scheme:
a) Primary.
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i. Basic layout plan.
ii. Elevation.
15.Free hand sketches of Graphic

symbols for landscape and building
materials. (12 hrs)

16.Rendering with pencil and pencil
colour. (06 hrs)

b) Secondary.
c) Tertiary.
ii. related colour scheme:
a) Analogues.
b) Monochromatic.
c) Achromatic.
d) Neutral.
iii. contrasting:
a) Complementary.
b) Split complementary.
c) Double split
d) Complementary.
e) Cool colour, warm colour.
Understand the psychological affects by
different colours on different person and
places.
Introduction of Graphic symbols in interior.
Understand impartance of building
materials (12 hrs.)

Professional
Skill 48Hrs;

Professional
Knowledge
10 Hrs

Draw fu rn i tu re
designing &
detailing.
(Map Nos:IES/
N9457)

Furniture design and detail:
17.Residential furniture. Table, chair,

sofa, cabinet, bed, wardrobe, dining
table,wall unit. (20 hrs)

18.Commercial furniture. Executive
table/ office table, Reception table,
cabinet storage, Display unit. (23
hrs):

Note: Necessary practical training will
be carried out on site.

19.Free hand sketches o f
graphic symbol of furniture (5hrs)

Furniture design:
Furniture styles:
i. Traditional/classic style.
ii. Ethnic style.
iii. Contemporary style. Types of furniture:
i. Daily uses furniture
ii. Loose carpentry furniture.
iii. Fixed carpentry furniture.
iv. Multi-utility storage
v. Open & closed storage Importance of

anthropometric and ergonomics.
(10 hrs.)

Professional
S k i l l
100Hrs;

Professional
Knowledge
23Hrs

Draw residential
plan with necessary
working d raw ing .
(Map Nos:IES/
N9458)

Drafting of Residential Plan (Any
Room):
20.Concept plan with circulation flow

(Bubble Diagram). (10 hrs)
21.Basic furniture layout plan with

working drawing. (20 hrs)
22.Wall elevation with dimension a n d

specification. (20 hrs)
23.Necessary details. (30 hrs)
24.Rendering the plan & elevations.

(20 hrs)

Planning of Interiors:
Space selection for circulation and furniture.
Selection of furniture according to
functional space.
Uses of furniture templates. (22 hrs.)

Professional
Skill 28 Hrs;

Professional
Knowledge
06 Hrs

Draw different types
of staircase. (Map
Nos:IES/N9459)

25. Prepare drawing w i t h
technical details of
the

R.C.C. Stair case. (14 hrs)
i. Straight Staircase.
ii. Open newel Staircase.
iii. Dog legged Staircase.
iv. Bifurcated Staircase.
26.Calculation of Staircase (tread

and riser). (10 hrs)
27.Model of staircase (4hrs)

Stair case:
Requirement and placement of good
Staircase.
Basic terminology of R.C.C.
Staircase.
Types of Staircase.
i. Straight.
ii. Quarter turn
iii. Half turn (Dog legged)
iv. Three quarter turn
v. Bifurcated
vi. Open newel.
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vii. Geometrical
viii.Circular
ix. Spiral.
Model of Staircase: - Demonstration
of R.C.C. Staircase with the help of
respective models. (06 hrs.)
Basic knowledge & importance in PPT/
video presentation
i. Mezzanine floor
a) Temporary
b) Semi permanent
ii. Stone masonry & types
iii. Brick masonry & bonds
• Stretcher bond
• Header bond
• English bond
• Flemish bond
• Raking bond
• Zigzag bond
iv. Lintels & types
v. Arches & types and

terminology
vi. foundation (06 hrs.)

Professional
Skill 36 Hrs;

Professional
Knowledge
06 Hrs

Apply b a s i c
knowledge o f
structural part of
building.
(Map Nos:IES/
N9460)

Preparing drawing:
28.Basic concept of section of a building

through toilet & balcony introducing
the beam & column. (20 hrs) and
kitchen

29.Preparing of drawings i)types of brick
bond

ii) English and Flemish bond
iii) lintals & arches
iv) foundation drawing (16hrs)

Professional
Skill 48 Hrs;

Professional
Knowledge
12 Hrs

Draw doors
and windows &
details. (Map
Nos:IES/N9461)

30. Model of Door window: -
Demonstrate doors and windows with the

help of respective models. (04 hrs)
31.Preparing of plan, elevation & section

of door (16 hrs)
i. Panelled door
ii. Glazed or sash
iii. Flush door
32.Preparing of plan, elevation & section

of window. (16 hrs)
i. Casement window with

ventilator (wooden)
ii. Sash window (wooden)
iii. Sliding window (aluminium)
33.Free hand sketches of graphic &

symbols for doors and windows
(12hrs)

Wooden Doors & Windows
Introduction of hardware fitting in
door & windows with dimension
Types of Doors
i. Batten and ledged door
ii. Framed and panelled door
iii. Glazed or sash door
iv. Flush door
v. Louvered door
vi. Wire gauged door
vii. Revolving
viii.Sliding (Aluminium)
ix. Swing door/ floor spring door
Placement of door & windows regarding
circulation of space Definition of technical
terms of doors & window
Size of doors & windows,
ventilators
Types of windows
• Fixed window
• Casement window
• Sliding window
• Sash window
• Louvered window
• Metal window
• Bay window
• Corner window
• Dormer window
• Gable window
• Sky light window Fixture and fastening
a) hinges, b) bolts, c) handles d) locks
(12 hrs.)
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Professional
Skill 30 Hrs;

Professional
Knowledge
10Hrs

Draw one and two
points perspective
view. (Map Nos:IES/
N9462)

Preparation of drawing
34.Draft one-point perspective view with

approximate method (any room).
(20hrs)

35.Render   the    perspective view with
any medium. (10 hrs)

Computer & drawing software
36.Installation and use of software i.e.

Coral Draw, Photoshop and Sketch
up,3D's Max with V-ray and Luminous
Prepare the power point s t i l l
presentation. (26 hrs)

37.Prepare the power point animated
presentation. (20 hrs)

Projection
Perspective projection definition
i. 1 point
ii. 2 point
iii. 3 point
(Describe the o n e - p o i n t
perspective with approximate method)
Definition
i. Ground plane
ii. Station point
iii. Picture plane
iv. Horizontal plane
v. Ground line
vi. Horizontal line or eye level
Vanishing point (10 hrs.)

Professional
Skill 46 Hrs;

Professional
Knowledge
12 Hrs

Prepare
power point
presentation with
animation. (Map
Nos:IES/N9463)

Computer & drawing software
36.Installation and use of software i.e.

Coral Draw, Photoshop and Sketch
up,3D's Max with V-ray and Luminous
Prepare the power point s t i l l
presentation. (26 hrs)

37.Prepare the power point animated
presentation. (20 hrs)

Knowledge of Computer and software
Microsoft Power point, commands and
their uses. Basic introduction of 3 DMax
(12 hrs.)

Professional
S k i l l
110Hrs;

Professional
Knowledge
23 Hrs

Create object on 2D
using tool bars,
commands. (Map
Nos:IES/N9464)

2D Software training-
38.Installation of AUTOCAD software. (10

hrs)
39.Elementary commands and menus

of AUTOCAD software. (45 hrs)
40.Drawing practice on AUTOCAD

software.Drawing practice on AUTO
CAD or other software (55 hrs)

Preliminary Drawing in AUTO CAD
i) 2D commands and use of
different menus.
ii) Concept of 2D drawing.
iii) Concept of rendering. (23 hrs.)

Professional
Skill 40 Hrs;

Professional
Knowledge
10 Hrs

Draw different types
of false ceiling by
using CAD.
(Map Nos:IES/
N9465)

Preparing of drawing with AUTOCAD and
user software
Installation and uses of software i.e. coral
drawing, photoshop and sketches up 30
s mac with v.rag anf lumion
40.drawing practice on AUTOCAD and

other software
41.Design a false ceiling in a room. (20

hrs)
42.Specify the level and section and

finishing material (laminate, veneer,
paints). (20 hrs)

Ceiling
Definition of false ceiling to understand the
job fabrication installation process of false
ceiling with Gyp board / POP board / Ply /
Wood
Types of ceiling
i. Grid
ii. Coffered
iii. Cove
iv. Plain
Finishing materials used for false ceiling.
Laminate, veneer, stone, glass, acrylic
sheet, MDF, paints, wall paper, fabric,
stainless steel, wood. (10 hrs.)

Professional
Skill 40 Hrs;

Professional
Knowledge
10 Hrs

Draw different types
of flooring by using
CAD. (Map
Nos:IES/N9466)

Preparing of drawing with AUTOCAD
and user software
43.Design a flooring pattern with finishing

material (Marble, Vitrified tile, PVC.
Laminated). (30 hrs)

44.Specify the starting point of flooring
and Specify the dimension & sizes.
(10 hrs)

Types of floor finishing
i. Stone ii. Marble
iii. Mosaic iv. Vinyl
v. Vitrified tiles vi. Ceramic tiles
vii. PVC viii. Carpet
ix. Laminated x. Glass
(10 hrs.)
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(xiv)

Professional
Skill 36 Hrs;

Professional
Knowledge
10 Hrs

Draw d i f f e r e n t
types of carpentry
joints by using CAD.
(Map Nos:IES/
N9467)

Drafting simple joints used in furniture
45.Drafting details drawing of different

types of joints. (20 hrs)
46.Draft a sheet of door/ window/ chair/

table/ bed (any one) (14 hrs)
47.Model of carpentry

joints.Demonstration of Stair Case with
the help of respective models (2hrs)

Carpentry joints
Types of joints
i. Butt joint
ii. Mitre joint
iii. Lap joint
iv. Mortise and Tenon joint
v. Tounge and groove joint
vi. Housed joint
vii. Cross joint Joints used in furniture
Joints used in doors/ windows/ ventilators.

Professional
Skill 20 Hrs;

Professional

Knowledge
06 Hrs

Analyse and uses of
paints polish and
varnish. ( M a p
Nos:IES/N9468)

Generate Power Point Presentation
for Paint, Polish and Varnish -
48. Practicing    processes     &

techniques of paints, polishing &
varnishing on surfaces. (12 hrs)

49.Recognize the tool & equipment and
their uses. (02 hrs)

50.Estimate quantity of materials used
on surface and labour cost. (06 hrs)
NOTE: - necessary practical
training will be carried out on
site.

Paints and polishing/varnishing:
What is paint Types of paints
i. Synthetic enamel ii. Acrylic Emulsion
iii. distemper iv. Epoxy
v. Nitro Cellulose vi. Metallic
vii. Texture viii. Lime wash
ix. Exterior paint Painting techniques
i. By Brush ii. By Roller
iii. By spray gun
Paintings defeats and remedies.
Introduction of polish and varnish:
Method of preparation and types of polish
on wood.
Types of varnishes:
i. Oil ii. Spirit
iii. Turpentine iv. Melamine
v. PU (polyurethane) (06 hrs.)

Professional
Skill 36 Hrs;

Professional
Knowledge
10 Hrs

Draw d i f f e r e n t
types of partition wall
by using CAD. (Map
Nos:IES/N9469)

51.Design the full height and low height
partition wall with different
construction and finishing materials.
(18 hrs)

52.Draft Plan, sectional plan, front
elevation and section with
specification and dimension. (18 hrs)

Partition wall:
Introduction of partition wall Property of a
good partition wall
Types of partition wall
i. Brick partition
ii. Glass partition
iii. Timber or wooden partition
iv. Aluminium partition (10 hrs.)

Professional
Skill 28 Hrs;

Professional
Knowledge
06 Hrs

Draw plumbing and
drainage details and
sanitary fittings by
using CAD. (Map
Nos:IES/N9470)

53. Layout the plumbing / drainage
/Sanitary plan and
sectional elevation. (10 hrs)
54.Make Top plan, side elevation, and

front elevation of all sanitary plumbing
fittings with dimension. (12 hrs)

55.Free hand sketches of graphic
symbols for plumbing and sanitary
(06hrs)

Plumbing:
Purpose and principle of house drainage.
Types of   Drainage   plumbing system
i. One pipe system
ii. Single stack system
iii. Single stack ( p a r t i a l l y
ventilated system)
iv. Two pipe system
Sanitation:
Traps
i. Gully trap
ii. Intercepting trap
iii. Grease trap
iv. Floor trap or Nahni trap Waste water
disposal:
i. Inspection chamber
ii. Septic tank Pipes:
i. Soil pipe
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(xv)

ii. Waste water pipe
iii. Rain water pipe Sanitation fitting:
i. Wash basin
ii. Sink
iii. Bath tub
iv. Water closet
v. Urinals
vi. Flushing cisterns (06 hrs.)

Professional
Skill 36 Hrs;

Professional
Knowledge
10 Hrs

Draw lighting and
electrical
layout plan by using
CAD. (Map
Nos:IES/N9471)

56.Layout plan of false ceiling with lighting
position, dimensions a n d
specifications. (16 hrs)

57.Layout of electrical plan & elevation
along with switch board, electrical
fittings & light fittings on wall with
dimension. (15 hrs)

58.Free hand sketches of graphic
symbols for electrical (05hrs)

Lighting:
Introduction of natural a n d
artificial light.
Differenttypes of l i g h t i n g
arrangements
i. Direct lighting
• Angular lighting
• Down lighting
• Eyeball fitting
• Track lighting
• Shade lighting
ii. Indirect lighting
iii. Diffused lighting
iv. Concealed lighting Varity of lampsi.
Incandescent
ii. Tungsten halogen
iii. Florescent
iv. Mercury
v. Sodium vapour
vi. LED
Electrical accessories
i. Switches & sockets with box
ii. DB (distribution board) & MCB
iii. Lamp holders
iv. Ceiling roses
v. Introduction of LAN/ CCTV/

Biometric/ Speaker/ Smoke
Detector (10 hrs.)

Professional
Skill 28 Hrs;

Professional
Knowledge
06 Hrs

Draw a i r
conditioning layout
by u s i n g
C A D . / o t h e r
software.
(Map Nos:IES/
N9472)

59 Layout plan of window and Split air
Conditioning with specification.
(28 hrs)

Air conditioning:
Introduction of Air Conditioning Principle of
Air Conditioning Types of Air Conditioning
i. Window Air Conditioning
ii. Split Air Conditioning
iii. Centralised Air Conditioning
iv. Cassette Air Conditioning (06 hrs.)

Professional
Skill 36 Hrs;

Professional
Knowledge
10 Hrs

Draw commercial
interiors by using
CAD. o t h e r
software. (Map
Nos:IES/N9473)

Office design project: -
60.Layout plan and Elevations. (06 hrs)
61.Necessary working details to execute

the project smoothly. (10 hrs)
62.Free hand sketch for necessary

details. (10 hrs)
63.Rendering with gradient & hatches.

(10 hrs)

Planning of c o m m e r c i a l
interiors: -
Introduction of office building.
Offices-
i. Interior designer/Architect
ii. Lawyer office
iii. Administration Room
iv. Hotel waiting lounge
Follow design guidelines and office space
standard. (10 hrs.)
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(xvi)

Professional
Knowledge
WCS- 32
Hrs.

Workshop Calculation & Science: 32 Hrs.

Demonstrate basic
m a t h e m a t i c a l
concept and
principles to perform
practical operations.

Understand and
explain basic
science in the field
of study. (Map
Nos:IES/N9402)

WORKSHOP CALCULATION & SCIENCE:
Unit, Fractions
Classification of unit system
Fundamental and Derived units F.P.S, C.G.S, M.K.S and SI units Measurement
units and conversion
Factors, HCF, LCM and problems
Fractions - Addition, substraction, multiplication & division Decimal fractions -
Addition, subtraction, multilipication & division
Solving problems by using calculator
Square root, Ratio and Proportions, Percentage
Square and suare root
Simple problems using calculator
Applications of pythagoras theorem and related problems Ratio and proportion
Ratio and proportion - Direct and indirect proportions Percentage
Precentage - Changing percentage to decimal and fraction
Material Science
Types metals, types of ferrous and non ferrous metals Physical and mechanical
properties of metals
Properties and uses of rubber, timber and insulating materials
Basic Electricity
Introduction and uses of electricity, electric current AC,DC their comparison,
voltage, resistance and their units
Conductor, insulator, types of connections - series and parallel
Mensuration
Area and perimeter of square, rectangle and parallelogram Area and perimeter of
Triangles
Area and perimeter of circle, semi-circle, circular ring, sector of circle, hexagon
and ellipse
Surface area and volume of solids - cube, cuboid,
Finding the lateral surface area, total surface area
Levers and Simple machines
Lever & Simple machines - Lever and its types

Project Work: - One room estimation of interiors works.
Industrial Visit [Visit to different places for interior work and to different sites where interiors works
are in progress & Necessary practical training to be carried out on site.]
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Construction Exercise 1.1.01
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Familarization with trade and institute
Objective: At the end of this exercise you shall be able to
• identify the trade based on functionality and aestuetics.

PROCEDURE

TASK 1: Observe various class rooms around your institute in terms of Interior (Spatial, circulation etc.,) and
note down the positive and negative aspects of the design (Fig 1)

1 Identify interior spaces in the institute.

2 Determine the design aspects of spaces within an
architectural environment.

3 Attension to scale and functional aspects.

4 Prepare drawing and documents to the design of
interior spaces.

5 Process of involving selection and coordination of
interior materials.

6 Arrange the space for furniture and other elements
which leads to optimum use of space avaliablity.

7 Plan and use the materials economically.

8 Ensure the project to be completed in time.

9 Identify desire atmosphere and color themes.

10 Make note of positive and negative aspects in written.

11 Carry out discussions in the class room and share
your ideas with the instructors.

12 Provide finish boards or books to illustrate the color
scheme.

13 Check the completed design must clearly convey the
design intent.

14 Ensure individual space and requirements.

15 Life safety and fire codes and regulations must be
followed in all designs.
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Construction Exercise 1.1.02
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Importance of trade training
Objective: At the end of this exercise you shall be able to
• analyse the interior in terms of spatial planning, material knowledge like texture.

PROCEDURE

TASK 1: Carryout observation of classrooms in terms of interior (with senses such as sight, smell, taste and
touch)

1 Determine the given interior space (classroom/studio).

2 Inspect the interiors firstly in term of :

a visual (sight) aspect (furniture, walls, ceiling etc.,)
and make sketches roughly as required.

• Check the materials around the space and take
help of the instructor to indentify it.

• Identify forms that had impacted the style and
overall impression of the room interms of shapes
regular / irregular.

b Audio aspect - Identify voices (sound) around the
space that promotes noise or quieter elements such as
acoustic elements has noise proof wall smell aspect
(audio aspect)

c Smell aspect - Identify aromas (smell) around the
space, since certain odors given comfort and
happiness such as presence of fresh flowers.

d Taste aspect - Identify color schemes around walls,
since color affects the appetite (taste) and will enable
you to associate with such colors.

e Tactile aspect - Check the textures available in
interior space, grains present in furniture (hard/soft),
textile fell (touch) in window certains since we are
drawn to richness of texture.

Note : During the exercise you can understand
that interior designing as a trade is substantial
part of our daily life.

TASK 2: Carryout the professional practice interms of interior

1 Determine the given interior space (Classroom/ Studio).

2 Arrange eminent and distinguished interior designer to
impart specialised education.

3 Laydown general condition of contract and prepare
standard forms of agreement.

4 Organise various competitions like Interior of the Year.

5 A code of professional conduct to be established by

the practitioners they should understand and adhere
to it.

6 Inspect the quality interior design programs in various
countries there by develop educational standards.

7 IIID (Indian Institute of Interior Designers) organise
seminor and exhibition in india.
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Construction Exercise 1.1.03
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Uses of tools, equipments and instruments
Objectives: At the end of this exercise you shall be able to
• identify drawing tools used in interior design decoration
• use drawing tools, equipments and instruments in interior decoration.

Instructors will explain drawing tools,
equipments and instruments name and uses
in interior design decorations trade.

1 Trainees will note down name and uses in table 1.

2 Get it checked by your Instructor.

Drawing board (Fig 1)

PROCEDURE

TASK 1: Identifying the tools and equipments (Fig 1 to 24)

Cellulose tape (Fig 2)

T-Square (Fig 3)

Set square (Fig 4)

Flexicurve (Fig 5)

French curves (Fig 6)
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Mini drafter (Fig 7)

Drawing pencils (Fig 8)

Fig 8

ID
20

N
11

03
H

8

Steel rule and Wooden scale (Fig 9)

Stencils (Fig 10)

Shape stencils (Fig 11)

Furniture template - 1:50 (Fig 12)

Furniture template - 1:100 (Fig 13)

Large compass (Fig 14)

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.03
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Large divider (Fig 15)

Bow - instruments (Fig 16)

Drop spring bow instruments (Fig 17)

Ruling pens (Fig 18)

Drawing instrumens (Fig 19)

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.03
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Beam compass (Fig 20) Lengthening bar (Fig 21)

Screw driver (Fig 22)

Lead case (Fig 23)

Proportional divider (Fig 24)

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.03
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Fig No. Name Uses

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

Table 1

Identify the tools and equipment and instrument and its uses

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.03
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Construction Exercise 1.1.04
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Free hand sketches of objects
Objective: At the end of this exercise you shall be able to
• Draw the furniture objects.

PROCEDURE

TASK 1: Draw interior related objects as given in Fig 1a to 1d and Fig 2e to 2k.

1 Set the drawing paper on the board.

2 Draw the free hand sketches of objects.
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9Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.04
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Construction Exercise 1.1.05
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Recognise layout of drawing sheet including title block
Objectives: At the end of this exercise you shall be able to
• set and fix drawing paper on the drawing board
• draw margins and title block frame
• layout the drawing sheet
• draw the title block as per I.S.

PROCEDURE

TASK 1: Prepare the layout as shown below on A2 size paper (Fig 1)

1 Place the drawing paper centrally on the drawing board.

2 Set the drawing board and align the top edge of the
drawing sheet.

3 Hold the drawing sheet by hand in the same position
and fix the sheet in this position with drawing cellolose
tape. (Fig 1)

4 Set off the margin distance using scale..

5 Draw four border lines as shown above

6 Mark and draw the title block.
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TASK 2: Draw this title block in position. In the remaining area of paper print the following (Fig 1)

1 All dimensions are in mm.

2 Ask if any doubt.

3 Six holes diameter 8 mm equally spaced 60 mm pitch
circle diameter.

4 This drawing confirms to IS:9609-1983.

5 Bureau of Indian Standards (BIS) is our national
standard.

6 General deviations as per IS:2012;(medium)

7 All thick lines-0.5 mm.

8 Chamfer to bottom of thread.

9 Rough will be the surface marked ‘X’.

10 Punch roll number and part number.

• Calculate the width of the each letter.

• Draw the guidelines for the required size:

• Mark the width and spacing for each letter.

• Draw vertical guidelines.

• Print the letter free hand, using HB pencil.

•    Draw the subsequent squares with the same.

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.05
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Construction Exercise 1.1.06
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Importance of lettering with single stroke gothic letter
Objectives: At the end of this exercise you shall be able to
• importance of lettering in drawing
• select and calculate the size of letters
• print single stroke letters and numerals by free hand.

PROCEDURE

TASK 1: Importance of lettering vertical gothic and gothic letters

Production

Lettering, in engineering drawing, is an important part
of drawing. Lettering enhances the clarity of drawing.

Lettering

The method of writing letters A, B, C, D and numerals 1,
2, 3, 4 etc., titles, notes, scale etc. on drawing is called
Lettering.

Types of lettering

1 Gothic Lettering

2 Free Hand Lettering

3 Roman Lettering

1. Gothic Lettering — Single stroke letters of equal
thickness and width are called Gothic letters. Gothic
letters may be single stroke and double stroke letters.
These letters can be written on a scale of 7:4 or 5:4.
Letters inclined at 15° to vertical axis are italic gothic
letters. All these types of letters are shown in figure
below.

TASK 2: Reproduce single stroke different gothic letters (Fig 1)

1 Select the size of letters and calculate the height &
width of each letter.

2 Arrange and draw the guidelines for the required size.

3 Prepare the layout for printing of letters.

4 Mark the width and spacing for each letters.

5 Draw vertcial guide lines.

6 Print the letter by freeahand, using H or HB pencil.
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SIZE
14mm
14mm
10mm
10mm
14mm

STYLE
Vertical capital
Inclined Capital
Vertical Capital
Inclined Capital
Numerals

SIZE
10mm
14mm
14mm
10mm
10mm

STYLE
Numerals
Lower case Vertical
Lower case inclined
Lower case vertical
Lower case inclined

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.06
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Construction Exercise 1.1.07
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Draw different types of lines by free hand
Objectives: At the end of this exercise you shall be able to
• sketch horizontal, vertical and inclined lines by free hand
• draw circles and arcs by free hand.

Lengthy lines can be drawn with the forearm
motion and short lines are drawn with the wrist
motion.

Keep uniform pressure while sketching.

Horizontal lines are drawn from left to right.
(Fig 1B)

While sketching straight lines between two
points keep your eyes on the point to which the
line is to go rather than the point of pencil.

Avoid of drawing whole length of line in one
single stroke.

Prevent using eraser often.

TASK 2: To draw vertical lines in thick and thin by freehand (Fig 1)

1 Sketch two horizontal thin guide lines AB & CD.

2 Mark points on the horizontal lines AB & CD, 5 mm
intervals.

3 Sketch the line in free hand between the two points with
thick and thin alternatively.

Vertical lines are drawn from top to bottom.
(Fig 1B)

PROCEDURE

TASK 1: To draw horizontal thick and thin lines by freehand (Fig 1)
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TASK 3: Sketch the inclined lines as shown in figure with thick and thin lines by freehand (Fig 1)

1 Sketch two axis AB & CD.

2 On the horizontal and vertical axis AB and CD, mark
points with 5 mm intervals.

3 Draw thick and thin lines in the direction as shown in
the figure alternatively.

Inclined lines running upward are drawn left to
right i.e bottom to top. (Fig 1B)

The pencil point need not to be too sharp.

Hold the pencil freely and not close to the
point.

It is better that the pencil can be hold 30 mm
away from the tip of the pencil lead.

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.07
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TASK 4: Draw by free hand circles square method (Fig 1)

1 Draw a square ABCD of size 60mm x 60mm, if the
circle to be drawn is of dia 60mm.

2 Mark the centre of the sides (1,2,3,4).

3 Draw diagonal AC and BD to identify the centre point
‘E’ of square.

4 Mark half the diversion of one side of square on the
AE.

5 Draw small arc joining the three points of one posi-
tion of square.

6 Similarly draw arcs to form a circle.

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.07
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TASK 5: Draw by free hand circles by radial lines method  (Fig 1)

1 Draw the horizontal and vertical centre lines forming
a centre.

2 Draw a number of radial lines passing through the
centre.

3 Mark uniform divisions approximately 5 mm from the
centre on the radial lines.

4 Draw small arcs on the 15 mm marks on each line (30
mm diameter).

5 See that it forms a thin circle, if necessary align and
draw the firm line to form a thick circle.

6 Repeat the same method for dia 60 mm and 80 mm
circles.

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.07
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Construction Exercise 1.1.08
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Introduce the scale MKS and FPS for making the drawing
Objectives: At the end of this exercise you shall be able to
• prepare scale of MKS and FPS in drawings.

PROCEDURE

TASK 1: Draw the given figure using MKS system

1 Prepare the drawing A2 sheets (border, title, title
block frame)

2 Using HB pencil do the drawing illustrated in the
figure.

3 Draw the rectangle from (fig 1) using scale 1:1 of MKS
scale (metric scale). (50cm x 10 cm)

4 Render (color) it as per your creativity.

5 Draw (fig 2) using scale 1:10/1:20 into proper
dimensions (each side - 40 cm). (40cm x 40 cm)

6 All dimensions are measured in cm.

TASK 2 : Draw the given figure using MKS system as well as FPS system

1 Prepare the drawing A2 sheets (border, tittle, tittle
block frame)

2 Draw the given Fig 3 of dimension 15’x12’ into scale
of 1:16 (FPS scale) and 1:50 (MKS scale) while
converting 15’x12’ in form of metric form (5m x 4m)
using HB pencil.

3 Label the windows and door properly.

4 All dimensions need to be precise while doing the
drawing.© N

IM
I 

NOT T
O B

E R
EPUBLI

SHED



19

Construction Exercise 1.1.09
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Draw the simple composition of geometrical object
Objectives: At the end of this exercise you shall be able to
• construct an Isometric scale to a given length
• draw the isometric projection of regular solids
• draw the isometric views of components with horizontal, vertical, slant and curved surfaces
• draw the isometric views for the given multi-views.

PROCEDURE

TASK 1: Construct an Isometric scale to measure upto 100 mm with minimum reading of 10 mm.

1 Draw a horizontal line OA.

2 Draw a line OC at 45° to OA and mark 10 mm, 20
mm.....100 mm.

3 Draw another line OB at 30° to OA.

4 Draw vertical projectors from divisions on OC on to
OB and mark the divisions as on OC.

The scale on OC is the true scale and the scale on OB
is the Isometric scale. (Fig 1a)

Another way of constructing isometric scale.

5 Draw a horizontal OA to a known length.(say 50mm)

6 Draw another line OE at 15° to OA.

7 Draw another line from point A making 45° and meet
the line OE at D.

8 Divide the line OA into number of equal divisions (say
5) and mark 10,20,30,40 and 50 mm.

9 From the points on the line OA, draw lines parallel to
AD and mark off 10,20,30,40 and 50 on line OE.

Now the scale on OA is the true scale and the scale on OD
is the isometric scale. (Fig 1b)

TASK 2: Draw the isometric drawing of a cube of side 25 mm (Fig 1)

1 Draw square of a, b, c and d.

2 Draw 30° lines from point b, cand d for the length of 25
mm.

3 Mark point g from b, f from c and e from s as shown in
figure.

4 Join all points.
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TASK 3: Draw the isometric drawing of a cuboid of base 30 mm x 40 mm and the height 20 mm (Fig 1)

1 Draw the three isometric axes through point ‘A’.

2 Mark AB = 40 mm, AE = 30 mm and AD = 20 mm
representing the three sides of cuboid.

3 Draw two vertical lines parallel to the line EF and BC
from point E and B respectively.

4 Similarly draw two more lines parallel to AB and AE
mark G intersecting point from F and G.

5 Draw lines parallel to DC and FG, draw lines parallel to
DF and GC.

6 Join all the points.

TASK 4: Draw the isometric projection of a rectangular prism of base 30 mm x 20 mm and height 60 mm (Fig 1)

1 Use isometric scale for all measurements.

2 Draw the lines AB, AD, AH to 20,30 & 60 representing
the isometric axes.

3 Draw lines parallel to isometric axes as shown and
complete the isometric projection required.

TASK 5: Draw the Isometric projection of the hexagonal prism of 2.5 cm side of base and 60 mm height (Fig 1)

1 Draw a hexagon of side 25 mm of its edge is horizontal.

2 Draw a rectangular prism of base pqrs and height 60
mm.

3 Draw the isometric view of the hexagonal base abcdef
of the prism using offset method.

4 Draw the top hexagonal face by drawing projection
from the corners of the base.

5 Make the visible edges by drawing thick lines and
draw the invisible edges in hidden line.

6 Rub off the unwanted lines and complete the isometric
projection.

Use isometric scale for all measurements. (Fig 1)

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.09
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TASK 6: Draw the Isometric projection of a cylinder of base 50 mm and height/length of 70 mm with its base
resting on HP by offset method and four centre arc method.

Off-set method

1 Draw the elevation and plan of the cylinder. (Fig 1)

2 Draw the isometric projection of a square of side
equals to the dia of cylinder. (Fig 1a)

3 Draw the isometric projection of a square prism of
height 70 mm on the square drawn.

4 The mid points of the sides of the square given four
points ABCD and four more points HIJG by intersection
of the diagonals with circles (located by offset method)
join the points to form isometric circle.

5 Draw the isometric circles for the bottom and top face of
the cylinder inside the square prism using offset method.

6 Draw common tangents to top and bottom isometric
circles.

7 Complete projection by drawing visible lines thick
and invisible lines thin. (Fig 1b)

Four Centre arc method

1 Draw the elevation and plan of cylinder. (Fig 1c)

2 Draw the isometric projection of a square of side
equals to the dia of cylinder.

3 Draw the isometric projection of a square prism of
height 70 mm on the square drawn.

4 Draw the bisectors RD and RA from R and PC and PB
from P.

5 Draw arcs with O
1
 and O

2
 as centres and radius O

1
D

and O
2
A

6 Draw arcs with P and R as centres and radius PC and RD.

7 Draw vertical lines from the end of the ellipse.

8 Draw the base as half of the ellipse.

9 Complete the isometric view of the prism. (Fig 2)

10 Fig 3 shows the cylinder in horizontal position.

11 Follow the procedure of the cylinder in vertical position
and complete the prism.
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TASK 7: Draw the Isometric projection of a hexagonal pyramid of side base 30 mm and height 65 mm given its
position as under

1 Its base resting on HP and the edge of the base parallel
to VP. (Fig 1)

2 Draw the plan and elevation of the pyramid (true
scale) and enclose the plan in the rectangle PQRS.

3 Draw the parallelogram with two of its adjacent edges
at 30° to the horizontal.  (Fig 2) PQ = Isometric length
of pq and PS = Isometric length of PS.

4 Draw an isometric hexagon ABCDEF in the
parallelogram PQRS.

5 Mark the centre O and draw a vertical line from point
O of height to 75 mm in isometric scale.

6 Join O, with ABCDE&F to complete the required
Isometric projection of the hexagonal pyramid. (Fig 3)

TASK 8: Draw the Isometric projection of a cone whose base diameter 40 mm and height 60 mm when its base
rest on HP (Fig 1)

1 Draw the plan and elevation of the cone in the true scale
as shown in the Fig 1.

2 Draw the Isometric projection of the base circle. (by four
centre method) (Fig 2)

3 Mark the centre  and draw a vertical line 0.0
1
 such that

0.0
1
 equals to 60 mm in isometric scale.

4 From `0' draw tangents to the isometric circle of the
base and complete the required isometric projection
of the cone. (Fig 3)
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Construction Exercise 1.1.10
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Draw the simple exercise using lines in different angles
Objectives: At the end of this exercise you shall be able to
• draw figures involving horizontal, vertical and inclined lines
• use 'T' square, set square, scale, divider and protractor.

PROCEDURE

Draw the following patterns and components using stright lines
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TASK 1: Horizontal line

1 Layout lines as shown in Fig 1 on an A2 drawing
sheet.

2 Butt the 'T' square approximately 5 mm above the line
EF.

3 Draw a horizontal line 100 mm long left to right. (15
mm from AE)

4 Draw a vertical line 100 mm long from the left end of
the drawing paper as shown in Fig 2.

5 Mark of points on the vertical line at 10 mm intervals
using divider. (Fig 3)

6 Draw horizontal lines through the points using 'T'
square. (Fig 4)

TASK 2: Vertical line

1 Draw the thin horizontal line and mark 10 mm spaces
as in (Fig 1).

2 Place the 30°/60° setsquare on the 'T' square in such
a way that its vertical edge is towards the left side of
the board, approximately 15 mm from the line GH.
(Fig 2)

3 Move your left hand onto the 'T' square blade and
hold the setsquare firmly in position.

4 Hold the pencil approximately at 60° with the paper.
(Fig 2)

5 Draw a line upwards approximately to a height of 100
mm twisting your body as shown in  Fig 3.

6 Continue to draw the remaining vertical lines.
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TASK 3: Inclined lines

1 For drawing 45° lines.

2 Place the working edge of the 'T' square 15 mm
above the line EF and draw horizontal lines in block
(3) as shown.

3 Draw vertical lines parallel to JK as shown in the
block.

4 Using divider, mark points from top corner at 10 mm
intervals on horizontal and vertical line. (Fig 1)

5 Butt, slide and take the working edge of 'T' square to
line EF.

6 Place the 45° setsquare and draw the 45° inclined
lines from the corner, top to downwards. (Fig 2)

7 Hold the blade of the 'T' square and setsquare intact
while drawing lines.

8 Following the same procedure complete block 4, 5 & 6.

9 Draw 45° inclined line in the opposite direction in
block 4. (Fig 3)
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10 30° or/and 60° inclined lines can be drawn with the help
of 30° /60° setsquare and 'T' square.

11 Draw 30° inclined lines in block 5. (Fig 4)

In the block 6, draw 60° inclined lines. (Fig 5)

TASK 4: Triangles in a square

1 Draw a square of side 100 mm long. (Fig 1a)

2 Draw another square of side 80 mm as shown in Fig
1b.

3 Draw four triangles using 45° setsquare and 'T'
square. (Fig 1c & 1d)

TASK 5: Tile pattern

1 Draw a square of side 100 mm and its diagonals.
(Fig 1a)

2 Draw lines parallel to both the diagonals at a distance
of 10 mm. (Fig 1b)

3 Complete the tile pattern by forming 20 mm x 10 mm
rectangles as shown in Fig 1c.
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TASK 6: Square pattern

1 Draw a square ABCD of side 100 mm with side CD
marking 30° to the vertical line. (Fig 1a)

2 Draw the next square by drawing straight lines through
points A, B, C & D using 'T' square and 45° setsquare.
(Fig 1b)

3 Draw the subsequent squares with the same
procedure but  with the inclination of 60°, 75° & 90°.
(Fig 1c, d, e)

TASK 7: Irregular pattern (Fig 1)

1 Draw a horizontal line AB to a length of 90 mm.

2 Draw the remaining lines BC, CD, DE, EF, FG, GH,
HJ, JK to the suitable length  and angle as in Fig 1.

3 Join the points KA and measure the length of KA.

4 Measure the angles JKA and KAB.
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Construction Exercise 1.1.11
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Draw the plan elevation, sectional elevation & isometric view of geometrical
solids
Objectives: At the end of this exercise you shall be able to
• draw the plan, elevation and side view of a cube, rectanglar prism, triangular prism and hexagonal prism
• draw the plan, elevation and side view of a cylinder, cone and regular hexagonal pyramid
• draw the sectional views of a square prism and cylinder.

Draw the orthographic projection (elevation, plan and side
view) of the square sheet (40 mm side) kept perpendicular
to HP and parallel to VP. (I angle)  (Fig 1)

1 Draw the xy line.

2 Draw the square with its centre 40 mm above the xy line
and one edge parallel to xy line.

3 Mark the corners of the figure a', b', c' & d'.  This will be
the elevation of the square.

4 Draw the vertical projectors from a'b' downward beyond
the xy line.

5 Draw a horizontal line dc at a distance of 20 mm below
the xy line.  Line dc will be the plan.

6 Draw a X'Y' line at a convenient distance from b'c',
intersecting the xy line at `0'.

7 Project the plan to the X Y line meeting at e.

8 By arc method transfer Oe to xy and mark the point ̀ f'
at a" and d" respectively.  Now the line a"d" is the side
view.

Draw the Top, Front and side views of the rectangular prism
of base 30 x 20 mm and height 40 mm.  (Fig 1a)

In this exercise the faces of prism are parallel to the planes
of projection.  Therefore all the lines orthographic projection
are vertical and horizontal lines only.

Visualise the shape of the object and imagine the shape
description of views.  Surface ABCD (Fig 2b) only visible
from the elevation.  At the same time all the four sides of
ABCD are isometric lines.  Therefore in the elevation a
rectangle of 40 x 30 mm is seen.

1 Draw xy line of convenient length. (Fig 1b)

2 Draw a rectangle a'b'c'd' on the xy line.  This will be the
elevation of the prism.

3 Project the vertical sides of the elevation (a'd' and b'c')
downwards beyond xy line.

4 Draw a horizontal line fg approximately 20 mm below
xy line.

5 Draw a rectangle fgba of 30 x 20 mm size.  This will be
the plan of the prism.

6 Project points b' and c' horizontally a convenient length
to the right side of the elevation.

7 Transfer the width of plan gb by arc and locate points
e"d" on the xy line.

8 Project e"d" vertically up and locate points f"a"d"e" is
the left side view of the prism.

PROCEDURE

TASK 1: Draw the plan, elevation and side view of a cube

TASK 2: Draw the plan, elevation and side view of a Rectagular prism
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Draw in first angle projection of front view, side view  and top
views of triangular prism sides are 40 mm and 70mm
length. (Fig 1a)

1 Draw equlateral triangle ABC sides are 40mm of front
view as shown in Fig.

2 Draw rectangle side view of BDEC 70mm length and
40 mm height as shown in Fig.

3 Draw top view of ACBDEF 40 mm width and 70 mm
height as shown in Fig.

TASK 3: Draw the plan, elevation and side view of a Triangular prism
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TASK 4: Draw the plan, elevation and side view of a  Cylinder

Draw the top, front and side view of a cylinder of diameter
20 mm and length 30 mm.  (Fig 1a)

In this problem the circular faces are parallel to VP.
Therefore the elevation is a circle resting on XY line.  Plan
and end views are rectangles of size 30 mm x 20 mm.

1 Draw the circle of diameter 20 mm touching XY line.
(Fig 1b)

2 Draw the plan projecting it from the elevation.

3 Draw the end view by drawing projection on it, from the
plan and elevation.

4 Draw the plan, elevation and side view of a cylinder
whose base diameter 30 mm and height 50 mm when
its position is as shown in Fig 1c.
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TASK 5: Draw the plan, elevation and side view of a  Cone

1 Draw the multi-views of the cone shown in the Fig 1a.
Follow the procedures of the earlier exercises and draw
the multi-views. (Fig 1b)

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.11

TASK 6: Draw the plan, elevation and side view of a  Regular hexagonal pyramid

Draw the Orthographic views of a regular hexagonal pyramid
of side 20 mm and height 40 mm given its position as below.
(Fig 1a)

1 Standing vertically with its base on HP and one side of
the hexagonal base parallel to VP.

2 The pyramid has 6 triangular faces and one hexagonal
base.  The plan will show the true shape of the base and
other six triangular faces are fore-shortened.

In this elevation, three triangular faces are seen and all of
them are fore-shortened.

1 Mark the centre of hexagon (Point P) and draw lines
from P to the six corners of the hexagon.  Now this is
the required plan. (Fig 1b)

2 Project this P from plan upwards and mark P' at a
distance of 75 mm from XY line.

3 Mark the points f', a'b'c' etc... on XY line by projecting
the corresponding points from plan.

4 Join the P' with f', a',b',c' etc and complete the required
elevation.

5 Draw projectors from elevation and plan to complete the
required side view.
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TASK 7: Draw the plan, elevation and side view of a Hexgonal prism

Draw the three views of the hexagonal prism shown in
Fig 1a.

From the position described above, it is clear that the
hexagonal face of the prism is parallel to AVP.  Therefore
the end view is a true hexagon and hence this view should
be drawn first.

1 Draw the side view (hexagonal of side 25 mm) with one
side on HP line. (Fig 1b)

2 Draw horizontal projectors from side view and complete
the front view. (in the front view two lateral faces are
visible, but they are fore shortened)

3 Draw projectors from elevation and side view and
complete the plan.

(Three lateral faces are visible of which one is of true
shape and the other two are fore shortened)
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TASK 8: Draw the sectional views of a Square prism sectional plan

Draw elevation, sectional plan and the true shape of the
section of a square prism.

1 Length of side of square prism standing vertically.

2 One diagonal of the base is perpendicular to VP and
anotehr diagonal parallel to VP.

3 Cutting plane makes 45° to the axis and intersects the
axis 40 mm above the base.

Draw the plan and elevation of the prism. (Fig 1)

4 Draw the cutting plane in the elevation of the drawing.

5 From the point m' draw projector to meet the plan at
mn.

6 Hatch the portion of the plan and complete the required
sectional plan.

To get the true shape

1 Draw a line parallel to the cutting plane.

2 Draw projectors perpendicular to the cutting plane from
points m', b' & c' and extend beyond the line, drawn
parallel to the cutting plane.

3 Transfer the distances mn and db symmetrically about
the line and also mark c''.

4 Join m''-n'', n''-d'', d''-c'', c''-b'' & b''-m'' and hatch the area
to complete the required true shape. (auxilliary view)

TASK 9: Draw the sectional views of a Cylinder sectional plan

Draw the sectional plan, elevation and true shape of the cut
surface of a cylinder given the details as under.

1 Cylinder is of diameter 50 mm and height 60 mm
stands on HP with its axis vertical.

2 Cutting plane makes 40° to the horizontal and
intersecting the axis at the mid-point of the vertical
axis.

Draw the plan and elevation of the cylinder. (Fig 1)

3 Indicate the cutting plane in the elevation.

4 Divide the plan into any number of equal parts, (say 12)
and mark the points a, b, c... I.

5 Project the points a to I vertically to intersect the
cutting plane line at a' b' c' etc.
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Skill Sequence

Practice on types of dimension
Objectives: This shall help you to
• draw different systems of dimensioning
• dimension the drawings by aligned system and unidirectional system
• follow the standard of system of dimensioning with different arrangements of dimensional values.

To show aligned system of dimensioning

1 Draw the figures as shown (Figs 1&2).

2 Show the dimension lines in the figures.

3 Place the dimension value above the dimension line
centrally as direction.

6 Project horizontally the points a, b, ... I in the plan by
transfer method for the side view.

7 Mark the intersection points of the corresponding
projection in the previous two steps and complete the
end view.

To draw the true shape of the section

1 Draw a line AB parallel to the cutting plane line.

2 Draw perpendicular projectors perpendicular to the
cutting plane line.

3 From points a', b', c' extend beyond the line AB.

4 Mark the points a'
1
, b'

1
, c'

1
 etc such that the distance

I'' b'' k'' c'' at in the end view are equal to Ib, kc etc in the
plan.

Join the points a'
1 
b'

1
, c'

1
 and complete the true shape.
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To show unidirectional system of dimensioning

1 Draw the figures as shown (Figs 3&4).

2 Show the dimension lines in the figures.

3 Cut the dimension line at center to place the dimen
sion value horizontally.

To show various notations used in dimensioning
(Figs 5 to 11)
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Construction Exercise 1.1.12
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Free hand sketches of graphic symbol
Objective: At the end of this exercise you shall be able to
• draw graphic and conventional symbols used in interior spaces.

PROCEDURE

TASK 1 : Draw the conventional symbols using different hatchings as given in (Fig 1)

1 Draw the conventional symbol as given in the (Fig 1)
using HB pencil.

Note: All symbols are standards, as per IS.

TYPE CONVENTION MATERIALS

Steel, Cast Iron, Copper and its Alloys,

Aluminium and its alloy,etc

Metals

Lead,Zinc Tin White-metal,etc.

Glass Glass

Porcelain, Stoneware, Marble,Slate etc

Packing and Insulating Asbestos, Fibre, Felt, Syntehtic resin,
materials Products, Paper, Cork, Linoleum,

Rubber, Leather, Wax, insulating &
Filling Materials etc

Wood Wood, Plywood  etc

Concrete Concrete

Liquid Water, Oil, Petrol, Kerosen etc

Fig 1

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



37Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.12

TASK 2: Draw the graphic symbols to indicate various furniture interior spaces (Fig 1)

1 Draw the graphic symbols proportionately (free hand)
using the given measurements.

Note: All dimensions are infeet and inches.
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Construction Exercise 1.1.13
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

How to make design
Objectives: At the end of this exercise you shall be able to
• prepare circulation of space (spatial arragement) (bubble diagram, proximity chart)
• prepare concepts, theme and colour usage in interiors
• drawing furniture layout with proper scale.

PROCEDURE

TASK 1: Prepare spatial planning in form of bubble diagram and furniture layout given below

1 Concept (theme also needs to be incorporated).

2 Furniture layout needs to be draw to proper scale and
dimension.

Data (Requirement for given bubble layout):

A Index

a Verandah

b Living

c Dining

d Kitchen

e Master bed room

f Attached toilet

g Common toilet

h Childrens bed room

B Built - up area excluding verandah 91.04 sq.m

C Door and Window sizes:

1 Doors Height x Width

a Entrance door 200 x 120 cms

b Toilet door 200 x 80 cms

c All other doors 200 x 100 cms

2 Window & Ventilators Height & Width

Window (W1) 120 x 120 cms

Window (W2) 120 x 120 cms

Window (W3) 120 x 120 cms

Window (W4) 120 x 60 cms

Window (W5) 50 x 100 cms

D Arrange the following furniture:

1 Verandah

a Arrange outdoor plants

2 Living room

a L-shaped sofa

b Circular table 80 cm diameter

c Plant tuff 50 cm diameter

d Partition wall between living and dining upto door
level

3 Dining

a Dining table (length x breath) = 150 x 80 cm

b Six chairs (length x breath) = 50 x 40 cm

c Suitable wash basin near the toilets

4 Kitchen

a Sink & drain board

b Stove

c Fridge

d Cupboard 30 cm, wide

5 Master bed room

a Single bed (length x breath x height) = 200 x 200
x 40 cm

b Built - in wardorbe (length x breath x height) = 150
x 60 x 300 cm

c Corner shelf

6 Attached toilet

a Wash basin

b Western WC

c Bath space

7 Common toilet

a Wash basin

b Western WC

c Bath space

8 Children bed room

a Two bed each (length x breath x height) = 100 x
200 x 40 cm

b Built - in wardrobe (length x breath x height) = 150
x 60 x 300 cm

c Corner shelf
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TASK 2: Bubble diagram of residential layout (Fig 1)

Prepare the bubble diagram for given data of residential
layout using the following steps.

1 Draw the bubble diagram connecting spaces based
on functionality.

2 Concept should be creativity aligned to the space and
even theme has to be followed systematically.

3 Colour scheme has to be employed while doing
furniture layout as per the concept.

Drawing Method

Steps

1 Draw to scale : 1:50 (or) 2cm = 1 meter as show,
otherwise choosen any convenient scale.

2 Draw the ground floor plan as per the given
measurement.

3 Arrange the indoor furniture as shown in fig 2 leaving
sufficient area.

4 While drawing the indoor furniture observe the
circulation area marked with arrows. Minimum
circulation are without obstructions shows efficient
interior design layout.

5 In designing any interior space this aspect of efficient
utilisation of space should be given due care.

Concept design, pattern and colours

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.13

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



40

Construction Exercise 1.1.14
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Design knowledge of interior in residential and commercial space (i) Basic
layout plan, (ii)  Elevation
Objectives: At the end of this exercise you shall be able to
• prepare drawing plan and elevation
• prepare residential plan
• prepare commercial layout plan.

PROCEDURE

TASK 1: Residential (Figs 1 & 2)

The retail chain ‘K.S.Ramyaagayathri dealing in fashion
jewellery is opening a showroom in one of the biggest
shopping mall in your city.

The room height is 11’ from the floor to ceiling. There is a
12’ wide corridor in front of the shop.
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“SAMPANN” which is set up at your locality
for 75’10.5” x 30’ using the given requirements.

1 Reception area and waiting Lounge.

2 Kitchen for cooking with clay, storage units and
different food counters.

3 Staff retiring room with changing room and toilet.

4 Toilet.

5 Having musical orchestra (Piano) as the focal point.

6 Private and public dining spaces with wooden
portitions.

7 Seperate main and service entry.

8 From the given layout, design the spaces as per
requirement.

9 Proportionaly draw the furniture and place it as per
Fig 1.

TASK 2 : Design the interior a restaurant named (Fig 1)

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.14
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Construction Exercise 1.1.15
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Free hand sketches of graphic symbols for carpentry, plumbing and
electrical landscape
Objective: At the end of this exercise you shall be able to
• draw free hand sketches graphic symbols for carpentry, plumbing and electrial landscape.

PROCEDURE

TASK 1: Draw the graphical symbols for door, windows and furniture (Fig 1 to 3)

BOOK SHELF

Graphic symbols for furniture in living and dining room. (Fig 1)
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Graphic symbols for doors. (Fig 2) Graphic symbols for windows. (Fig 3)

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.15
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TASK 2: Draw free hand sketches of plumbing and sanitary fittings (Fig 1)

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.15
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TASK 3: Draw the free hand skectches of electrical and landscape (Fig 1)

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.15
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Construction Exercise 1.1.16
Interior Design & Decoration - Basics of Interior Design and Functional
Aspects

Rendering with pencil and pencil colour
Objectives: At the end of this exercise you shall be able to
• draw color wheel and understand its importance
• draw color scheme and get the knowledge of using it interiors.

PROCEDURE

TASK 1: Draw color wheel and understand its importance

1 Draw concentric circles of three valied sizes.

2 The innermost divide it into three pacts, first using red,
blue, yellow which are the primary colors.

3 The middle circle which is formed by mixing two primary
colors eg:when red is mixed with yellow we get orange,
hence secondary colors are orange, green, violet.

4 Similarly outermost circle should be formed by mixing
two secondary colors.

TASK 2: Draw color scheme and get the knowledge of using it interiors

1 Draw a color wheel showing primary, secondary and
testiary colors. (Fig 1,2 &3)
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TASK 3: Creatively uses color schemes in showing interior spaces which should satisfy the following criteria.

6 Triad color scheme.

7 Draw the color wheel using the above data as given in(Fig1)

Note: The scheme followed should be precise
and the image selected for drawing should be
interior based.

1 Analogous color scheme.

2 Complimentary color scheme.

3 Double complementary color scheme.

4 split complementary color scheme.

5 Monochromatic color scheme.

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.16
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Skill Sequence

Sketch the landscape or monuments
Objective: This shall help you to
• sketch landscape or mounments.

Landscape

• Draw the out line as shown in Fig 1 use HB pencil to
draw the outline.

• Render the landscape using 2B, 4B, 6B, pencils for
various shades as shown in Fig 2.

• The landscape can also be rendered using water
colours or colour pencils.

• Practice few more sketches as shown in Fig 3,4,5,6,7,8.
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Tripod Grip

• Position the pencil applying equal pressure between
the side of the middle finger, the tip of the index finger
and the thumb as shown in Fig 1.

Sketch the drawing using tripod grip, extended grip, overhand grip and hand
grip

Objectives: This shall help you to
• sketch the drawing using tripod grip
• sketch the drawing using extended grip
• sketch the drawing using overhand grip
• sketch the drawing using hand grip.

• Do not grip the pencil too firmly.  Holding a pencil too
tightly or too lightly will limit your flexibility in drawing.

• Do not hold the pencil vertically as shown in Fig 2.
check if the thumb and the underside of the forearm
are in straight line.

Extended Grip

• The tripod grip is still used, but you will hold the pencil
a bit further at the end on near the tip that has the
eraser. as shown in Fig 3.

• Small movements of your hand make larger effects
on the other end.
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Overhand Grip

• Hold the pencil horizontally as shown in Fig 4.

• The overhand grip have a relaxed grip on the pencil but
not too relaxed that the grip would not be secure.

• You can draw sitting or standing, make sure that your
arm has full range movement.

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.1.16

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



52

Under hand Grip

• Hold the pencil in a relaxed way.

• This grip is best suited for broad sketching.

• The pencil is positioned in a ‘v’ with the middle and
index finger controlling the movement as shown in
Fig 5.

• Using this type of grip will help you make from lines
and small linear details.
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Construction Exercise 1.2.17
Interior Design & Decoration - Furniture Design and Details

Residential furniture design and detail
Objective: At the end of this exercise you shall be able to
• draw residential furniture design as per the dimensions.

Data:

Table size = 1200 x 900 x 760 mm

Top plauge = 1200 x 900 mm

Bottom rails = 45 x 20 mm

Leg size = 45 x 45 mm

PROCEDURE

TASK 1: Draw the residential table as per dimension (Fig 1)

TASK 2: Draw residential chair as per dimension (Fig 1)

Data:

Armed chair size = 840 x 595 x 610 mm

TASK 3: Draw a residential sofa as per dimensions (Fig 1)

Data:

Sofa size = 2000 x 710 x 960 mm
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TASK 6: Draw the dining table as per dimension (Fig 1)

TASK 4: Draw the cabinet as per dimension (Fig 1)

Data:

Cabniet size = 1500 x 900 x 45 mm

TASK 5: Draw the bed as per dimension (Fig 1)

Data:

Bed size = 1875 x 1500 x 950 mm
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TASK 8: Draw the modular kitchen wall unit cabinet (Fig 1)

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.2.17
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Construction Exercise 1.2.18
Interior Design & Decoration - Furniture Design and Details

Commercial furnitures design and detail
Objective: At the end of this exercise you shall be able to
• draw the commercial furniture design as per the dimensions.

PROCEDURE

TASK 1: Draw the Executive table (Fig 1)

1 Draw executive table as per dimension.

2 Draw well of proper height and detail all parts properly.

3 Use line weight accordingly.

Data:

Table top = 2200 x 880 x 19 mm (Thick
plywood)

TASK 2: Draw the Office table (Fig 1)

1 Draw office table as per dimension.

2 Draw well of proper height and detail all parts properly.

3 Use line weight accordingly.

Data:

Table size = 1210 x 600 x 760 mm

Top plank size = 1210 x 600 x 20 mm (Thick)

Left side cupboard = 657 x 300 mm

Right side drawer = 590 x 410 mm

Table top sum mica = 2200 x 880 x 1 mm (Thick)

Left side cupboard = 1800 x 450 x 600 mm

Right side drawer = 600 x 500x 420 mm (with three
drawers)
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TASK 3: Draw the Reception table (Fig 1)

1 Draw the reception table as per dimension.

2 Draw well of proper height and detail all parts properly.

3 Use line weight accordingly.

TASK 4: Draw the cabinet storage table (Fig 1)

1 Draw cabinet storage as per dimension.

2 Draw well of proper height and detail all parts properly.

3 Use line weight accordingly.

Data:

Cabinet size = 1200 x 300 x 900 mm

Door size = 900 x 582 mm

Data:

Table top front = 1800 x 880 mm

Table top side = 1080 x 600 mm

Counter top front = 1800 x 300 x 350 mm

Counter top side = 1660 x 200 x 350 mm
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TASK 5: Draw the display unit (Fig 1)

1 Draw display unit as per the dimension.

2 Draw well of proper height and details all parts.

3 Use line weight accordingly.

Data:

Display unit size 1240 x 640 x 162 mm.
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Construction Exercise 1.2.19
Interior Design & Decoration - Furniture Design and Details

Free hand sketches of graphic symbols of furniture
Objective: At the end of this exercise you shall be able to
• draw the free hand sketches of graphic symbol of furniture.

PROCEDURE

TASK 1:

1 Draw the graphic symbol of furniture design in floor as
per the dimensions free hand approximate. (Fig 1)
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TASK 2:

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.2.19

1 Draw the graphical symbol of furniture living room as
per the dimensions approximate. (Fig 2)
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Construction Exercise 1.3.20
Interior Design & Decoration - Planning of Residential Interior Spaces

Concept plan with circulation flow (Bubble diagram)
Objectives: At the end of this exercise you shall be able to
• draw bubble diagram
• draw plan sectional elevation to suitable scale.

PROCEDURE

TASK 1: Draw the bubble diagram and residential layout

Draw bubble diagram along with circulation flow with
given requirements of client who is an interior designer
having family of four (2 kids). (Even a concept note has
to be made.)

Data/Requirements to be incorporated

a One studio (Interior designer) for working

b Home theater

c Living room

d Dining room

e Guest room

f Kitchen

g Master bedroom with attached toilet

h Kids bedroom with attached toilet

i Common toilet

j Prayer (Pooja) spaces

1 Draw the bubble diagram using the required data is
the given Fig 1 below gives clear detail of it.

2 Circulation of spaces needs to be understood while
doing bubble diagram Fig 2 by drawing proximity
chart.

Note: Proximity charge enables placing of
spaces next to each other.
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Construction Exercise 1.3.21
Interior Design & Decoration - Planning of Residential Interior Spaces

Basic furniture layout
Objective: At the end of this exercise you shall be able to
• draw the basic furniture layout plan.

PROCEDURE

TASK 1: Furniture layout

2 From the given bubble diagram of task 1 draw proper
furniture based on standard size.

3 Refer Fig 1 a bubble understanding.

1 Draw furniture layout for (Fig 1) resistance and render
it using different, medium pencils, dry pastels etc,.

Fig 1
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Construction Exercise 1.3.22-24
Interior Design & Decoration - Planning of Residential Interior Spaces

Wall elevation and details, rendering plan and elevation
Objectives: At the end of this exercise you shall be able to
• draw the wall elevation with dimension
• necessary details
• render the plan ans elevation.

PROCEDURE

TASK 1: Wall section elevation

1 Draw wall sectional elevation with dimension and
specification.

2 Render the elevation.

a Draw sectional lines A - A’C - C’.

b Draw wall of proper height and detail all parts property.

c Use line weight accordingly.

d Refer Fig 1 & 2 for reference.
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TASK 2: Spread footing for walls (Brick/Stone)

Data:

Wall thickness = 230 mm

D = Depth of foundation from grounf level = 1200 mm

a = offset of concrete = 150 mm

b = offset of brickwork = 75 mm

c = thickness of footing = 200 mm

d = depth of concrete = 150 mm

B = Breadth of concrete = 900 mm

1 Draw the section of stone footing.

2 Mark the dimension as shown in Fig 1.

3 Hatch and complete the section.

TASK 3: Necessary details for residential plan with working drawing

1 Draw a size of plot.

2 Set backs.

3 Location & width of the the road.

4 North direction.

5 Climatic information

6 Do R & D for sample floor plan.

7 Divide plot in grids.

8 Make bubble diagram (2/3 times)

9 The following included in a plan set.

10 Foundation plan.

11 Floor plan

12 Building sections

13 Roof plan

14 Beam calcs pack

TASK 4: Rendering the plan and elevation

1 Render a floor plan is a 2D or 3D view of home layout.

2 Present the floor plan to home buyers to help them to
understand every aspect of it.

3 Introduce the example model.

4 Adjust the focal length.

5 Adjust the depth of field.

6 Adjust your shadows and sum settings.

7 Copy and paste effects to duplicate.

8 Quick over view of the example model.

9 Adjusting sun and heading for floor plan view.

10 Make a front view.

11 Adjust your shadow range.

TASK 5: Rendering in elevation

1 Each side of house elevation drawings should be
shown.

2 Show each wall length and its height.

3 Show roof width and height.

4 Draw the visible portion of the foundation.

5 Show any exterior features (such as decks porches
and stairs).

6 Window and door trim.
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Construction Exercise 1.4.25
Interior Design & Decoration - Civil Components

Prepare drawing with technical details of R.C.C stair case
Objectives: At the end of this exercise you shall be able to
• draw the plan and section of straight staircase and technical details
• draw the plan and section of open well staircase and technical details
• draw the plan and section of dog legged straight staircase and technical details
• draw the plan and section of bifurcated staircase and technical details.

PROCEDURE

TASK 1: Draw the plan and section of straight staircase (Fig 1)

DATA

Height of upper floor = 3 m

The total runs of straight stair = 6 m

R.C.C waist = 10 cm thick

The Tread = 30 cm

No.of Steps in the flight = 20 Nos.

Width of stair = 0.90 m

The handrail G.I pipe = 50 mm dia.

Newel post G.I pipe = 75mm 80cm height
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The baluster 25mmG.I pipe nd missing data may be
assumed.

I Plan

1 Select scale 1:50.

2 Draw plan of the straight stair with proper number of
treads.

3 Draw the landing after twelve risers.

4 Draw the threads (6 Nos) after the landing.

5 Dimension the drawing properly.

II Sectional Elevation

1 Draw upward projector lines to mark the risers from
each tread and complete the section as indication in
figures.

2 Draw hand rail details.

3 Fully dimension the drawing.

TASK 2: Draw the plan and section of RCC open newell staircase as per the data given below:

DATA

Room size = 6 x 2.50 m

Wall = 30 cm

Height of floor = 2.975 m

Tread = 25 m

Rise = 17.5 cm

Width of stair = 1.00 m

Width of landing = 1.00 m

Open well rectangle = 50 cm width

RCC waist = 12.5 cm

RCC beam = 20 x 25 cm

Nosing = 2.5 cm

Hand rail = 50 mm

Baluster = 25 mm

1 Draw the plan of room with size 6 x 2.5m

2 Draw the width of stair as 1m

3 Draw the treads 25cm wide and complete the plan as
shown in Fig 1.

4 To develop the section, draw projectors upwards
from each tread.

5 Complete the section as indicated in the figure.

6 Draw the details at (A) in 1:10 scale as shown Fig 2.
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TASK 3: Draw the plan and section of RCC dog legged staircase as per the data given below:

DATA

Room size = 6 x 2.50 m

Wall = 30 cm

Height of floor = 2.975 m

Tread = 25 m

Rise = 17.5 cm

Width of stair = 1.00 m

Width of landing = 1.00 m

Open well rectangle = 50 cm width

RCC waist = 12.5 cm

RCC beam = 20 x 25 cm

Nosing = 2.5 cm

Hand rail = 50 mm

Baluster = 25 mm

Plan

1 Draw the plan of half turn RCC dog legged stair room
as per data given with proper number of treads as
shown figure with appropriate scale.

2 Draw the landing after nine risers.

3 Draw the window in plan.

4 Dimension the drawing property.

Sectional Elevation

1 Draw the sectional elevation of the stair by drawing
projectors upward from each treads.

2 Draw the handrail details as per given datas.

3 Draw the elevation of the window.

4 Dimension the drawing property.
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TASK 4: Draw the plan and section of bifurcated stair (Fig 1)

DATA

Height between floors = 3m

Tread = 30 cm

Rise = 15 cm

Middle landing = 1m (Width)

Width of stair = 1m

Wall thickness = 20 cm

R.C.C slab thickness = 12 cm

No.of risers in 1st flight = 12 Nos.

No. of risers in 2nd flight = 8 Nos.

Hand rail, newel post, baluster = 25 mm

1 Draw the plan of differential stair in 1:50 sclae as per
given data.

2 To develop the elements, draw projections upwards
form each tread.

3 Complete the elevation as indicated in Fig 1.
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Construction Exercise 1.4.26
Interior Design & Decoration - Civil Components

Calculation of staircase (trade and riser)
Objective: At the end of this exercise you shall be able to
• calculate tread and risers for a given staircase.

PROCEDURE

TASK 1 : Design of layout

i Design of layout The height of floor is generally
known procedure for determining the no. of treads
and risers is as follows.

a The position of 1st and last risers are determined
with regard to the position of doors, windows,
verandas etc.

b A convenient height of riser is assumed.

c No. of risers equal to total height of floor divided by
height of risers.

 
Height of riser

Total height of floor
i.e no.of risers =

d No. of treads = no. of riser -1

This is due to the fact that the surface of the upper floor
forms the tread for the top step.

E.g:- For instance let us assume that height of floor is
3.8m assume the rise of 14 cm.

 
0.14
3.50

No.of risers = = 25 Nos.

No. of treads in single flight = 25 - 1 = 24 Nos.

No. of treads in double flight = 25 - 2 = 23 Nos

Depending upon the space available for staircase the
type of stair is selected.

Tread and Riser

In - order to make the ascend and descend easy the
tread and risers of a stair should be proportional following
rules of thumb are commonly used for obtaining a
satisfactory proportion of the tread and riser of a step.

i Rise in cm x going in cm = 40 to 45

ii Rise in cm x going in cm = 426 (approximately)

iii 2 rise in cm x going in cm = 60 (approximately) Take
rise equal to 14 cm and going would be 30 cm as
standard.

Take rise equal to 14 cm and going would be 30 cm as
standard.

Other combination of rise and going would be 15 x 28cm,
16 x 26cm, 17 x 24cm.

Problem (Fig 1&2)

1 The inside dimension of a stair case in a residential
building are 2m X 4.6m. The height of floor is 3.3 m
and the roof consist of R.C.0 slab of 12 cm thick-ness.
Design a proper layout of R.C.0 slab stair for this
building.

Section

Adopt a dog - legged stair

Assume a convenient height of riser say = 18 cm

 
Height of riser

Total height of floor
Then the no.of risers =

Total height = 3.30 + 0.12 = 3.42 m

Height of riser = 18 cm
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0.18
3.42

Number of risers =

Split the number of risers into two flights conveniently
say 12 nos in first flight and 7 nos in second flight.

No of steps in 1st flight = 12-1 = 11 nos

No. of steps in 2nd flight = 7-1 = 6 nos

Draw the plan and sectional elevation of the dog legged
stair case according the designed values.

TASK 2 : Design a dog legged staircase for a building in which the vertical distance between the floors is 3.6m:
   (Fig 1)

The stair hall measures 2.5m x 5m.

Let the rise be 15cm and tread the 25cm.

It us keep width of each flight = 1.2m

Width of landing width of stairs = 1.2m

Height of each flight = 3.6/2

No of risers required = 180/15

= 12” (each flight)

No of treads in each flight 12-1 = 11

Space (Area) occupied by treads

= 11 x 25

= 275 cm.

Space (Area) left for passage

= 5- 12- 2.75

= 1.05 meters
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Construction Exercise 1.4.27
Interior Design & Decoration - Civil Components

Model of staircase
Objectives: At the end of this exercise you shall be able to
• draw the plan and section of three quarter turn stairs
• draw the plan and section of spiral stairs.

PROCEDURE

TASK 1: Draw the plan and section of three quarter turn stairs. (Fig 1)

DATA

Room size = 3.50 x 2.90m.

Wall = 30cm.

Height between floor = 3.00m.

Tread = 30 cm.

Rise = 15 cm.

Width of stair = 1.00m.

Width of stair = 1.00m.

Open well rectangle = 150 x 90 cm.

R.C.C. waist = 12.5 cm.

R.C.C. Beam = 20 x 25cm.

Nosing = 2.5 cm.

Hand rail = 50 mm.

Baluster = 25mm, 80cm height.

Balustrade = with glass and
    wooden combination.

Same as previous exercise considering given data.

TASK 2: Draw the plan and section of spiral stairs (Fig 1)

DATA

Height of floor = 3m.

Wall = 30cm.

Tread = 19cm inner circle and
    56cm outer circle.

Rise = 21.80cm.

Width of stair = 0.80cm.

R.C.C Waist = 12.5cm.

R.C.C Pilar = 20cm.

Hand rail = 50mm.

Baluster = 25mm.

• Draw the column dia 20cm.

• Draw the outer circle of 0.9m radius.

• Divide the circle in to 10 Equal parts.

• Draw the 10 Winders.

• Draw the outer circumference of handrail of 50mm.

• Draw the complete plan.

• Develop the elevation by projecting each and very
points form plan as shown.

• Draw the balusters and handrail and complete the el-
evation.

• Complete the plan and elevation of spiral stair.
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TASK 1
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TASK 2
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Construction Exercise 1.4.28
Interior Design & Decoration - Civil Components

Basic concept of section of a building through toilet & balcony,  deam, column
and kitchen
Objectives: At the end of this exercise you shall be able to
• identify the thickness wall
• draw the plan of building
• draw the section of the building
• draw the elevation of residence.

PROCEDURE

TASK 1: Draw the plan, elevation and sectional elevation of the building as per the line diagram (Fig 1)

1 Select a scale of 1:50.

2 Layout the drawing sheetfor plan, section and elevation.

3 Prepare the plan starting from the corner of Living room.

4 Draw wall thickness as per the scale.

5 Create the rooms as per the figure 1.

6 Erase the unnecessary construction lines.

7 Mark the position of door, windows etc.

8 Furnish the dimensions and notes where ever needed.

9 Complete the plan.

TASK 2: Draw the section (Fig 1)

1 Draw a horizontal line shows the ground level.

2 Identify the position of cutting plane.

3 Create projection lines for walls, as per the room size.

4 Draw the basement line, roof line, parapet line etc.

5 Furnish the foundation details as shown.

6 Hatch the section as per the materials used.

7 Furnish the dimensions.

8 Complete the section.

TASK 3: Draw the plan and Elevation (Fig 1)

1 Draw projection lines from plan and section.

2 Remove the unwanted projection lines and develop.
The elevation.

3 Furnish the door, window, sunshade details etc.

4 Finish the required plan and elevation by outlines.

5 Complete the working drawing with specification
schedule of joinery and other details.
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Construction Exercise 1.4.29
Interior Design & Decoration - Civil Components

Drawing of english bond and flemish band, lintals & arches, foundation
Objectives: At the end of this exercise you shall be able to
• draw the plans of english bond of 1 brick and 1½ brick thick wall
• project elevation view of english bond of 1 brick thick wall
• develop the Isometric view of english bond of 1½ brick thick wall
• draw the plan of 1 brick and 1½ brick wall
• develop the isometric view of flemish bond

• draw the elevation and section of wooden lintel
• draw the elevation of brick lintel
• draw the elevation and section of stone lintel
• draw the section of R.C.C lintel and details of bars
• Draw the elevation of

• flat Arch
• semi circular Arch
• semi Elliptical Arch (with five centres) and
• venetian Arch

• draw the top view and draw cross section of grillage foundation
• draw the isometric view of grillage foundation.
• draw the details of precast piles.

Data:

Size of brick = 230 mm x 115 mm x 75 mm

Size of queen closer = 230 mm x 57.5 mm x 75 mm

Height of each course = 75 mm

PROCEDURE

TASK 1:  English bond 1 brick thick

1 Draw horizontal and vertical lines to form ‘L’ Shape to a
required length.

2 Draw parallel line to  ‘L’ shape at an offset of 230mm.

3 Draw quoin stretcher and queen closer as shown in
Figure 1A for courses.

4 Draw headers side by side between the vertical lines.

5 Draw stretchers between the horizonl lines at an offset
of 230mm.

6 Follow the same proceducers for even course as shown
in Fig 1B.

7 Draw projections from plans of odd and even courses
and develop the elevation. (Fig 2).

8 Develop the isometric view for the plans shown in Fig
1a & 1b as show in Fig 3.

TASK 2:  English bond 1½ brick wall (Fig 2)

1 Draw the ‘L’ shape, 345mm wide

2 Complete the plan views as per the Fig 4a and 4b.

3 Draw projections from plans of odd and even courses
and develop the elevation (Fig 5)

4 Develop the isometric view for the plans shown in Fig
4A to 4B

5 Arrange odd course and even course alternately and
complete the drawings as shown in Fig 6.
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TASK 3: Draw the plan of 1 brick and 1½ brick wall

Flemish bend in walls

Data:

Size of brick =230 mm x 115mm x 75 mm

Size of queen closer = 230mm x 57.5mm x 75

Height of each course = 75 mm

1 Draw plan view of odd course of one brick wall in Double
flemish bond (Fig 1)

2 Draw 230mm thick corner wall as per exercise English
Bond.

3   Similarly draw quoin header and queen closer.

3  Draw headers and stretchers alternately in both
directions (Fig 1) and complete the drawing.

TASK 4:Draw plan view of even course of one brick wall in Double Flemish bond (Fig 1)

1 Draw the corner wall for even course as mentioned in
Task 1 & 2.

2 Complete the drawing as per Fig 1

3 Develop the isometric view of double flemish bond for 1
brick thick as shown in Fig 2.

TASK 5 : Draw  plan views of double flemish bond for one and half brick thick wall at right angled corner

1 Draw the ‘L’ shape, 345mm wide

2 Follow the procedures mentioned in TASK 3 and
TASK 4.

3 Complete the plan views as per Fig 1 and Fig 2.
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4 Develop the isometric view of double flemish bond for
one and half brick thick wall at right angled corner.
(Fig 3)

TASK 6 : Draw plan view of odd (Fig 1) and even (2) courses of single Flemish bond for one and half brick wall
at right angled corner

1 Draw the ‘L’ shape, 345mm wide

2 Draw the arrangement of bricks as flemish bond in face
and as English bond in back.

3 Complete the plan as per Fig 1 and 2.

4 Develop the isometric view of single flemish bond for 1
1 1/2 brick thick wall as shown in Fig 3.
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TASK 7: Draw plans of odd and even courses of single flemish bond for two brick wall at right angled corner

1 Draw the ‘L’ shape, 460mm wide. 2 Draw odd and even courses as shown in Fig 1 & 2

3 Develop the isometric view of 2 brick thick single flemish
bond.

TASK 8: Draw the elevation and section of wooden lintel

Draw various views of wooden, stone, brick, steel and
R.C.C. lintel

• Draw a span of 1000mm

• Draw 100 mm thick wooden Lintel

• Draw bearing of Lintel 100 mm

• Draw three bolt and nuts in elevation

• Draw three courses of Brick masonry on the top of the
wooden Lintel

• Draw a section at AA

• Draw a section of wall 300 mm

• Draw and develop the section at AA

• Draw convensional symbols

• Complete the drawing as shown in Fig 1.

TASK 9:  Draw the elevation of stone lintel

The size of stone Lintel 220 mm

Draw the elevation of stone Lintel similar to wooden Lintel

Draw bearing of Lintel 250 mm (Fig 1)

TASK 10: Draw the elevation and section of brick lintel

• Draw the elevation of brick Lintel

• Draw a span of 1000 mm

• Draw the elevation of wall

• Draw brick Lintel width of brick 100 mm and depth of
brick 300 mm

• Draw and develop the brick Lintel as shown in Fig 1.
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• Similarly Draw another form of brick Lintel as shown in
Fig 2

• width of brick 100 mm and

• depth of brick 150 mm.

TASK 11: Draw the section of steel lintel and details of bars

Steel Lintel : (Fig 1,2,3)

Size of Rolled steel Joist

Indian standard medium Weight beam (ISMB) 150 x 80 -
14.9 Kg - 1 No.

Indian standard Junior beam (ISJB)

175 x 50 - 8.1Kg.

• Draw a span of 2500 mm

• Draw ISMB 150 x 80 - 1No. at the middle of the wall.

• Draw Bearing 150 mm on both sides.

• Draw three courses of brick masonry on the top of the
lintel (Fig 1)

• Draw a section view of steel beam. (Fig 2)

• Draw and develop multiple units of I - section connected
with pipe separator. (Fig 3)

TASK 12: Draw the R.C.C. Lintel

• Draw a span of 2500 mm

• Draw a depth of beam 220 mm

• Draw a bearing of Lintel 200 mm

• Draw a bent up bar 300mm from L/7 both supports -
1 No.

• Draw straight bar at bottom of Lintel 16mm f - 2 Nos.

• Draw anchor bar at Top of Lintel 16mm  f - 2 Nos.
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• Draw stirrup 6 mm  f uniformly spaced 360 mm c/c
Fig 1

• Draw a section at AA (Fig 2)

• Draw the details bar bending. (Fig 3)

• Complete the drawing.

TASK 13: Draw the Flat Arch

Draw the elevations of Flat arch

Draw the elevation of Flat arch (gauged type)

Width of opening = 1200 mm

The depth or height of arch = 300 mm

Angle of the skewback = 600

Rise of the arch at the middle = 12 mm

Width of each voussoir at extrados = 100 mm

Thickness of mortar joints = 10 mm

• Draw the opening to a width 1200 mm and to a conve-
nient height by indicating the break line.

• Draw the skewback at an angle of 600 on both sides of
opening.

• Draw a line parallel to the top of opening at a distance
of 300mm for fixing the height of the arch.

• Project the skewback lines backwards to findout the
centre ‘c’ of the arch.

• Mark the width of voussoirs on top of extrados. Join
these points with the arch centre to draw voussoirs.

• Draw the brick layers in elevation on both sides of the
opening and top of the arch.

• Complete the elevation of flat gauged arch as shown
in Fig 1.

TASK 14: Draw the Semi circular arch

Draw the elevation of semi circular arch

Width of opening = 1200 mm

The depth or height of arch = 2 rings. = 200 mm

Angle of skewback = 00 (i.e horizontal)

Rise of the arch at the middle = 1/2 span of opening

        = 600 mm

Width of each voussoir at extrados = 100mm

Thickness of mortar joints = 10mm

Procedure

• Draw the opening to a width of 1200 mm

• Draw the springing line and mark the centre of arch
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• Draw the intrados with a radius of 600 mm and extrados
with  a radius of 800 mm from the arch centre.

• Draw the voussoirs as detailed in Fig 1 (Left side half
elevation is made with purpose made bricks with 2
rings and the right half elevation is made with gauged
bricks).The arch may be constructed with two rings of
purpose made bricks of single ring of structure.

• Draw the elevation of remaining wall and complete the
drawing as shown in Fig 1

TASK 15: Semi Elliptical arch with five centres

Draw the elevation of semi Elliptical arch with five centres

Width of opening = 1800 mm

The depth or height of arch = 300 mm

Angle of the skew back = 00 (ie horizontal)

• Draw the opening to a width of 1800 mm

• Draw the springing line AB and divide it into 5 equal
parts A1 = 1 C = CD = D5 = 5B

From the Centre A and B draw arc of radius equal to
the span, to intersect at 3.  Join the point 3 with C and
D.

• From the centres 1 and 5, draw arcs of radius equal to
3/5th of span, meeting each other at point E.

• Join points 1 and E. The point of intersection of lines
3C and E1 is 2. Similarly join 5 and E. The point of
intersection of lines 3D and E5 is 4

• The points 1,2,3,4 and 5 represent five centres of the
arch.

• Draw the left half elevation as axed arch and the right
half elevation as rough arch.

• Draw the arrangement of voussoirs and the remaining
elevation of wall as shown in Fig 1.

Draw the Venetian arch

Draw the elevation of venetian arch

Width of opening = 1200 mm

Rise = 900 mm

The depth or height or arch at skewback = 200 mm

• Draw the springing line AB to 1200mm length.

• From the midpoint of AB, mark the rise at C.

• Join AC and BC to complete the triangle ABC

• Draw the skewback AD and BE on eitherside to a
length 200 mm

• Draw DF parallel to AC and EF parallel to BC to Com-
plete the triangle DEF.

• Draw perpendicular bisectors for AC and BC. They meet
the springing line at r1 and r2 which are centre points
to draw intrados.

• Similarly draw perpendicular bisectors for DF and EF.
Let them meet the springing line at R1 and R2 which
are centre points to draw extrados.

• Draw intrados with centres r1 and r2 and extrados with
centres R1 and R2 as shown in the figure.

• Draw the voussoirs

Complete the remaining elevation as shown in Fig 2.
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TASK 16 : Draw the isometric view to show the arrangement of  (Rolled steel joist) R.S.Js in a grillage foundation
to support a steel stancheon.

First layer of RSJ

No. of R.S.J in first tier(layer) = 11 Nos.

C.S size of R.S.J = 100 mm x 125 mm

c/c distance between each RSJ = 200 mm

Dia of bolt = 16mm.

No of bolts = 3.

Second layer of RSJ

No. of R.S.J in the second layer = 4 Nos.

C.S size of R.S.J = 125mm x 300mm

c/c distance between each R.S.J = 200 mm

Bolt details similar to 1st layer

Steel Stancheon

R.S.J Column = 200 x 350 mm

Angle cleat size = 100 x 130 x 12 mm thick

Thickness of gusset plate = 16mm

1 Calculate the size of 1st  layer based on the size of
R.SJand  c/c distance between each RSJ.

2 Draw the isometric planes and arrange the first tier of
R.S.Js as shown in Fig 1 and Task 17 - Fig 2.

3 Similarly calculate the size of second layer and draw
as detailed in Fig(1).

4 Draw the RSJ column angle cleat and gusset plate as
shown in Fig 1.

5 Draw the bolt and nut arrangement and complete the
drawing as shown in Fig 1.
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TASK 17: Draw the section of grillage foundation

1 Draw the R.S.Js in Ist layer and second layer, and the
gusset plate as shown in Fig 1.

2 Draw the outline of concrete embedding as hidden line
and complete the drawing as shown in Fig 1.

3 Develop the isometric view of the grillage foundation as
shown in Fig 2.

TASK 19 : Draw the cross section of raft foundation with slab only

Thickness of pier  = 300 mm

Span between piers  = 3000 mm

Thickness of bedding concrete = 150mm

Thickness of R.C.C slab = 300 mm

Pillar offset = 300mm.

Depth of sand filling =1350mm.

1 Draw the rectangles for Bedding concrete and R.C.C
slab as shown in Fig 1.

2 Draw the supports as per the span and bearings and
complete the cross section as detailed in Fig 1.
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TASK 20 : Draw the cross and vertical section of precast piles and well foundation

The size of the pile 300mm x 300mm

Length of the pile 8000 mm

Clear cover = 40mm

Depth of cast iron shoe = 200mm.

Main bars 25mm φ4Nos. stirrups 10 mm dia spacing as
shown in Fig 1a

1 Draw cross section of pile as shown in Fig 1a.

2 Project the vertical section of pile.

3 Draw the bars as per Fig shown 1b and complete the
drawing.
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TASK 21 : Draw the vertical section of precast piles (Fig 1)

From the bottom of the pile bucket length is minimum
300 mm.

Diameter of under reamed or bulb 2 to 3 times of dia of
pile.

The vertical spacing between two bulbs varies from 1.25
to 1.50 times dia of bulb.

Draw the bars and complete the same as shown in Fig.

Skill Sequence

Drawing damp proofing in basement, floors and walls
Objectives:  This shall help you to
• draw damp proofing in basement
• draw damp proofing in floors
• draw damp proofing in walls.

Damp proofing in basement in ordinary soil (Fig 1)

Thickness of mainwalls = 300 mm

Thickness of Horizontal DPC = 30 mm

Thickness of Vertical DPC = 20 mm

Thickness of foundation conc. = 150 mm

Thickness of Brick layer = 100 mm

Thickness of floor conc. = 100 mm

Flooring thick = 40 mm

Outer protective wall =  ½ brick thick

SCALE 1:20

1 Draw the section of foundation concrete of thick
200 mm.

2 Draw horizontal DPC of thick 30 mm.

3 Draw vertical outer protective wall of  brick thick from

the right side of foundation concrete with an offset of
150mm.

4 Draw vertical DPC of thick 20 mm upto 150 mm above
ground level.

5 Draw vertical main wall of 30 cm thick.

6 Draw flooring above the floor concrete.

7 Hatch the proper conventional symbols.

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.4.29

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



92

Damp proofing in basement in damp soil using foun-
dation drains

Thickness of mainwalls = 300 mm

Thickness of Horizontal DPC = 30 mm

Thickness of Vertical DPC = 20 mm

Thickness of foundation conc. = 400 mm

Thickness of Brick layer = 100 mm

Thickness of flat brick course = 75 mm

Thickness of drain pipe = 150 mm dia.

SCALE 1:20

1 Draw the section of foundation concrete of thick 400
mm.

2 Draw horizontal DPC of thick 30 mm.

3 Draw flat brick course of thick 75 mm.

4 Draw the flooring concrete of 200 mm.

5 Draw the vertical outer protective wall of 1/2 brick thick
from the left side of foundation concrete with an offset
of 150 mm.

6 Draw vertical DPC of the 20mm upto 150mm above
ground level.

7 Draw the drain pipe of 150 mm dia as shown in Fig 2.

8 Draw the gravel filling in the sides of the foundation.

9 Hatch the proper conventional symbols and complete
the drawing with dimension and text.

Draw the details of Damp proofing in Floors.

Data:

Wall thickness = 300 mm

Depth of lean conc = 75 mm

Thickness of flat bricks = 75 mm

Thickness of DPC = 30 mm

(mastic asphalt)

Thickness of floor concrete = 100 mm

Thickness of flooring = 25 mm

SCALE 1:10

Draw the section of wall and basement

1 Draw the floor and flooring as shown in Fig 3

2 Draw the DPC of 30 mm thick mastic asphalt in wall,
floor and in the junction of wall and floor.

3 Draw the proper conventional symbols and complete
the section.

Fig 3
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Construction Exercise 1.4.30
Interior Design & Decoration - Civil Components

Demonstrate doors and windows with the help of respective models
Objective: At the end of this exercise you shall be able to
• demonstrate different type of doors and windows.

PROCEDURE

TASK 1: Identify the doors name (Fig 1)

Instructor will display the respective models in the section and demonstrate to the students regarding
the different types of doors names and uses.
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1 Trainees will note down all the displayed respective
model doors names and uses.

2 Record them in table 1.

3 Get it checked by the instructor.

TASK 2: Identify the windows name (Fig 1)

Instructor will display the respective models in the section and demonstrate to the students regarding
the different types of windows names and uses.

1 Trainees will note down all the displayed respective
model windows names and uses.

2 Record them in table 2.

Table 1

Fig no.1 Name Uses

A

B

C

Table 1

Fig no.1 Name Uses

A

B

Fig no.1 Name Uses

D

E

F

G

H

Fig no.1 Name Uses

C

D

E

F

G

3 Get it checked by the instructor.
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Construction Exercise 1.4.31
Interior Design & Decoration - Civil Components

Prepare plan, elevation and section of door
Objectives: At the end of this exercise you shall be able to
• draw the plan, elevation and section of panelled door
• draw the plan, elevation and section of panelled and glazed door
• draw the plan, elevation and section of flush doors.

PROCEDURE

TASK 1: Draw the vertical section, elevation of paneled door with the given data below (Fig 1)

DATA

Width of wall = 300 mm

Height of lintel = 150 mm

Size of door = 1000 x 2000 mm

Frame size

Head frame = 90 x 70 mm

Post = 90 x 70 mm

Vertical styles = 95 x 35 mm - 4 Nos

Top rail = 95 x 35 mm

Lock rail = 150 x 35 mm

Mid rail = 95 x 35 mm

Butt hinges = 100 - 4 Nos

Pannel = 6 nos of equal size,
20 mm thick.

1 Draw door opening, size 1000 x 2000 mm with
appropriate scale.

2 Draw two post 70 mm thick, height 1930 mm at a
distance of 860 mm apart.

3 Draw door head 70 mm thick 1300 mm length inclined
the horn.

4 Draw style of size 95 x 35 mm near the two post

5 Draw top rail 95 x 35 mm

6 Draw panel size 20 mm thick

7 Draw widrail 95 x 35mm

8 Draw lock rail 150 x 35 mm

9 Draw the bottom rail 150 x 35 mm

10 Draw panels and butt hinges as shown in Fig 1.

11 Mark the aldrop in lock rail and complete the drawing.

12 Draw the vertical section and mark the symbols and
complete the drawing.
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TASK 2: Draw the elevation and vertical section of panelled and glazed door with the given data below
    (Fig 1)

DATA

Width of wall = 300 mm

Height of lintel = 150 mm

Size of door = 1000 x 2000 mm

Frame size

Head frame = 90 x 70 mm

Post = 90 x 70 mm

Vertical style = 95 x 35 mm, 4 Nos

Top rail = 95 x 35 mm

Lock rail = 195 x 35 mm

Bottom rail = 195 x 35 mm

Butt hinges = 100 mm, 4 Nos

Pannel = 6 Nos of equal size,
20 mm thick

Glass = 3 mm thick 8 Nos

Sash = 35 x 35 mm

1 Draw door opening, size 1000 x 2000 mm with
appropriate scale.

2 Draw two post 70 mm thick, height 1930 mm at a
distance of 860 mm apart.

3 Draw door head 70 mm thick

4 Draw style of size 95 x 35 mm near the two post.

5 Draw top rail 95 x 35 mm

6 Draw sash bar and glass panel as shown in Fig 1.
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TASK 3: Draw the elevation and section of solid or laminated flush door (Fig 1a)

DATA

Size of door = 1000 x 2000.

Post = 80 x 120 mm 2 Nos.

Head = 80 x 120 mm.

3 ply = 6 mm thick.

Thickness of shutter 44 mm.

1 Draw the door opening, size of 1000 x 2100 mm.

2 Draw two posts of thickness 80 mm, and height 1920
mm at a distance of 840 mm apart.

3 Draw a head 80 mm thickness over the post.

4 Draw parallel strips 16 mm each as shown in Fig 1a.

5 Draw the details of section as shown in Fig 1a.

6 Complete the drawing.

7 Draw the lock and mark the aldrop. 8 Develop the vertical section mark the symbols and
complete the drawing.

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.4.31

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



98

TASK 4: Draw the elevation and section of framed flush door (Fig 1b)

DATA

Horizontal = 20 mm wide.

Vertical ribs = 10 mm

Ventilaling hole = 10 mm

Bottom rail = 40 x 25.

1 Draw the door opening, 1000 x 2100 mm.

2 Draw two points of thickness 80 mm, and height 1920
mm at a distance of 840 mm apart.

3 Draw a head 80 mm thickness over the post.

4 Draw horizontal & vertical ribs of 20 mm width as
shown in Fig 1b.

5 Draw bottom rail of size 40 x 25 mm.

6 Draw the details of section as shown in Fig 1b.

7 Complete the drawing.
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Construction Exercise 1.4.32
Interior Design & Decoration - Civil Components

Preparation of plan elevation & section of window
Objective: At the end of this exercise you shall be able to
• draw the plan of elevation & section of window.

PROCEDURE

TASK 1: Draw the elevation & section of casement window with ventilator

DATA

Size of windows = 1800 x 1670 mm

No. of glazed pavel = 6

Frame = 100 x 60 mm

Ventilator rail = 35 x 75 mm

Transome = 100 x 60 mm

Sill size = 100 x 60 mm

Head = 100 x 60 mm

Post = 100 x 60 mm, 4 Nos

Hanging style = 35 x 75 mm, 3 Nos.

Meeting style = 35 x 75 mm, 3 Nos.

Top rail = 35 x 75 mm, 3 Nos.

Bottom rail = 35 x 75 mm, 3 Nos.

1 Draw the post of size 100 x 60 x 1670 mm as shown in
the Fig 1.

2 Draw sill and head of size 100 x 60 x 1800 mm as
shown in the Fig 1.

3 Draw the transome of size 100 x 60 x 1800 mm as
shown in the Fig 1.

4 Draw the hanging style 75 x 35 mm as shown in the
Fig 1.

5 Draw the meeting style 35 x 75 mm.

6 Draw top and bottom rail 35 x 75 mm between the
styles.

7 Draw the three glass panels between the top and
bottom rails.

8 Draw the vertical section in the Fig 1.
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DATA

Aluminium 2 track, = 62 x 32 x 1040 mm, 2 Nos.
E channel

Aluminium 2 track, = 62 x 32 x 860 mm, 2 Nos.
E channel top & bottom

Side shutter section = 40 x 18 x 1010 mm, 2 Nos.

Top and bottom = 40 x 18 x 380 mm, 8 Nos.
Shutter section

TASK 3: Draw the elevation and section of aluminium sliding window

Inter lock shutter = 40 x 18 x 1010 mm, 2 Nos.

Plain glass = 937 x 363 x 5 mm, 2 Nos.

1 Draw the U channel outer frame size 1040 x 860 mm.

2 Draw the sliding window side shutter and inter lock
shutter height 1001 mm.

3 Draw the top and bottom shutter size 405 mm.

4 Complete the drawing as per the shown Fig 1&2.

DATA

Head = 75 x 110 mm

Post = 75 x 110 mm, 2 Nos.

Hanging style = 75 x 32 mm, 2 Nos.

Meeting style = 75 x 32 mm, 2 Nos.

Top rail = 75 x 32 mm, 2 Nos.

Frieze rail = 75 x 32 mm

Bottom rail = 75 x 32 mm

Sill = 75 x 110 mm

1 Draw two post of 75 mm thick and 1050 mm height at
distance of 600 mm apart.

2 Draw a sill of 75 mm thick and 900 mm length below
the post.

3 Draw the head of 75 mm thich 900 mm length over
the post.

4 Draw the hanging style of width 75 mm near the posts.

5 Draw the two meeting styles of width 75 mm in the
middle.

TASK 2: Draw the elevation and details of sash window (Fig 1)

6 Draw top rail and bottom rail of height 75 mm between
the styles draw the vertical section as shown in Fig 1.
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Construction Exercise 1.4.33
Interior Design & Decoration - Civil Components

Free hand sketches of graphic symbols for door and windows
Objective: At the end of this exercise you shall be able to
• draw free hand sketches of doors and windows.

PROCEDURE

TASK 1: Draw the free hand sketches of graphic & symbols for windows
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TASK 2: Draw the free hand sketches of graphic & symbols for doors
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Construction Exercise 1.5.34
Interior Design & Decoration - Perspective Drawing and Basics of Computer

Interiors one point perspective
Objective: At the end of this exercise you shall able to
• draw one point perspective.

TASK 2: Draw a one point perspective with low central vanishing point.

PROCEDURE

TASK 1: Draw a one point perspective with high central vanishing point (Fig 1)

1 Draw the one point perspective by drawing a focus point.

2 Then draw walls and windows respectively.

3 Then draw the furnitures and fixtures accordingly.
(Fig 1)
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TASK 3: Draw one point perspectives at different vanishing point

1 Draw a one point perspective with high central
located vanishing point. (Fig 1)

2 The effect of low central vanishing point. (Fig 2)

3 The efffect of the horizontal placement of the vanishing
point. (Fig 3)

4 The effect of a centrally located vanishing point.
(Fig 4)

5 Left-wall emphasis is obtained by placing the
vanishing point to the extreme right. (Fig 5)
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Skill Sequence

Drawing of interior perspective view
Objectives: This shall help you to
• draw the plan
• draw the interior perspective view.

Draw the Interior Perspective Views from the data
given (Figs 1&2).

DATA

1 Size of room = 4000 x 3000mm

2 Size of door D = 1000 x 2100 mm

3 Size of door D1= 900 x 2100 mm

4 Window size = 1100 x 2100 mm

5 Size of box = 800 x 2000 mm

6 Height of ceiling = 3000 mm

7 Draw plan of room = 4000 x 3000 mm

8 Draw the plan at the bottom of your drawing sheet so
as to generate the interior perspective above the plan.

9 Mark the position of doors and windows as shown in
(Fig 1)

14 Draw perpendicular line from A and B.

15 Mark C and D as ceiling height 3000 mm.

16 Complete the rectangle ABCD.

17 Draw the diagonals CB and AD.

18 Find the centre of vision (CV).

19 Coincide R and CV and mark at AB as

20 From the point 1, draw perpendicular, to cut the diagonal
AD at a 1.

21 Complete the rectangle a1, c1, d1, b1.

22 Mark the height of door 2100mm as shown in (fig 2).

10 Draw the box 800 x 2000 mm as shown in (Fig 1).

11 Draw square floor tiles in plan.

12 Complete the plan of room as shown in fig 1.

13 Draw a horizontal line AB.  Parallel to R.S. (fig 2).

23 Coinside the height of door and cv.

24 Coinside side door towards cv and marks at AB.

25 Draw perpendicular up to height of door.

26 Draw similarly door and windows.

27 Project floor tiles from plan up to AB.

28 All projected lines join towards cv.

29 Similarly draw horizontal line of tiles.

30 Draw box shape in the interior perspective.

31 Complete the interior perspective drawing.
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Perspective projection
Objectives: This shall help you to
• describe perspective projection
• describe uses of perspective drawings
• describe four elements of perspective
• describe the types of perspective.

Describe perspective projection (Ref. Fig 1)

The most realistic form of pictorial drawing is the
perspective.  This is because it allows for the reduction
in size of an object as it recedes from the viewer.

Perspective drawing should three dimensional objects
in a single plane as they appear to the eye.

Uses of Perspective Drawing

Perspective drawings are used in architectural design
to portray the finished structure in a realistic manner.

The perspective to illustrate proposed product, designs
and illustrate advertising copy.

A perspective has four elements (Fig 1)

Types of Perspective

There are three types, according to the number of vanishing
point.

1 One point or parallel perspective.

2 Two Point perspective

i Object

ii A station point

iii A picture plane

iv Visual rays

i Object: The product is viewed.

ii Station Point: The point from which the product is
viewed called the station point.

iii Picture plane: The plane upon which the product is
projected, called the plane of projection or picture plane.

iv Visual rays: The projectors called visual rays which
run from the station point to the product.

v Centre of Vision:  The centre of vision is located at
the centre of the area on the product.

One point or Parallel perspective

If the object is placed so that the face or front view is
parallel with the picture placed.
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Draw two point perspective
Objectives: This shall help you to
• draw two point perspective.

Draw two point perspective as given below in Figs
1&2.

1 Place two points V1, V2, which is achived by drawing
two points from central line and during it into two points
respectively as in (Fig 1)

2 Then taking consideration from the two varnishing points
and draw the window, wall and furnitures respectively
as in (Fig 2).

3 Then from (Fig 3) start plaing furnitures and human
figures (Fig 4) and accessories.
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Construction Exercise 1.5.35
Interior Design & Decoration - Perspective Drawing and Basics of Computer

Render the perspective view with any medium
Objectives: At the end of this exercise you shall be able to
• draw types of renderings
• use of renderings.

PROCEDURE

TASK 1: Draw the two style of Rendering (a) from soft pencil (b) from pen & ink rendering in the drawing
sheet. (Fig 1 & Fig 2)

a From soft pencil (Fig 1) b From pen & ink (Fig 2)

TASK 2: Draw the method of shading to show sunlight of high areas and shadow the area opposite the light
source in the drawing sheet (Fig 1)© N
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TASK 3: Draw the shadow using reflection method (Fig 1)

TASK 4: Draw the method of rendering of types of (Fig 1) fenees and walls  (Fig 2) and architectural sketchers
of people (Fig 3) landscaping in the drawing sheet.

Trees and shelbs (Figs 1&2)
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Architectural sketchers of people (Fig 3)

TASK 5: Render the image (Fig 1) with any one rendering media and technique

a Color pencils

b Poster color

c Dry partels

d Crayon

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.5.35
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Fig 1

Construction Exercise 1.5.36
Interior Design & Decoration - Perspective Drawing and Basics of Computer

Installation of coral draw, photoshop and sketch up 3D’s max with V-ray
and Luminous software and prepare the power point skill presentation
Objectives: At the end of this exercise you shall be able to
• open a CorelDraw X5 Software
• create a New Drawing in CorelDRAW
• draw a given line drawing by using the Freehand Tool
• do the lab assignment.

Requirements

Tools/Equipments/Instruments

• Personal Computer with Windows XP Professional
Operating system (Latest Configuration) Suitable
for the CorelDraw Graphics Suite Software

• CorelDraw Graphics Suite X5 Software (Latest version)

PROCEDURE

TASK 1: Basic of  CorelDraw open a corelDraw X5 Software

1 Click 'Start' Button   from the Task Bar
2 Select 'Programs' in the Popup Menu

3 Click the 'CorelDRAW Graphics Suite X5' in the
Programs Menu.

4 Click  'CorelDRAW X5'. The window will appear as
shown in Fig.
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5 A CorelDRAW X5 window will appear as shown in Fig.2

Fig 2

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.5.36

TASK 2 : Create a New Drawing in CorelDRAW

Method 1

1 Click on the Welcome Page, click Quick Start

2 Click New blank document. The Window will appear as
shown in Fig 3.

Fig 3
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Fig 6

3 Type a filename in the Name text box. Will appear as
shown in Fig 4.

Fig 4

4 Place the curser Preset destination list box,

5 Click Pull down Menu, choose Default CMYK

This command applies settings for creating
graphics that are destined for commercial
printing). Will appear as shown in Fig 5.

6  Choose a unit of measurement in Centimeter from the
Unit of measurement list box

You can also choose British and American
Metric System such as Inches, Millimeters, Pica,
Point, Pixels etc.

Fig 5

7 Place the curser in the Size tab box

8 Click Pull down Menu and Select A4 paper size

Create custom Page size type values in the
width and height boxes.

9 Select Portrait button in the page orientation buttons
(Portrait or Landscape)

10 Choose a color mode in CMYK at the primary color
mode list box

11 Select a rendering resolution from the Rendering
resolution list box

The rendering resolution for effects that will
likely be rasterized, such as transparency, drop
shadow, and bevel effects

12 Choose the Enhanced preview mode from the Preview
mode list box

13 Select a default RGB profile from the RGB profile list
box

14 Choose a default CMYK profile from the CMYK profile
list box

15 Select a default Grayscale profile from the Grayscale
profile list box

16 Click OK. The New Document will appear shown in
Fig 6.

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.5.36

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



117

Method 2

1 Click 'File Menu' in the Menu Bar

2 Select 'New' Menu (Press Ctrl +N from the Keyboard
shortcut key).  Will appear as shown in Fig 7.

3 Repeat the Step 3 to 16 in Task 2 of method 1

You can add and delete a destination preset by
choosing the preset name from the Preset
destination list box, and clicking the Remove
preset button.

Fig 7

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.5.36

Method 3

1 Click 'File Menu' in the Menu bar

2 Select 'New from template' Menu. Will appear as shown
in Fig 8.

Fig 8

3 Choose a template from the Templates list will appear
as shown in Fig 9 (if the file is not appear in the
Templates list go to the next step)

4 Click Brows to select specific Template file. Will appear
as shown in Fig 10.

you can choose different Template files in the
'Browse' button (the Browse button will appear
in Left bottom corner of the 'New from Template'
dialog box)

5 Click Open.

Fig 9

Fig 10© N
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If the Shape is not correct you can erase as you
draw hold down the Shift button on the keyboard
and drag backwards.

5 Select 'Shape  Tool'  in the Toolbox

6 Choose 'All nodes button' in the Property bar, the object
look like as shown in Fig 12.

Fig 12

To reduce the number of nodes in the entire

object, click the Select all nodes button   on

the property bar

To reduce the number of nodes in a part of a
curve object, marquee select the part you want
to change.

7 Click and Move the Curve smoothness slider. (Now the
object look like as shown in Fig 13.

Fig 13

TASK 3 : Draw a given line drawing by using the Freehand Tool

A line is a path between two points. Lines can
consist of multiple segments, and the line
segments can be curved or straight. The line
segments are connected by nodes, which are
depicted as small squares. CorelDRAW provides
various drawing tools that let you draw curved
and straight lines, and lines containing both
curved and straight segments.

1 Select the 'Freehand Tool'  in the Toolbox.

2  Click Centre of the Page to Draw drag the mouse like
a pencil on paper

You can constrain a line created with the
Freehand  tool to a predefined angle, called a
constrain angle, by holding down Ctrl while
you drag. This feature is useful for drawing
straight vertical and horizontal lines

3 Draw the Leaf in correct shape as shown in the Fig 11.

4 Release the mouse button

Fig 11

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.5.36

The number of nodes that are removed.
Removing many nodes can reshape the curve
object.

If the Shape is not in correct you can Add and

delete a node by using the Shape Tool  and

Property bar.

8 Draw the Midrib and vein lines.

9 Correct shape of the Midrib and vein lines by using the

Shape Tool 

10 Click File Menu and Choose 'Save' the Document. The
dialog box will appear in shown in figure.

Drawings are saved to the CorelDRAW file
format (CDR) and are compatible with the latest
version of the application. You can also save a
drawing that is compatible with an earlier
version of CorelDRAW Graphics Suite
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11 Place the curser in the 'Save in' button and click pull
down menu.

12 Choose the d: (d drive) and open 'DTPO' folder by double
clicking the cursor in the DTPO folder.

13 Type file "DTPO Drawing" in the file name button.

Fig 14

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.5.36

TASK 4 : Do the lab assignment

1 Create a "New Document"

2 Repeat the Step 3 to 16 in Task 2 of method 1
3 Draw the own object by using Freehand Tool 

4 Check with the instructor.

14 Click  'Save'. The file will appear shown in figure.

15 Close the "DTPO Drawing.cdr" by clicking the file menu
and choose to 'close' will appear as shown as Fig 14.

16 Click File menu and choose 'Exit.

17 Check with the instructor.

Create new photoshop document
Objectives: At the end of this exercise you shall be able to
• install a Creative Suite 6 suite or stand-alone product from disc
• create, Open, and import images in Adobe Photoshop
• open a file with Adobe Bridge
• import images from a digital camera and scanner.

TASK 1: Create new photoshop document install a Creative Suite 6 suite or stand-alone product from disc

1 Insert the Adobe Creative Suite 6 suite or stand-alone
product Application DVD into your DVD drive.

2. Double-click Set-up.exe (Windows) or Install.app (Mac
OS) to begin the installation.

Depending on your Autoplay settings in
Windows, the Set-up.exe file can launch
automatically.

3. Follow the onscreen instructions to complete the
installation.

4. When prompted to enter a serial number, enter your
Adobe Creative Suite 6 suite or stand-alone product
serial number and complete the installation.

You must accept the license agreement and warranty
terms to use this product. This product doesn't function
without mandatory activation and registration via the Internet.

Adobe's single user license allows installation of a single
product license on two machines (such as one work

machine and one home machine) provided the same
individual uses the software, and not concurrently on both
machines.

If you want to install the product on a third
computer, first deactivate the software on one
computer. To deactivate, choose Help >
Deactivate.

If your product is on multiple discs, wait for first disc to
complete. Once completed, remove the first disc and insert
the second disc in same DVD drive.

Requirements

• Personal Computer with Windows 7
Professional Operating system (Latest
Configuration) Suitable for the Adobe
Photoshop CS6 Software

• Adobe Photoshop CS6 software (Latest
version)
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TASK 2: Create, Open, and import images in Adobe Photoshop

Open a Adobe Photoshop CS6

1. Click 'Start' Button from the left corner of the Task Bar
of the windows 8.1 version OS the down arrow will
appear on the left bottom of the screen see the figure

2 In the New dialog box, type a name for the image.

3 (Optional) Choose document size from the Preset
menu.

To create a document with the pixel dimensions
set for a specific device, click the Device Central
button.

4 Set the width and height by choosing a preset from the
Size menu or entering values in the Width and Height
text boxes.

To match the width, height, resolution, color mode, and
bit depth of the new image to that of any open image,
choose a filename from the bottom section of the Preset
menu.

5 Set the Resolution, Color Mode, and bit depth.

If you've copied a selection to the clipboard, the image
dimensions and resolution are automatically based on that
image data.

6 Select a canvas color option:

White Fills the background layer with white, the default
background color.

Background Color Fills the background layer with the
current background color.

Transparent Makes the first layer transparent, with no
color values. The resulting document has a single,
transparent layer as its contents.

2 Click the Down arrow and select the Adobe Photoshop
CS6. See the figure and follow.

3 The Adobe Photoshop will appear as shown in the
following figure

Create an image

1 Choose File > New.

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.5.36
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7 (Optional) If necessary, click the Advanced button to
display more options.

8 (Optional) Under Advanced, choose a color profile, or
choose Don't Color Manage This Document. For Pixel
Aspect Ratio, choose Square unless you're using the
image for video. In that case, choose another option to
use nonsquare pixels.

9 When you finish, you can save the settings as a preset
by clicking Save Preset, or you can click OK to open the
new file. See the figure and follow the same option in the
dialog box

10 The New Document will appear as shown in the following
figure

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.5.36
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4 Click Ok button. The new document will appear as
shown in the following figure.

 

Open a file using the Open command 1 Choose File>
Open.

Select the name of the file you want to open. If the file does
not appear, select the option for showing all files from the
Files of Type pop-up menu.

3 Click Open. In some cases, a dialog box appears,
letting you set format-specific options. See the figure
and follow the same option in the figure (select the
image file from already saved in your computer or
download from the web site.)
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Duplicate an image

You can duplicate an entire image (including all layers,
layer masks, and channels) into available memory without
saving to disk.

1 Open the image you want to duplicate.

2 Choose Image > Duplicate.

3 Enter a name for the duplicated image. See the figure
and follow.

4 If you want to duplicate the image and merge the layers,
select Duplicate Merged Layers Only. To preserve the
layers, make sure this option is deselected.

5 Click OK. The duplicate image document will appear as
shown in the following figure.
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Open a recently used file

• Choose File > Open Recent, and select a file from the
submenu.

Open PDF files

1 (Photoshop) Choose File > Open.

2 In the Open dialog box, select the name of the file, and
click Open.

3 Under Select in the Import PDF dialog box, select
Pages or Images, depending on what elements of the
PDF document you want to import.

Art Box Crops to the region specified in the PDF file for
placing the PDF data into another application.

7 Under Image Size, enter values (if necessary) for Width
and Height:

• To preserve the aspect ratio of the pages as they're
scaled to fit within the rectangle defined by the Width
and Height values, select Constrain Proportions.

• To scale the pages exactly to the Width and Height
values, deselect Constrain Proportions. Some distortion
might occur when the pages are scaled.

When more than one page is selected, the Width and
Height text boxes display the maximum width and height
values of the selected pages. All pages are rendered at
their original size if Constrain Proportions is selected and
you don't change the Width and Height values. Changing
the values will scale all pages proportionately as they're
rasterized.

8 Specify the following options under Image Size:

Resolution Sets the resolution for the new document.

Mode Sets the color mode for the new document.

Bit Depth Sets the bit depth for the new document.

The Width and Height values plus the Resolution determine
the final pixel dimension of resulting document.

9 To suppress color profile warnings, select Suppress
Warning.

10 Click OK. The image file will appear.

Open an EPS file

You can also bring PostScript artwork into Photoshop
using the Place command, the Paste command, and the
dragand-drop feature.

1 Choose File > Open.

Select the file you want to open, and click Open.

2 Indicate the desired dimensions, resolution, and mode.
To maintain the same height-to-width ratio, select
Constrain Proportions.

3 To minimize jagged lines at the edges of artwork, select
Anti-aliased.

Change the screen mode

You can use the screen mode options to view images on
your entire screen. You can show or hide the menu bar, title
bar, and scroll bars.

To display the default mode (menu bar at the top and scroll
bars on the side), choose View > Screen Mode > Standard

Screen Mode. Or, click the Screen Mode button 

in the Application bar, and select Standard Screen Mode
from the pop-up menu.

or

To display a full-screen window with a menu bar and a 50%
gray background, but no title bar or scroll bars, choose

 

4 Click the thumbnails to select the pages or images you
want to open. Shift-click to select more than one page
or image. The number of selected items appears under
the preview window. If you're importing images, skip to
step 8.

Use the Thumbnail Size menu to adjust the
thumbnail view in the preview window. The Fit
Page option fits one thumbnail in the preview
window. A scroll bar appears if there are
multiple items.

5 To give the new document a name, type it in the Name
text box. If you're importing more than one page or
image, multiple documents open with the base name
followed by a number.

6 Under Page Options, choose from the Crop To menu to
specify what part of the PDF document to include:

Bounding Box Crops to the smallest rectangular region
that includes all the text and graphics of the page. This
option eliminates extraneous white space and any
document elements outside the Trim Box.

Bounding Box will not crop white space that is
part of a background created by the source
application.

Media Box Crops to the original size of the page.

Crop Box Crops to the clipping region (crop margins) of the
PDF file.

Bleed Box Crops to the region specified in the PDF file for
accommodating limitations inherent in production processes
such as cutting, folding, and trimming.

Trim Box Crops to the region specified for the intended
finished size of the page.
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View > Screen Mode > Full Screen Mode With Menu Bar.
Or, click the Screen Mode button in the Application bar,
and select Full Screen Mode With Menu Bar from the pop-
up menu.

or

To display a full-screen window with only a black background
(no title bar, menu bar, or scroll bars), choose View >
Screen Mode > Full Screen Mode. Or, click the Screen
Mode button in the Application bar, and select Full Screen
Mode from the pop-up menu.

Use the Navigator panel

You use the Navigator panel to quickly change the view of
your artwork using a thumbnail display. The colored box in
the Navigator (called the proxy view area) corresponds to
the currently viewable area in the window.

To display the Navigator panel, select Window > Navigator.

or

To change the magnification, type a value in the text box,
click the Zoom Out or Zoom In button, or drag the zoom
slider.

or

To move the view of an image, drag the proxy view area in
the image thumbnail. You can also click the image
thumbnail to designate the viewable area.

Magnify a specific area

1 Select the Zoom tool.

2 Drag over the part of the image that you want to magnify.

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.5.36

A Panel menu button  B Thumbnail display of artwork  C  Proxy
preview area  D  Zoom text box  E Zoom Outbutton F Zoom slider
G Zoom Inbutton

The area inside the zoom marquee is displayed at the
highest possible magnification. To move the marquee
around the artwork in Photoshop, begin dragging a marquee
and then hold down the spacebar.

TASK 3: Opening a file with Adobe Bridge

1 Choose File > Browse In Bridge. If you're prompted to
enable the Photoshop extension in Bridge, click OK.

2 Select the Folders tab in the upper left corner, and then
browse to the particular folder you copied from the DVD
onto your hard disk.

3 Select the specify folder, and choose File > Add To
Favorites. Adding files, folders, application icons, and
other assets that you use often to the Favorites panel
lets you access them quickly.

4 Select the Favorites tab to open the panel, and click the
particular folder to open it. See the figure and follow.

5 Select and double click image. The image file window
will appear in the Adobe Photoshop.
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TASK 4: Import images from a digital camera, and Scanner

Import images from a digital camera using WIA (Windows
only)

Certain digital cameras import images using Windows
Image Acquisition (WIA) support. When you use WIA,
Photoshop works with Windows and your digital camera or
scanner software to import images directly into Photoshop.

1 Choose File > Import > WIA Support.

2 Choose a destination in which to save your image files
on your computer.

3 Make sure that Open Acquired Images in Photoshop is
selected. If you are importing a large number of images,
or if you want to edit the images later, deselect Open
Acquired Images.

4 To save the imported images directly into a folder whose
name is the current date, select Unique Subfolder.

5 Click Start.

6 Select the digital camera from which to import images.

If the name of your camera does not appear in
the submenu, verify that the software and drivers
were properly installed and that the camera is
connected.

7 Choose the image or images you want to import:

• Click the image from the list of thumbnails to import
the image.

• Hold down Shift and click multiple images to import
them at the same time.

• Click Select All to import all available images.

8 Click Get Picture to import the image.

Import images using a TWAIN interface

TWAIN is a cross-platform interface for acquiring images
captured by certain scanners, digital cameras, and frame
grabbers.

1 Install the TWAIN software provided by the device
manufacturer.

2 Download the Photoshop TWAIN plug-in for Windows

3 Choose File > Import, and select the device you want
to use from the submenu.

Import images using a WIA interface (Windows only)

1 Choose File > Import > WIA Support.

2 Choose a destination on your computer for saving your
image files.

3 Click Start.

4 Select Open Acquired Images In Photoshop (unless
you have a large number of images to import, or if you
want to edit the images at a later time).

5 Select Unique Subfolder if you want to save imported
images in a folder named with the current date.

6 Select the scanner that you want to use.

If the name of your scanner does not appear in
the submenu, verify that the software and drivers
were properly installed and that the scanner is
connected.

7 Choose the kind of image you want to scan: Color
Picture, Grayscale Picture, or Black And White Picture
or Text.
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8 To specify custom settings, select Adjust The Quality
Of The Scanned Picture.

9 Click Preview. If necessary, drag the handles of the
bounding box to adjust the size of the crop.

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.5.36

Fig 1

10 Click Scan.

The scanned image is saved in BMP format.

Sketch up 3D’s max
Objectives: At the end of this exercise you shall be able to
• install a creative sketch up 3D’s max software.

TASK 1: Sketch up 3D’s max install a creative sketch of 3D’s max

Step 1: Go to the Autodesk 3ds Max education page.

Step 2: Sign in to an existing Autodesk account using your
e-mail address and password.

Step 3: If you don't have account then click create.

Step 4: Fill all the details

Fig 2

Fig 3

Fig 4

Fig 5

Fig 6

Step 5: Sign in to get the educational access.

Step 6: Select get started to download the software.
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Fig 7

Fig 8

Fig 9

Fig 10

Fig 11

Fig 12

Step 7: Check all the details and click confirm.

Step 8: Upload your student ID card photo.

Step 9: Right click on the download setup file and run it in
administer.

Step 10: Choose where to install.

Step 11: Select necessary components and click install.

Step 12: Click start to run the software.
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Fig 13

Fig 1

V - ray Software
Objectives: At the end of this exercise you shall be able to
• install a creative use V-ray software.

Step 13 : Installation completed.

TASK 1: Install and use V-ray software

Step 1: Go to http://download.chaos.com/© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



130

Fig 2

2023 2022 2021 2020

2019 2018 2017 2016

2015 2014 2013 2012

2011 2010 2009 2008

Fig 3 Fig 4

Fig 5
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Step 2: Select V-Ray 3D’s Max

Step 3: Select the version according to your need. Step 4: Select download

Step: 5: Right click on the download setup file and run it in
administrator.
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Fig 6
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Create new lumion software
Objectives: At the end of this exercise you shall be able to
• install a creative new lumion software.

Step 1: Go LUMION official page then select try lumion free

Fig 1

Step 2: Select request a limited trail

Fig 2

Step 6: Installation completed.
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Step 3: Fill all the details Step 4: Go to Lumion account

Step 5: Click view more to download the product

Fig 3 Fig 4

Fig 5

Fig 8

Step 6: Download the product

Fig 6

Step 7: Download Lumion installer

Step 8: Right click on the download setup file and run it in
administrator.

Fig 7
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Fig 9

Fig 10

Fig 11

Step 9: Enter the Activation code you received in the e-
mail.

Step 10: Download Lumion installer

Step 11: Software successfully installed
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Prepare the power point skill presentation
Objectives: At the end of this exercise you shall be able to
• open a power point and create a new document
• familiarize different power point screen components.

TASK 1 : Open a Power point and creat a new document

1 Boot the system, if not booted

2 Click Start Button

3 Select Programs

4 Click Microsoft Power Point. (Fig 1)

5 PowerPoint window will open (Fig 2)

Requirements

A working PC with MS Office 2007

Fig 1

Fig 2

Create a New Presentation (Fig 3)

1 Choose File Menu

2 Click New option (Short cut key : Ctrl  + N)

3 Created a New presentation

Fig 3
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Fig 5

3 Displayed Save as window

4 Type the name of the presentation "sample" (Fig 3)

5 Choose saving location

6 Click save button

7  Saved current presentation "sample" (Fig 4)

Close the current presentation:

1 Choose file menu

2 Click Close option

3 Closed current presentation

Insert a New Slide

1 Choose Insert Menu

2 Click New Slide (Short cut key : Ctrl + M). (Fig 5)
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Fig 1

TASK 2 : Familiarize different Power point screen components. (Fig 1)

Fig 2

1 Choose Fie Menu

2 Click Open option which displays,

3 existing presentation.

4 Choose any one presentation " presentation1"

5 Click Open button to open the presentation 1’

Save a current Presentation

1 Choose File menu

2 Click Save option (Fig 2)

Fig 4

Fig 3
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Construction Exercise 1.5.37
Interior Design & Decoration - Perspective Drawing and Basics of Computer

Prepare the power point animated presentation
Objectives: At the end of this exercise you shall be able to
• insert a simple animation to text
• arrange timing for each animation
• set transition between slides.

Requirements

Tools/Equipments/Instruments

• A working Computer with MS Office 2007  - 1 No.

PROCEDURE

TASK 1: Insert a simple animation to text

1 When the Slide 1 Normal View screen appears,

2 click on the first line of text.

3 The first Text Box will appear as below. (Fig 1)

4 When you see the above Text Box, highlight the text.
When you do, you will again see the Drawing Tools
Tab appear.

5. Click the Drawing Tools Tab and the Drawing Tools
Ribbon will again appear - just like it did for WordArt.
(Fig 2)

Arrange timings for each animation

1 Click the Animations Tabagain,

2 Thenclick the down triangle to the right of Custom
Ani….

3 When the drop down menu appears click Custom
 Animation… (Fig 3)

4 The following Custom Animation Task Pane will appear
on the  your screen.When this screen appears, first,
click Add Effect,Then click Entrance, and finally click
More Effects  (because we want ALL of the effects).
(Fig 4)

5 The Add Entrance Effect menu screen will appear.
(Fig 5)

6 Move your cursor over the blue Add Entrance Effect
"bar" at the top of the menu screen. Click and hold
down the left mouse button and drag the menu screen
to the right of your screen so that you can see the
textin the Title text box.  After you have moved this box
raise your finger from the left mouse button.

7 Choose one of the effects by clicking-on it.  You will
now be able to see the animation effect in the Text
box.  You may hear a sound that is "part" of your Slide
Transition.

Fig 3

Fig 1
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Fig 4

Fig 5

8 Notice - on the right side of the screen - under Custom
Animation - that the Titles (on which we added effects)
are shown as a part of this screen.

Also notice, on the right side of our second title there
is a small, down pointing arrow.

9 Click-on this arrow it will show you each line of text that
you animated in the lower sub-title box. (Fig 6)

Now we'll enhance our text some more. (Fig 7)

10 Move your cursor over the first title and click the left
mouse button.  Next click the small down arrow on the
right sideof this box.  You will see a menu screen
appear that will let you enhance your title. Choose
(click)Effect Options and the menu screen below will
appear.

Chose magnify for our text effect and then chose laser
for our sound.

11 Go ahead and experiment with Entrance effects and
sounds for your slide. (Fig 8)

Fig 6

Fig 7

Fig 8
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Name: Created set times on the Animations Tab
for your slides, and desire to have the show

1 Run in "automatic," click theSlideShowTab and then

2 Clickthe Set Up Slide Show button. (Fig 1)

TASK 2: Arrange Timings for each animations

The following Set Up Show menu screen will appear.
(Fig 2)

In the Advance slides box (Fig 3)

3 click the circular area to the left of Using timings, if
present.  Look over the other choices in this menu
screen.  Notice that there are a lot of enhancements
in this Set Up Show menu screen.  Experiment, as
you desire.

4 Click theOKbutton when you have made your changes.

5 if they desire to have the show repeat continuously, is
the Loop continuously until 'Esc' selection.  This is
indicated by an arrow to the Show options area.
(Fig 4)

6 Clickon Slide Show Taband then select Rehearse
Timings. (Fig 5)

7 A small, rehearse timings "box" will appear (image
above).  It will "show" a running clock on the right side
of the menu - that indicates the time for the entire
show.

Fig 2

Fig 1

Fig 5

gFig 4

Fig 3
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TASK 3: Set transition between slides

1 Now well add some pizzazz to our presentation.
When you viewed your slide show, a few moments
ago, it was like "flopping down" plastic transparencies
on an overhead projector." Now add some motion,
animation, sound, and color and really make our
presentation something to view. (Fig 1)

2 Go to the Slide Sorter button at the bottom right area
of the screen.

3 Click on the button with four white squares.

4 You can now seeall nine slides (as shown below).
Notice that Slide 9 (the one with the flying bat) does
not show the path of the bat.  This is because of the
motion path - not a big deal. Lightly,click once on the
first slide to highlight the slide (an orange border will
surround the slide - see arrow below).  Now point in
the MIDDLE of Slide 1 and click on your RIGHT
mouse button. (Fig 2)

5 If you accidentally quick twice on Slide 1, this will take
you to the Slide View, again.  If this happens, simply
click on the Slide Sorter View button at the bottom of
the screen, just like you did on the last page.With Slide
1 "marked," click the Animations Tab.  The Animations
Ribbon will again open. (Fig 3)

For previous PowerPoint users, this is another "totally
new" method. (Fig 4)

6 Transitions are neat, visual actions, as we move from
slide to slide in our show.  To get a "feel" for what
Transitions do, click the More Arrow in the lower right
corner of the Transition to This Slide Group. (Fig 6)

A Transition selection screen similar to the image on
the right will appear.

Notice in - the Animations Ribbon a Group - Transition
to This Slide. (Fig 5)

7 So, let's get started in creating some movement
(transitions) as we enhance our PowerPoint slide
show.  Remember that we clicked-on Slide 1 to begin
this process.

We have enlarged the Fades and Dissolves and
Wipes sections of the Transitions image on the last
page.  We moved our cursor over Wipe Up and clicked
on it.  Immediately our Slide 1 Transitioned with a
Wipe Up. (Fig 7)

8 AtthebottomoftheTransition to This Slide Group there
is a Random area.  One of the choices has a Question
Mark ( ? ). We chosethis selection and then chose
Apply to All Slides.  So, when we show our slides, each
slide will transition with a different effect. (Fig 8)

gFig 7

Fig 6

g

 More Arrow 

Fig 5

gFig 1

Fig 2

Fig 3

Fig 4
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9 Go ahead and try as many Slide Transitions as you
desire.  When you have one you like, look at the lower
left corner of Slide 1.  You will see a small "shooting"
star.  This means that a transition has been applied to
this slide.  If you click the star, you will see the
transition you selected will Play again. (Fig 9)

10 You can repeat the above process by clicking on each
slide and selecting a different transition for each slide.
Or - Notice - on the right side of  theTransition to This
Slide Group - you can select Apply to All.  And the
transition you choose will be applied to all of your
slides.  It's up to you on how you want each slide to
transition - or not transition. (Fig 10)

11 Also notice that there is a Transition Speed selection in
this same area.  You may change your transition from
Fast to Medium or Slow.  (Fig 11)

12 You may also add a Sound to your transition.  Click the
small down arrow to the right of Transition Sound.  A
drop down list of sounds will appear.  We chose
Chime for our Slide 1 Transition.

Notice at the bottom of the "list" it indicates Other
Sound….  When we found the bat sound on Microsoft
Office Online, it placed the sound in our Clip Art
Organizer.  To use this sound we had to choose Other
Sound.  When we did, it was added to our list at the top.

As you get more comfortable with sounds, you can
find some really neat sounds all over the internet.
(Fig 12)

Fig 12

gFig 11

gFig 9

Fig 8

g 3Fig 10
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Construction	       Exercise 1.6.38
Interior Design & Decoration - Basic of Auto CAD software and Preliminary 
Auto CAD Software 	       

Installation of 2D (AutoCAD) software
Objective : At the end of this exercise you shall be able to
• install the 2D software.

PROCEDURE 

Student’s version 2020 Download  
The AutoCAD student version is available free for up to 
3 years. For the student version, we have to sign-in and 
then select the student version option. 

Note: We cannot use the objects created in 
the student’s version for commercial use. 
If we want to use the AutoCAD software for 
commercial projects and objectives, we need 
to buy the license for the AutoCAD software.

Let’s start with the process of installation of Student’s 
version. To download the 2019, 2018! or 2017 version,all 
the steps will remain the same. We need to select the 
appropriate version. The steps to download the latest 
version, i.e., AutoCAD 2020 are listed below:

Step 1 	 : Open your favorite browser

Step 2 	 : Type the url: https://www.autodesk.com/
education/free-software/autocad

1	 The Autodesk page will be opened. as given in  
(Fig 1).

Step 3 : 	Click on the ‘CREATE  ACCOUNT’  option to  
create  your account  for  the  student version. 

Step 4 : We can also click on the option below the 
CREATE ACCOUNT button to download the 
version for a 30 days free trial. as shown in 
(Fig 2)

Not a student or educator? Get the free trial

Fig 1

Fig 2

Step 5 : When we click on the CREATE ACCOUNT 
button, the screen willlook like the given image 
(Fig 2).

Step 6 : We  need  to  enter  the  details  to  create  
an  account.  The  drop-down  list  of the 
educational role will appear as the given image 
(Fig 3) & institution type will appear as shown 
in given fig 4. 

Fig 3

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



142

Step 12 : We need to select the version, operating 
system, and the Language from the drop-
down list. After this step, the download will 
begin.

1	 The drop-down list of the Version will appear as the 
given image (Fig 8).

Fig 4

Fig 5

You can select the option according to the requirements.

Step 7 :  	After these details, click on the ‘NEXT’ button 
given at the bottom.

Step 8 : The window  with details such as name, email-
id, etc. will appear as the below image (Fig 5).

Fig 6

Fig 7

The registration process is now complete, and we can 
now sign-in with this email-id and password on the link 
mentioned in step 2.

Step 10 : After the sign-up, the Autodesk will ask for 
a 6-digit passcode verification. We need to 
download the Duo Mobile app, scan the QR 
code, and enter the passcode or we can also 
follow the same instructions as mentioned by 
Autodesk .

Step 11 : 	 The screen will now appear as the given image 
(Fig 7).

Fig 8

Step 9 :  The final step is the verification of your email-id. 
The window will now look like the given image 
(Fig 6).

2	 Here, we will select the latest version, i.e., 2020.

3	 Note: We can select the particular version from the 
drop-down list according to the requirements. The 
system requirements for that version will be displayed 
accordingly.

4	 According to the selected version, the drop-down list 
of the operating system will be listed. For the 2020 
version, only windows 64-bit is listed.

5	 You can set the Language according to the 
requirements.

6	 The drop-down list of the Language will appear as 
the below image (Fig 9).

7	 After selecting the above categories, the window will 
now look like the below image (Fig 10).
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Step 19 : The download  will  start. We need to wait for  
a while until the download  is completed.

Step 20 : After the download is completed, the window 
will appear as shown in the below image  
(Fig 16).

Fig 13

Fig 9

Fig 10
Fig 14

Fig 15

Fig 16

Fig 11

Step 13 : 	The serial  number and the product key will  
be required further during the installation of 
the AutoCAD.

Step14 :  	Click  on  the ‘INSTALL  NOW’ option  given  
at the  bottom of the  page. It will appear as 
(Fig 11).

Fig 12

Step 16 : 	Open the downloaded file.It will look like the 
below image (Fig 13).

Step 17 :  	The  AutoCAD  window  will appear.  Click  on 
the  ‘Install’  option  as  shown  in the below  
image (Fig 14).

Step 18 : 	Now, again click on Install as shown in the 
below image. (Fig 15)

Step 15 : Accept the license and click on ‘Install’ as 
shown in the below image (Fig 12).
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(Click on the ‘Launch Now’ option at the bottom right 
corner of the page.

Step 21 : The configuration will start, as shown in the 
below image (Fig 17)).

Fig 18

Fig 17

Fig 19

Step 22 :  After this step, the AutoCAD software will be 
opened. Click on the OK option as shown in 
the below image (Fig 18).

The AutoCAD software will appear.

Step 23 : Now, at  last, comes the Autodesk  license  
part. After this, you can start your drawings.

As soon the window appears, click on the ‘I Agree’ option 
for acceptance of license terms and conditions as shown 
in the below image (Fig 19).

Step 24: The AutoCAD software is now ready for use.

The screen of the AutoCAD software will look like 
the below image (Fig 20).

Fig 20
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Fig 4

Fig 2

Construction	       Exercise 1.6.39
Interior Design & Decoration - Basic of Auto CAD software and Preliminary 
Auto CAD Software	       

Elementary commands  and menus of 2D (AutoCAD) software
Objectives : At the end of this exercise you shall be able to
• 	start a new drawing
•	 open a template
•	 create a template.

Starting a new drawing
Step 1: Pulldown menu: file, new.

Step 2: When you invoke this command Autocad displays 
the select template dialogue box.(If  you selected “show 
startup  dialogue box’ from option dialogue box you cannot 
see the following dialogue box. Instead of this you can 
see the start up dialogue box itself) (Fig 1).

Opening a template
Step 1:The template that you create by using F 8.   It will 
appear as a blank screen, but there are many variables 
that have been preset. This will allow you to start drawing 
immediately).

Let’s start by opening the “1 Workbook” (Fig 2).

1	 Select file/new

2	 Select use a template box (third from the left). (Fig 3)

3	 Select 1 workbook helper. dwt from the list of 
templates. 

4	 Select the ok button.

Create a template. (Fig 4)

Now you can create a template. This will be a very 
easy task. (Fig 5)
Step 1: Start AutoCAD as follows.

Start button/programs/AutoCAD.

The 3 letter extension for drawing file is 
drawing If a dialog box appears select the 
“Cancel” Button.

Step 2: Select file/open.
Step 3:	Select the directory in which the files located.
(click on the) (Fig 6).

Fig 1

Fig 3

PROCEDURE
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Step 4:	Select the file “Workbook  and then “Open” 
button.

Step 5:	Select “File / save as” (Fig 7)
Step 8: Type a description and select the “OK” button.

This template can be used at the beginning of each of 
the exercises. (Fig 10)

(Using  a template as a master setup drawing is good 
CAD management).

Creating a new drawing
Step 1: New command
Create a new drawing file.

1	 Choose	 File, 	 new. or

2	 Press	 Ctrl + N  or

3	 Click		 The new icon or

4	 Type		 New at the comand prompt.

			   Command: new

5	 Choose	 One of the options for creating a 	
		  new drawing.

Step 2
1	 Click		 The ok button.

Fig 5

Fig 6

Fig 7

Step 6:	Select the “File of type” down arrow to display 
different saving formats. Select “ Autocad drawing 
template (*.dwt)”. (Fig  8)

The 3 letter extension for template is “dwt”.

	 A list of all the AutoCAD templates will appear. (Your 
list may be different)

Step 7:	Type the new name “1 Workbook” in the file 
name”.  box and then select the save button. (Fig 9)

The “1” before the name will place the file at the top of 
the list.

AutoCAD displays numerical first and then 
alphabetical.

Fig 8

Fig 9

Fig 10
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Step 3: Save the drawing as another name.

Note: New drawings can also be created from 
template files. (Fig 11)

Open existing drawings (Fig 12)
Step 1	

1	 Choose	 File, 	 open. or

2	 Press	 Ctrl + O

3	 Click		 The open icon. or

4	 Type		 Open at the command 			 
		  prompt.command: open

5	 Press 	 Enter

6	 Double click	The desired directory to find the 		
		  drawing to open.

7	 Click		 the drawing name to open.

Step 1	 Click		  The ok button.

Preview shows a bitmap image of the drawing selected. 
This image is the view that was last saved in the drawing.  

Saving drawings
Saves the most recent changes to a drawing.  The first 
time an unnamed drawing is saved the “Save As” Dialog 
box appears.  AutoCAD saves its drawings as files with 
extensions ending in . DWG.

Step 2	

1	 Choose	 File, save or save as       

2	 Type		 Save or  save as at the command 	
		  prompt command: Save or Save as

3	 Press	 Enter

4	 Type		 A new drawing name or keep the 	
		  existing drawing name.

Step 2
Click		  The ok button.

Various file type can be saved as shown in fig 13

Step 3: Clicking the dropdown list for file type changes 
the format that the drawing can be saved in.

Quick save
The Qsave command is equivalent to clicking Save on 
the file menu.

If the drawing is named, AutoCAD saves the drawing 
using the file fromat specified on the open and save tab 
of the Options dialog box and does not request a file 
name.  If the drawing is unnamed, AutoCAD displays the 
save drawing. As dialog box (see save as) and saves 
the drawing with the file name and format you specify.

Step 1
1. Press	 Ctrl + S.	

		      or

2. Click		 The save icon.

		     or

3. Type		 Qsave at the command prompt, 		
	              Command: Qsave.

Hint: Drawings can be saved as different versions of 
AutoCAD (e.g. R13, R14, R2000, etc.) (Fig 14)

AutoSave settings under Tools, options...

Fig 11

Fig 12

Fig 13
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Existing AutoCAD
Step 1 		 Choose	File, exit.	

				     or

Type 		  Quit at the command prompt.
			   Command: Quit

Step 2 Press	 ENTER.

Step 3 Click	 Yes to save changes or No to 		
		  discard changes.

Drawing area control 
Objectives : At the end of this exercise you shall be able to
•	 identify method of entering commands
•	 practice drawing command set up
•	 practice drawing area set up.

TASK 1: Methods of entering commands

Fig 14

AutoCAD has 3 different methods of entering commands. 
All 3 methods will accomplish the same end result.  
AutoCAD allows you to use the method you prepare.  
The following are descriptions of all 3 methods and 
an example of how each one would be used to start 
command such as the line command.

Step 1: Pull down Menu (select draw / line).

a	 Move the cursor to the Menu Bar.

b	 Click on a Menu header such as “Draw”.

c	 Slide the cursor down the list of commands and click 
to select.

				    or
Step 2: Tool bars (select the line icon from the draw 	
tool bar).
Move the cursor to an icon on a toolbar and press the  	
left mouse button.
				    or

Step 3: Keyboard (Type L and <enter>).

Type the command on the command line.

What is a shortcut menu?

In addition to the methods listed above, AutoCAD has 
shortcut menus.  Shortcut Menus give you quick access 
to command options.  Shortcut Menus are available when 
brackets [] enclose the options, on the command line.  
(Example below) To activate a Shortcut Menu, press the 
right mouse button.

Example

Step 1: Select: draw /circle / center, radius._circle specify 
center point for circle or [3P / 2P/ Ttr (tan tan radius)]:
Step 2: Press the right mouse button now, the shortcut 
menu on the left will appear.  This allows you to select 
the options 3P, 2P, or Ttr with the mouse rather than 
typing your selection.

TASK 2: Drawing units setup (Fig 1)

Every object we construct in a CAD system is measured 
in Units.  We should determine the system of units within 
the CAD system before creating the first geometric 
entities.

Step 1: In the menu bar select:

(Format) (Units)
The AutoCAD menu bar contains multiple pull down 
menus, where all of the  AutoCAD commands can be 
accessed.  Note that many of the menu items listed in 

the pull-down menus can also be accessed through the 
Quick Access toolbar and / or Ribbon panels.

Step 2: Click on the length type option to display the 
different types of length units available. Confirm the 
length type is set to decimal. (Fig 2 & 3)

Step 3:	On your own, examine the other settings that are 
available.

Step 4:	In the drawing Units dialog box, set the length 
type  to decimal.  This will set the measurement to the 
default english units, inches.
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Fig 1

Fig 2

Fig 3

Step 5:	Set the precision to two digits after the decimal 
point as shown in the above Figure. (Fig 4)

Fig 4

Fig 1

Step 6:	Pick ok to exit the drawing units dialog box.

TASK 3: Drawing area setup

Next, we will set up the drawing limits by entering a 
command in the command prompt area. Setting the 
Drawing Limits controls the extents of the display of the 
grid.  It also serves as a visual reference that marks the 
working area.  It can also be used to prevent construction 
outside the grid limits and as a plot option that defines an 
area to be plotted / printed. Note that this setting does 
not limit the region for geometry construction.

Step 1: In the menu bar select:

[Format] [Drawing Limits] (Fig 1)
Step 2: In the command prompt area, the message 
“Reset model space limits: Specify lower left corner or 
[on/off] <0.00,0.00>.” is displayed.  Press the ENTER 
key once to accept the default coordinates <0.00,0.00>. 
(Fig 2)

Step 3: In the command prompt area, the messsage 
“specify upper right corner <12.00,9.00>” is displayed.  
Press the ENTER key again to accept the default 
coordinates <12.00,9.00>. (Fig 3)
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Fig 3

In Paper Space - you can insert one of several predefined 
title blocks into the  drawing and create a set of layout 
viewports  within the title blocks. You can specify a global 
scale as the ratio between the scale of the title block in 
the layout and the  drawing on the Model tab. The model 
tab is most useful for plotting multiple views  of a drawing  
within a single border.

MVSETUP commands

No  (to not create a new layout tab - we will do this in 
another lesson)

A 	 (Metric units)

48	(Scale factor - common arch, scale factor is 1:1)

24	Width- see table  below for paper size.

	 (example 210 x 297) Since we are printing in “land	
	 scape “ mode, we enter  the bigger  number of the 	
	 paper size first.

18	Length - Smaller number from the list below.

Once MVSETUP is finished, it will show a rectangle. This 
is the area where your grid wil show up if you have the 
grid on. This box is pretty much useless so just erase it. 
You will not need it.

From here, set up dimensions styles, text styles. layer.

If these settings will used in other drawings here are two 
suggestions, the first of which  is recommended because 
it is less error prone.

1  	After creating the desired settings, do a save-as and 
save t as a . dwt. All of the settings  that you created 
will be saved.

2  	After using this drawing, open it and erase all objects. 
The settings will remain  but  you will have to hunt 
down the objects that need to be erased in layouts. 

2	 Setting units of a drawing
UNITS Command is used to set the units of measure, 
angle measurement, direction and precision.Pull down 
Menu: Format, UNITS

Command: UNITS

If you enter-units at the command prompt, UNITS 
displays prompts on the command line.There are five 
fundamental types of units i.e. Decimal, architectural, 
engineering, fractional & scientific.

The text window displays the following prompt.

There are five fundamental types of units i.e. Decimal, 
architectural, engineering, fractional & scientific.

There are five fundamental types of units i.e. 
Decimal, Architectural, Engineering, Fractional & 
Scientific.

Fig 2

Step 4: Move the graphic cursor near the upper right 
corner inside the drawing area and note that the 
drawing area is unchanged. (The drawing limits 
command is used to set the drawing area, but the 
display will not be adjusted until a display command 
is used.)

1	 Setting limits of a drawing
In AutoCAD The drawing must be drawn in full scale.  So 
limits are needed to size up a drawing area.  The limits 
are determined by the following factor.

i	 Size of drawing.

ii	 Space needed for dimensions, notes and other details.

iii	 Space between different views.

iv	 Space for the border and a title block etc.

Limits
Step 1: Pull down: Format, drawing limits.

Step 2:Command: Limits.

The command LIMITS allows you to change the upper 
and lower limits of the drawing.  

Example: Set the drawing screen to A4 size (210 x 297)

Command: LIMIT.

Step 3:Specify lower left corner or (ON/OFF) 
<0.000,0.000>:

Step 4: Specify upper right corner <12.000,9.000>: 
210,297

Step 5: Give ZOOM command with ALL option to view 
all the drawing

area (A4 size)

Step 6: MVSETUP = Multiview Setup

MVSETUP offers two different setup options depending 
on whether you are in Model Space or in a Layout (Paper 
Space).

In model space- you set the units type, drawing scale 
factor, and paper size at the command prompt using 
MVSETUP. Using the settings you provide, a rectangular  
border is drawn at the grid limits.
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Report formats: (Examples)
1	 Scientific (1.55E + 01)
2	 Decimal (915.50)
3	 Engineering 1’-3.50”
4	 Architectural 1’-3 1/2”
5	 Fractional 15 1/2
Enter choice, 1 to 5 <Current >: Enter a value (1-5) or press ENTER

The following prompt for decimal precision is displayed if you 
specify the scientific, decimal, or engineering format. Enter number 
of digits to right of decimal point (0 to 8 ) <Current >: Enter a value 
(0-8) or press ENTER.
The following prompt for the denominator of the smallest fraction 
is displayed if you specify the architectural or fraction format.
Enter denominator of smallest fraction to display.
(1,2,4,8,16,32,64,128,or 256) <current>: Enter a value 
(1,2,4,8,16,32,64,128,or 256) or press ENTER
Inserting scale
Controls the units of measurement for blocks and   drawings that 
are inserted into the current drawing. A  block or a drawing that is 
created with units that are different from the units specified with this 
option is scaled when inserted. The insertion scale is the ratio of  
the units used in the source block or drawing and the units used 
in the target drawing and the units used in the target drawing. 
Select Unitless to insert the block without scaling it to match the 
specified units.

	 Icon/Button	 Description

The next prompts is for angle formats and precision.
	System of angle measure: (Example)
1	 Decimal degree 45.000
2	 Degree/minutes/seconds 45d0’0.
3	 Grads 50.000g.
4	 Radians 0.78454r.
5	 Surveyor’s units N 45d0’0”E.
Enter choice ,1 to 5< Current>:Enter a value (1-5) or press ENTER.
Enter number of fractional places for display of angles (0-8) <Current>:Enter a 
value (0-8) or press ENTER.

The next prompt is for the direction for angle 0.
Direction for angle 0:
East 3 o’clock = 0.
North 12 o’clock = 90.
West 9 o’ clock = 180.
South 6 o’ clock = 270.
Enter direction for angle 0<current>: Enter a value or press ENTER.
The default direction for 0 degrees is to the east quadrant, or 3 o’ clock. The 
default direction for positive angular measurement is counterclockwise.
Measure angles clockwise? [Yes/No]
<current>: Enter y or n or press ENTER.
Select the unit you want from the dialogue box. This unit is used for dimensioning 
of the drawing. Input from the user accepted in this unit only.
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Drafting setting a display commands
Objectives : At the end of this exercise you shall be able to
•  practice the drafting setting
•  identify the visual reference
•  identify esc, undo, redo
•  practice display commands.

Drafting Settings (Fig 1)

Fig 1

Fig 2

Fig 3

Fig 4

Drafting settings includes the commands for initial setting 
of a drawing.  Some of the drafting settings are snap, 
grid, polar tracking, osnap. 
Step 1: Switches the grid on/off 

Step 2: Set the size of the grid in the current drawing units 

Step 3: Snap: Snap is used to move the cursor at a 
defined value. This will set a position on the drawing 
quickly and accurately. The snap mode can be switched 
ON / OFF by pressing function key F9.

Grid: Grid command is used to display dots, which is 
easy for us to fix the points.  But these dots were not

printed. Grid points have default spacing of one unit.  We 
can change the spacing too. This mode can be ON / OFF 
by using the function key F7. 

Object snap settings (Fig 2)

Object snap settings are used to pick a geometric point 
on an object. Object snap mode can be ON / OFF by 
using the function key F3 or by clicking O snap button on 

the status bar. There are various options for object snap 
settings such as end point, mid point, centre, quadrent 
etc.
Ortho: Ortho command forces lines to be drawn exactly 
perpendicular directions. While using this  command we 
have to turn ortho ON/OFF (otherwise press F8 according 
to our need
The grid and snap mode option can be turned ON or OFF 
through the status bar. The status bar area is located at 
the bottom left of the AutoCAD drawing screen, next to 
the cursor coordinates.
The second button in the status bar is the snap mode 
option and the third button is the grid display option.  
(Fig 3) Note that the buttons in the status bar area serve 
two functions: (1) the status of the specific option, and (2) 
as toggle switches that can be used to turn these special 
options  on and off. When the corresponding button is 
highlighted, the specific option is turned on. Using the 
buttons is quick and easy way to make changes to these 
drawing aid options. Another aspect of the buttons in the 
Status Bar is these options can be switched on and off 
in the middle of another command.

Grid on
1	 Left-click the grid button in the status bar to turn on the 

grid display option. (Notice in the command prompt 
area, on the massage “<Grid on>” is also displayed.) 
(Fig 4)

2	 Move the cursor inside the graphics window, and 
estimate the distance in between the grid lines by 
watching the coordinates display at the bottom of the 
screen. (Fig 5)

The grid option creates a pattern of lines that extends 
over an area on the screen. Using the grid is similar 
to placing a sheet of grid paper under a drawing. The 
grid helps you align objects and visualize the distance 
between them. The grid is not displayed in the plotten 
drawing. The default grid spacing. Which means the 
distance in between two lines in the screen, is 0.5 inches. 
We can see that the sketched horizontal line in the sketch 
is about 4.5 inches long.
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Fig 5

Snap mode on (Fig 6)

Fig 6

Step 1:	Left- click the snap mode button in the status bar 
to turn on the snap option.

Step 2:	Move the cursor inside the graphics window, 
and move the cursor diagonally on the screen. Observe 
the movement of the cursor and watch the coordinates 
display at the bottom of the screen. 

SNAP mode is on, the screen cursor and all input 
coordinates are snapped to the nearest point on the 
grid. (Fig 7)

The default snap interval is 0.5 inches, and aligned to 
the grid points on the screen. (Fig 8)

In case of any mistake
Pressing the ESC key
The Esc key at the top of the key board will get you out of 
most problems you encounter using AutoCAD. Here are 
some examples of the times you would press Esc key.

•	 If a command is not responding the way you expect.

Fig 7

•	 If you want to cancel a command you started.

•	 If you clicked a point on the screen unintentionally.

•	 If a dialogue box appears  on the screen accidently.

In all these cases above, pressing Esc once will free the 
command line.

Example
Issue the line command, click a point on the screen and 
then press the esc key to cancel the command.

Using undo
Undo the last command by typing U at the command line 
and pressing the enter key, or by clicking on the Undo 
icon on the tool bar.

Using redo 
The Redo command will reinstate the last command you 
applied undo to.  You may undo as may commands as 
like you, but you may only redo once.

  Display commands
Zoom
Zoom command enlarges or reduces the view of the 
drawing. When we are working on a drawing it is always 
required to bring the area of our interest to focus on to 
the screen. The zoom tool bar may be accessed from 
the standard tool bar at the top of the screen or from 
the dropdown menu > view >Tool bars....> Zoom. The 
icons are

Fig 8
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Pan: Pull down menu: view, pan.

The cursor changes to a hand cursor. (Fig 9)

Icon		  Function

 	 This allow you to select a window or box around the area you want to magnify.

	 This is both zoom and pan.  When the command is issued a view box will be 		
	 displayed with the drawing inside. The view box can be resized (Zoom) and moved 	
	 around pan.

	 The drawing is at a scale of 1.A zoom scale of 2 doubles the magnification of the 	
	 drawing, while 0.5 halves it.

	 Allows you to pick a point which will be the center of the zoom area.

	 Just click on it zoom in on the drawing. You may preset the amount it zooms in a the 	
	 command line.

	 Just click on it zoom out from the drawing. You may preset the amount it zooms out 	
	 at the command line.

	 This zooms to show the complete electronic page you set up. It zooms out to the 	
	 electronic sheet limits.

	 This will zoom to fit the complete drawing on the screen.

	 This displays the last view created by zoom, pan or view command.

By holding down the pick button on the pointing device, 
you lock the cursor to its current location relative to the 
view port coordinate system. Graphics within  the window 
are moved in the same direction as the cursor.

when you reach a logical extent (edge of the drawing 
space), bar is displayed on the hand cursor on the side 
where the extend has been reached.  Also a message 
is displayed in the status bar as “already bottom most 
extent”.  Depending upon whether the logical extent is at 
the top, bottom, or side of the drawing, the bar is either 
horizontal (top or bottom) or vertical (left or right side).

When you release the pick button, panning stops. You 
can release the pick button move the cursor to another 
location in the drawing, and the press the pick button 
again to pan the display from that location.

On your own, move the graphic cursor near the upper-
right comer inside the drawing area and note that 
the drawing area is unchanged.  (The Drawing Limits 
command is used to set the drawing area, but the display 
will not be adjusted until a display command is used.)

Inside the Menu Bar area 

Select:  [View] [Zoom] [All]
Zoom All command will adjust the display so that all 
objects in the drawing are displayed to be as large as 

possible.  If no objects are constructed, the Drawing 
Limits are used to adjust the current viewport.

Move the graphic cursor near the upper - right comer 
inside the drawing area and note that the display area 
is updated.

In the menu bar area select: [View] [pan] [Realtime]  
(Fig 10)

Fig 9

Fig 10

The available pan commands enable us tomove the view 
to a different position. The pan - realtime function acts 
as if you are using a video camera.
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Commands & co-ordinate system
Objectives : At the end of this exercise you shall be able to
•  use draw command line
•  practice co-ordinate system
•  use modify command erase.

Draw commands Line  
From tool bar: Line

Draw menu: Line

Command : Line, L

Example: 

Command: L - Line
Step 1: Specify first point: Select one point on the screen

Step 2: Specify next point or [Undo]: Select second point 
on the screen

Step 3: Specify next point or [Undo]:

Continue
Continue a line from the end point of the most recently 
drawn line

If the most recently drawn line is an arc, its end point 
defines the starting point of the line, and the line is drawn 
tangent to the arc.

Close
Ends the last line segment at the beginning of the first 
line segment, which forms a closed loop of line segments.
You can close after you have drawn a serious of two or 
more segments.

Undo
Erase the most recent segment of a line sequence.  
Entering “U” more than once back tracks through line 
segments in the order you created them.

Co-ordinate system in autocad
All drawings are superimposed on an invisible grid, or  
co-ordinate system, with a horizontal X-axis and a 
verticasl Y-axis.

 You can establish grid and snap setting that match 
the units of the co-ordinate system or some multiple or 
fraction of it.

1	 Absolute co-ordinate system  (X, Y): To enter an 
absolute coordinate, specify a point by entering its X 
and Y values in the format X,Y. (Fig 1)

Use absolute  coordinate when you know the precise X 
and Y values in the point from the origin. The following 
sequence of coordinates draw a triangle, as shown below.

Step 1: Command _ Line specify first point: 2,2

Specify next point or [undo]: 8,2

Specify next point or  [undo]: 8,6

Specify next point or  [undo]: 5,6

Specify next point or  [undo]: 5,4

Specify next point or  [undo]: 2,4

Relative rectangular co-ordinate system @ X 
distance, Y distance (Fig 2)
Use relataive coordinates when you know the position 
of a point with respect to the previous point, the relative 
rectangular coordinate is represented in the following 
format.

Move the cursor, which appears as a hand inside the 
graphics window, near the center of the drawing window, 
then push down the left - mouse - button and drag the 

display toward the right and top side until we can see the 
sketched line.  (Notice the scroll bars can also be used 
to adjust viewing of the display.)
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The relative polar coordiante is representing in the 
following format. (Fig 4)

@Distance<angle
Command: _ line specify first point:2,3.

Specify next point or [undo]: @ 4<0.

Specify next point or [undo]: @ 4<90.

Specify next point or [close / undo]: @ 4<180.

Specify next point or [close / undo]:c.

Drawing lines with the line command
Step 1:	Move the graphics cursor to the first icon in the 
draw 	 panel. This icon is the line icon. Note that a brief 
description of the line command appears next to the 
cursor.

Fig 4

Fig 5

Fig 6

Fig 7

We will create a freehand sketch of a five - point star 
using the Line command. Do not be overly concerned with 
the actual size or the accuracy of your freehand sketch. 

Step 4:	We will start at a location about one - third from 
the bottom of the graphics window.  Left - click once to 
position the starting point of our first line.  This will be 
point 1 of our sketch.  Next move the cursor upward and 
toward the right side of point 1 (Fig 6). Notice the rubber 
band line that follows the graphics cursor in the graphics 
window.  Left - click again (point 2) and we have created 
the first line of our sketch. (Fig 7)

Step 2: X displacement, Y-displacement
Command:_ line specify first point:2,2

Specify next point or [undo]: @ 4,0

Specify next point or [undo]: @ 0,4

Specify next point or [Close/ undo]: @ 0,-2

Specify next point or [Close/ undo]: @ -2,0

Specify next point or [Close/ undo]: @ c

Relative polar co-ordinate system @ distance angle 
(Fig 3)
Polar co-ordinate system uses a distance and an angle 
with reference to the previous point to locate a point.  
Angle is measured in anti-clock direction, taking 0° 
towards right.

Step 2:	Select the icon by clicking once with the Left - 
mouse- button, which will activate the line command. 
(Fig 4)

Step 3:	In the command prompt area, near the bottom 
of the AutoCAD drawing screen, the message “ - line 
specify point:” is  displayed. (Fig 5) AutoCAD expects us 
to identify the starting location of a straight line.  Move the 
graphics cursor inside the graphics window and watch 
the display of the coordinates of the graphics cursor at 
the bottom of the AutoCAD drawing screen.  The three 
numbers represent the location of the cursor in the X,Y, 
and Z directions.  We can treat the graphics window as 
if it was a piece of paper and we are using the graphics 
cursor as if it were a pencil with which to draw.
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Fig 8

Fig 9

Step 5:	Move the cursor to the left of point 2 and create 
a horizontal line about the same length as the first line 
on the screen.

Step 6:	Repeat the above steps and complete the 
freehand sketch by adding three more lines (from point 
3 to point 4, point 4 to point 5, and then connect to point 
5 back to point 1).

Step 7:	Notice that the Line command remains activated 
even after we connected the last segment of the line to 
the starting point (point 1) of our sketch. (Fig 8) Inside 
the graphics window, Click once with the right - mouse-
button and a popup menu appears on the screen.

Step 9:	Move the cursor near point 2 and point 3, and 
estimate the length of the horizontal line by watching the 
displayed coordinates for each point.

ERASE
There are 3 methods to erase (delete) objects from the 
drawing.  You decide which one you preper to use. They 
all work equally well.
METHOD 1
Select  the Erase command first and then select the 
objects
Step 1:	Start the Erase command by using one of the 
following.
TYPING = E <enter>.

Step 8:	Select enter with the left - mouse - button to 
end the line command.  (This is equivalent to hitting the 
[ENTER] key on the keyboard.) (Fig 9) 

PULLDOWN = MODIFY / ERASE
TOOLBAR = MODIFY
Step 2:	Select objects: Pick one or more objects
Select objects: Press <enter> and the objects will 
disappear.
METHOD 2
Select the objects first and then the Erase command 
from the shortcut menu
Step 1:	Select the object (s) to be erased.

Step 2:	Press the right mouse button.

Step 3:	Select “Erase” from the short - cut mentu.

METHOD 3
Select the objects first and then the delete key
Step 1:	Select the object (s) to be erased.

Step 2:	Press the delete key.

Very important :  If you want the erased objects 
to return, press U <enter> or Ctrl + Z or the Undo 
arrow icon. This will “Undo” the effects of the last 
command.
Using the ERASE command
One of the advantages of using a CAD system is the 
ability to remove entities without leaving any marks.  We 
will erase two of the lines usisnsg the Erase command.

Step 1:	Pick Erase in the modify toolbar. (Fig 10) (The 
icon is a picture of an eraser at the end of a pencil.) The 
message “Select objects” is displayed in the command 
prompt arrea and AutoCAD awaits us to select the objects 
to erase.

Fig 10

Step 2:	Left - cllick the SNAP MODE button on the status 
bar to turn OFF the SNAP MODE option so that we can 
more easily move the cursor on top of objects.  We can 
toggle the Status Bar options ON or OFF in the middle 
of another command. (Fig 11)

Fig 11
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Step 3:	Select any two lines on the screen; the selected 
lines are displayed as dashed lines as shown in the figure 
below.
To deselect an object from the selection set, hold down 
the [SHIFT] keyand select the object again.
Step 4:	Right - mouse - click once to accept the 
selections.  The selected two lines are erased.
The last command
Step 1:	Inside the graphics window, click once with the 
right- mouse-button to bring up the popup option menu.
Step 2:	Click repeat erase, with the left - mouse - button, 
in the popup menu to repeat the last command.  Notice 
the other options available in the popup menu. (Fig 12)

Fig 12

Fig 13

Fig 14

Fig 15

Step 3:	Move the cursor to a location that is above and 
toward the left side of the entities on the screen.  Left - 
mouse - click once to start a corner of a rubber - band 
window.
Move the cursor toward the right and below the entities, 
and then left-mouse-click to enclose all the entities inside 
the selection window. Notice all entities that are inside 
the window are selected. 

Inside the graphics window, right-mouse-click once to 
proceed with erasing the selected entities. (Fig 13 & 14)

When your own create a free hand sketch of your choice 
using the line comman. Experiment with using the 
different commands we have discussed so far, Reset 
the satus button so that only the GRID DISPLAY option 
is turned ON as shown. (Fig 15)

Practice - I
Instructions
Step 1:	Start a New file
Step 2:	Draw the objects below using

LINE  command.

Ortho (f8) ON for Horizontal and Vertical lines.

Ortho (f8) OFF for lines drawn on an  Angle.
Increment Snap (f9) ON 	 Osnap (f3) OFF.
Step 3: Save this drawing using:

Practice - II (Fig 16)
Instructions
Step 1:	Using drawing DRG NO ERASE the missing 
lines.

Step 2:	Save this drawing using:

File / Save as / DRG NO.

Practice - III (Fig 17)	

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.6.39

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



159

Basic commands - I
Objectives : At the end of this exercise you shall be able to
•	 create circle
•	 create arcs
•	 creat polygon.

Fig 1

Creating circles
The menus and toolbars is AutoCAD 2013 are designed 
to allow the CAD operators to quickly activate the desired 
commands (Fig 1).

•	 Center, diameter: Draws a circle based on a center 
point and a diameter.

•	 2 points: Draws a circle based on two. 

•	 3 Points: Draws a circle based on three points on the 
circumference.

•	 TTR - Tangent, Tangent, Radius: Draws a circle with 
a specified radius tangent to two objects.

•	 TTT - Tangent, Tangent, Tangent: Draws a circle 
tangent to three objects.

Circle
AutoCAD provides the following ways of drawing circles.
(Fig 2).

Step 1:	In the Draw toolbar, click on the little triangle 
below the circle icon.  Note that the little triangle indicates 
additional options are available.

Step 2:	A circle based on two endpoints of the diameter.

Notice the different options available under the circle 
submenu.

•	 Center, radius: Draws a circle based on a center 
point and a radius.

Step 3:	Save this drawing using.

File / Save as DRG NO.

Practice - IV (Fig 19)	
Instructions
Step 1:	Start a New file. 

Step 2:	Draw the objects below using

	 Draw / Line.

	 Osnap (f3) OFF.
Step 3:	Save this drawing using.

	 File  / Save as (give file name).

Fig 2

Instructions
Step 1:	Start a New file. (Fig 18)
Step 2:	Draw the objects below using.

Draw / Line.

Ortho (f8) ON for Horizontal and Vetical Lines.

Ortho (f8) OFF for lines drawn on an Angle.

Increment Snap (f9) ON
Osnap (f3) OFF
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Step 1:	Centre and radius (Fig 3) 

This is the classical method. The first point define the 
circle‘s  center,

The second one radius

Example

Command.			   : Circle or C.

3P / 2P / TTR /<Center point>.	 : 200,200.

Diameter / <Radius>. 		  : 150.

Step 2:	Centre and diameter (Fig 4)
After the circle’s center has been defined the diameter 
can be given 

Example

Command			   : Circle or C

3P/2P/TTR/<Center Point>	 : 200, 200

Diameter/<Radius>		  : D 

Diameter			   : 300

5	 Tangent, tangent and radius (Fig 7)
This option allows the user to define two tangential points 
and then the circle’s radius.  In order to invoke this option 
it  should have two entities draw.  The circle can be drawn 
between Tangentially to two lines, two circles, or two Arc’s 
or combination of any two.

Example

Command			   : Circle or C

3P/2P/TTR/<Center point>	 : TTR.

Enter Tangent Space		  : Pick by using 		
			                  mouse on the 		
				      entity drawn already.

Radius				    : 100

AutoCAD procides 11 different ways of drawing Arcs.
Step 3:	Points (Fig 5)
With this option, the user can specify two points 
constituting the end points of the circles diameter.

First point on Diameter		  : 200,200

Second point on Diameter	 : 400,400

Step 4:	3 Points (Fig 6)
With this option the user can specify two points 
constituting the end points of the circles diameter.

Example

Command			   : Circle or C

3P/2P/TTR/<Center point>	 : 3P

First point on Diameter		  : 200,200

Second point on Diameter	 : 400,400

Third point on Diameter		 : 300,350

Example

Command 			   : Circle or C

3P/2P/TTT/<Center point>	 : 2P

1	 3 Points (Fig 8)
In this method three points define the Arc’s Start point, 
Second point that the Arc passes through, and the arc’s 
end point. (Fig 9)
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Fig 8

3	 Start point, centre, included angle (S,C,A) (Fig 11)
In this method first specify the start point of the arc, then 
the center point or the arc, and then the include angle 
between the start point and the end point of the arc.

Example

Command			   : Arc or A

Center/<Start point>		  : 400,400.

Center/End<Second point>	 : C.

Center point			   : 350,400.

Angle/Length of Chord/
<End point>			   : A.

Included Angle			   : 90.

2	 Start point, centre, end point  (S,C,E) (Fig 10)
Center refers to the center point of the circle of while the 
arc is a part.

Example	

Command			   : Arc or A

Center/<Start point>		  : 400,400.

Center/End<Second point>       	 : C.

Center point			   : 350,400.

Angle/Length of chord/
<End point>			   : 50,450. 

4	 Start point centre, length of chord (S,C,L) (Fig 12)
In this method first specify the start point of the arc, then 
the center point of the arc and then the chord length.

Example 
Command			   : Arc or A.

Center/<Start point>		  : 400,400.

Center/End<Second point>	 : C.

Center Point			   : 350,400.

Angle/Length of Chord/
<End point>			   : L.

Length of Chord			  : 80.

5	 Start point, end point, radius (S,E,R) (Fig 13)
In this method first specify the start point of the arc, then 
the end point and finally the radius of the arc.
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Example

Command			   : Arc or A.

Center/<Start point>		  : 400,400.

Center/End<Second point>	 : E.

End point			   : 350,450.

Angle/Direction/Radius/
<Center point>			   : R.

Radius				    : 75.

6	 Start point, end point, included angle (S,E,A)       
(Fig 14) 

In this method first specify the start point of the arc, then 
the end point and finally the included angle of the arc.

Example

Command			   : Arc or A.

Cener/<Start Point>		  : 400,400.

Center/End<Second point>	 : E. 

End point			   : 350,450.

Angle/Direction/Radius/
<Center poinmt>		  : A.

Included angle			   : 90.	

7	 Start point, end point, starting direction (S,E,D) 
(Fig 15)

In this method first specify the start point of the arc, then 
the end point and finally the starting direction of the arc 
from the start point.

Example

Command			   : Arc or A.
Center/<Start point>		  : 400,400.
Center/End<Second point>	 : E.
End point			   : 350,450.
Angle/Direction/Radius/
<Center point>    		  : D.
Direction from start point	 : 90.

8	 Start point, end point, centre point  (S,E,C) Fig 16
In this method first specify the start point of the arc, then 
the end point and finally the center point of the arc.

Example

Command			   : Arc or A.

Center/<Start Point>		  :400,400.

Cener/End<Second point> 	 : E.

End point			   : 250,450.

Angle/Direction/Radius/
<Center point>			   : 350,400.

9	 Centre point, start point, end point (C,S,E)  
(Fig 17)

In this method first specify the center point of the arc, 
then the start point and finally the end point of the arc.

Example

Command			   :  Arc or A.

Center/<Start point>		  : C.

Center point			   : 350,400.

Stat point			   : 400,400.

Angle/Length of chord/
<End point>			   : 350,450.

10	Centre point, start point, length of the chord  
(C,S,L) (Fig 18)

In this method first specify the center point of the arc, then 
the start point and finally the length of chord.
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Example

Command				    :  Arc or A.

Center/<Start point>			   : C.

Center point				    : 350,400.

Stat point				    : 400,400.

Angle/Length of chord/<End point>	 : L.

Length of chord				   : 75. 

11	Centre point, start point, included angle (C,S,A) 
(Fig 19)

In this method first specify the center point of the arc, then 
the start point and finally the included angle.

Example

Command				    :  Arc or A.

Center/<Start point>			   : C.

Center point				    : 350,400.

Stat point				    : 400,400.

Angle/Length of chord/<End point>	 : A. 

Included angle				    : 90.

Ellipse
This command approximates an ellipse is to choose the 
default options:

1	 Ellipse by axis and eccentricity (Fig 20)
Example

Other end point of axis			   : 500,400.

Distance to other axis or [Rotation] 	 : 75.

2	 Ellipse by axis and rotation (Fig 21)
Example

Command 			                : Ellipse or EL.

Axis end point of ellipse or (Arc/center)	 : 400,400.

Other end point of axis			   : 500,400.

Distance to other axis or [Rotation]	 : R.

Rotation around major axis	  	 : 60.

4	 Ellipse by centre, one axis, and rotation (Fig 23)
Example 
Command			                : Ellipse or EL.
Axis end point of ellipse or (Arc/center)	 : C.
Center of ellipse			   : 400,400.
Axis end point				    : 500,400.
Distance to other axis or [Rotation]	 : R.
Rotation around major axis		  : 60.

Command 				    : Ellipse or EL.

Axis end point of ellipse or (Arc/Center) 	: 400,400.

3	 Ellipse by centre and two axes (Fig 22)
Example 

Command			               : Ellipse or EL.

Axis end point of ellipse or (Arc/center)	 :400,400.

Center of ellipse				    : 
400,400.

Axis end point				    : 500,400.

Distance to other axis or [Rotation]	 : 75.
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2	 Centre of polygon, circumscribed about circle 
radius of circle (Fig 25)

Example 

Command			   : Polygon/POL.

POLYGON Enter number of  
sides<default>			   : 6.

Center of polygon or [Edge] 	 : 400,400.

[Inscribed in circle/
Circumscribed about circle]<I>	 : C.

Radius of circle			  : 50.

Basic commands - II	  
Objectives : At the end of this exercise you shall be able to
•	 erase oops move copy offset rotate
•	 scale fillet trim champer extend break
•	 join mirror array strech lengthen explode.

Polygon
This command allows the user to draw regular 2D 
polygons.
1	 Centre of polygon, inscribed circel, radius  

(Fig 24)
Example 
Command				    : POL.
POLYGON Enter number of sides 	 : 6.
<default>
Center of polygon or [Edge] 		  : 400,400.

[Inscribed in circle/
Circumscribed about circle]<I>		  : I.

Specify radius of circle			   : 50.

3	 Edge option (Fig 26)
Example 
Command			   : Polygon/POL
POLYGON Enter number of 	 : 6.
sides <default>
Center of polygon or [Edge] 	 : E.
First end point of edge		  : 400,400.
Second end point of edge	 : 400,500.

Doughnut (Donut) (Fig 27)
This command allows the user to draw filled circles and 
rings
Example of filled circle option
Command			   : Donut.
Inside diameter <default>	 : 0.
Out side diameter <default>	 : 50.
Center of doughnut		  : 100,100.

Example for rings (Fig 28)
Command			   : Donut.
Inside diameter <default>	 : 30.
Out side diameter <default>	 : 50.
Center of doughnut		  : 100,100.

Modifying commands
Modifying commands are used for modifying the existing 
drawings.  Thus it helps to prepare  a final drawing 

incorporating the necessary changes and a lot of time 
is saved.  Modifying commands are properties, erase, 
copy, mirror, offset, array,move,rotate, scale, trim, extend, 
explode etc.
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4	 Copy (Fig 4)
Tool bar		 : Modify, Copy.

Pull down	 : Modify, Copy.

Command	 : Copy.

This command is used to copy the existing drawing to 
another place.

Example

Command 	 : Copy or Co or CP

Select objects	 : Select object to Copy

Select objects	 : One found

Base point or 
displacement 	 : Select a base point.

Second point of 
displacement	 : Drag cursor at desired place and 
click 			     mouse.

1	 Erase (Fig 1)
This command allows the user to specify entities 
permanently removed from the drawing.  The selection 
can be made with any of the standard SELECT OBJECT 
method. 

Tool bar		 : Modify, Erase.

Pull down	 : Modify, Erase.

Command	 : Erase./ E.

Example

Command	 : Erase or E.	
Select objects	 : Select the objects using mouse.

Select objects	 : 

2	 Oops (Fig 2)
This command restore objects that have been 
unexpectedly erased by the previous ERASE command

Example

Command	 : Erase or E

Select objects	 : Select the objects using mouse

Command	 : Oops

3	 Move (Fig 3)
This command is used to move a single or a set of objects 
to a new location on a drawing.

Tool bar				   : Modify, Move.

Pull down			   : Modify, Move.

Command			   : Move / M.

Example

Command			   : Move or M.

Select objects			   : Select circle.

Select objects			   : One found.

Select objects			   : 

Base point or displacement 	 : Click A as basepoint.

Second point of displacement	 : Select B.

5	 Offset (Fig 5)

Tool bar 		  : Modify, Offset.

Pull down		  : Modify, Offset.

Command		  : Offset / O.

This command is used to draw parallel lines, concentric 
circle, arcs etc.  When offset is used, it is necessary to 
specify the offset distance and side of offset.

Command 		  : Offset or O.

Offset distance or 
through <current> 	 : 10.
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7	 Scale (Fig 7)
This command is used to change the size of an object

Tool bar			  : Modify, Scale

Pull down		  : Modify, Scale

Command		  : Scale / SC

Example

Command		  : Scale / SC

Select objects		  : Select the object by window.

Select objects		  : Three found.

Select objects		  : 

Specify scale factor or	 : 2. 

[Copy/Reference]<Default>

9	 Trim (Fig 9) 
This command is used to removed a part of a line, circle 
or arc based on a cutting edge.

Tool bar.		  : Modify, Trim.

Pull Down.		  : Modify, Trim.

Command		  : Trim or TR

Example

Command		  : TR TRIM.

Select objects or <Select all>: Select cutting edge, 1 
found

Select objects:

Select object to trim of shift - select to extend or

[Fence / Crossing / Project / Edge / eRase / Undo]: Select 
object to trim.

Select the object 	 : Select the circle.

Side to offset		  : Specify the side for offsetting.

6	 Rotate (Fig 6)
This command is used to rotate an object or set of objects 
to a specified angle.

Tool bar 			   : Modify, Rotate.

Pull Down		  : Modify, Rotate.

Command		  : Rotate / Ro.

Example

Command		  : Rotate / Ro.

Select objects		  : Select the object by window.

Select objects		  : Three found.

Select objects		  : 

Specify base point or displacement: Click A as basepoint.

Specify rotation angle or [Copy / Reference] < default>: 

Specify rotation angle or [Copy / Reference] < default>: 
20.

8  Fillet (Fig 8)
This command is used to connect two parallel lines, arcs 
etc., smoothly by a curve of specified radius.

Tool bar			  : Modify, Fillet.

Pull down		  : Modify, Fillet.

Command		  : Fillet or F.

Example

Command		  : Fillet or F

Current settings 		  : TRIM, Radius = 0,0000

Select first object or [Undo/Polyline/Radius/Trim/
Multiple]: R

Specify fillet radius<0.0000>

Select first object or [Undo/Polyline/Radius/Trim/
Multiple]: Select A

Select second object or shift - selected to apply corner: 
Select B
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Select object to trim or shift - select to extend or 

[Fence / Crossing / Project / Edge/ Erase/ Undo]:

10	Chamfer (Fig 10)9.9.

This command is used to join two non parallel lines with 
an intermediate line.  It produces an inclined surface at 
the edge of two intersetting lines.

Tool bar		 : Modify, Chamfer.

Pull down	 : Modify, Chamfer.

Command	 : Chamfer or CHA.

Example

Command 	 : Chamfer or CHA.

(TRIM mode) Current chamfer Dist1 <Default>, Dist2 
<Default>.

Select first line or [Undo Polyline/Distance/Angle/.

Trim/mEthod/Multiple]	 : D.

Specify first chamfer distance <0.5000>.

Specify second chamfer distance <3.0000>.

Select first line:

Select second line:

11 Extend (Fig 11)
This command is used to extend the shorter lines to meet 
another object.

Tool bar		 : Modify, Extend.

Pull down	 : Modify, Extend.

Command	 : Extend or EX.

Select objects  
or <Select all>	 : Select A, 1 found.
Select objects:
Select object to extend or shift - select to trim or [Fence/
Crossing/Project/Edge/Undo]:Select B.
Select object to extend or shift - select to trim or [Fence/
Crossing/Project/Edge/Undo]:

12  Break (Fig 12)1.11.
This command is used to erase a part of an object 
between two points.
Tool bar		 : Modify, Break.
Pull Down	 : Modify, Break.
Command	 : Break or BR.
Example1 	 : To break a line
Command 	 : Break or BR.
Select objects	 : Select A.
Specify second 
break point 	 : Select B.

13 Join (Fig 13)2.12.

This command is used to join two lines.
Tool bar		 : Modify, Join.
Pull down	 : Modify, Join.
Command	 : Join or J.
Example

Command 	 : Join or J. Select source object.

Select lines to
join to source	 : Select A and B.

14 Mirror (Fig 14)
Tool bar		 : Modify, Mirror. 
Pull down	 : Modify, Mirror. 
Command	 : Mirror or MI.
This command is used to create a miror image of the 
select objects.  After selecting the objects the beginning 
point and end point of a mirror line is entered.
Example
Command 		  : Mirror.
Select object		  : Select the object.
Select object		  : 

Example

Command	 : Extend or EX.
Select boundary 
edges.
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First point of 		  : Specify the first point.
mirror line
Second point		  : Specify the second point.
Delete old object ?	 : Enter Y for deletion, N for 
retaining <N>		     the previous object.

15  Array (Fig 15)
Tool bar		 : Modify, Array.

Pull down	 : Modify, Array.

Command	 : Array or AR.

This command is used to make multiple copies of an 
object in rectangular or polr (circulr) patterns.

Example		  : 1

Command		  : Array.

Select objects		  : Select circle of radius 5.

Rectangular or polar  	 : R.
array ( R/P)

Number or rows 		
 (----) <1> 		  : 4.

Number of columns  	
(III) <1>			  : 3.

Unit cell or distance
between Rows (----) 	 : 3. 

Distance between 	
columns (III)		  : 3.

Example		  : 2

Command		  : Array.

Select objects		  : Select circle C1.

Rectangular or 
polar Aarray ( R/P)	  : P.

Base /<Centre point 
of Array>		  : Select circle C2.

Number or Items 	 : 4.

Angle to fill <360> 	 : Press to acept 360°.

Rotate objects as they 
are copied ? <Y>	 : Enter Y or N.

16  Strech (Fig 16)
Tool bar		 : Modify, Strech.

Pull down	 : Modify, Strech.

Command	 : Strech or S.

This command is used to lenghten or shorten the line 
or objects.

Example	 : 1

Command 	 : STRETCH.

Select objects to stretch by crossing - window

Select objects	 : Select A and B by crossing - window.

Select objects	 :

Specify base point or [Displacement] <Displacement>.

Specify second point: Mouse click at C.

17  Lenthen (Fig 17)
Tool bar 		  : Modify, Lengthen. 

Pull down	 : Modify, Lengthen.

Command	 : Lengthen or LEN.

This command is used to lengthen or shorten a line.

Example 	 : 1

Command 	 : LEN or LENGTHEN.

Select an object or [DElta/Percent/Total/Dynamic]: T

(Current length: 10).

Specify total length of [Angle] <1.0000)>:15.
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Select an object to change or [Undo]: Select line AB

Select an object to change or [Undo]

18 Explode (Fig 18)
Tool bar		 : Modify, Explode.
Pull down	 : Modify, Explode.
Command	 : Explode or X.
This command will split the component objects such as 
blocks, polylines, regions etc.  If you explode a ployline 
the result will be ordinary lines or arcs.
Example   : 1
Command : EXPLODE or X.
Select an object : Select the rectangle.

Scale by specifying length
You can show AutoCAD the reference length (by pointing 
to the two endpoints of a line to be scaled), and then 
specify the new length. You can specify the new length 
by pointing, or by dragging the object.

1	 Type 		  R to define a reference length
			   Scale factor / Reference: (R)
2	 Choose	 A reference scale factor.
			   Reference length; (number or points)
3	 Choose	 A new scale factor.
			   New length: (number of points) .

19 SCALE (Fig 19)
Choose		 Modify, Scale.
Click		  the Scale icon.
Type 		  SCALE at the command prompt.
		  Command : SCALE.
		  Select objects: (Select Objects).
Pick		  A pivot point to scale about base 	
			   point : (point).
Type		  A rotation angle <Scale factor> /		
		  Reference: (number).
		  or
Pick		  A scale factor< Scale Factor>/		
		  Reference: (Point).
		  Scale factor / Reference: (points).

You can be closed to form enclosed to form enclosed 
shapes.  A closed multiline automatically joins the 
beginning and end of the shape.  When you are drawing 
a multiline shape, the command option ‘c’ closes the 
shape otherwise just press enter to finish the command.

Editing multiline (Fig 20)

Basic commands - III	
Objectives : At the end of this exercise you shall be able to
•	 point rectangle
•	 revision cloud spline multilines
•	 construction line (xline) ray hatch.

1	Point
This command is used to display a point on the screen 
(Drawing area).

Enter
Command	 : Point.
Point		  : 5,6.
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iii	 Length: This asks you to enter the length of a new 
poly 	line segment. This can be invoked by entering 
U 	 at the last prompt.

iv	 Half width: This is used to specify the starting and 
ending hald width or a poly line. This can be invoked 
by entering H at last prompt.

v	 Arc: This is used to draw poly arcs from the 
previous 	 point. It provides the various option for 
drawing poly arcs. The Arc option can be invoked by 
entering a last prompt.

4	 Revision cloud (Fig 1)
This command is used to high light your mark-ups.

Example

Command	 : REVCLOUD.

Minimum arc length: 2.0000 Maximum arc length: 3.0000 
Style: Normal specify start point or (Arc length / object / 
Style) <Object>: Specify start point.

Guide crosshairs along cloud path:

Revision cloud finished.

Changing the point type.
Normally the point appears as a dot on the screen, the 
style in these dialog box by clicking the pointing device 
(mouse) then select the OK button.
Enter
Command	 : PDMODE.
Pull down	 : Format, point style.
While using the pull - down menu, the point style dialogue 
box will appear select a point style in this dialog box by 
clicking the pointing device (mouse) then select the OK 
button.
Enter
Command	 : PDMODE.
New value for PDMODE<current>: Enter new value (2) .
Command	 : Point.
Point		  : (2.2).
2	Rectangle
This command is used to draw Rectangle.
Example
Command	 : RECTANGLE / REG.
First comer or (Chamfer / Elevation / Fillet / Thickness 
/ Width) : 2,1
Other corner (Area / Dimension / Rotation): 5,6.
Chamfer	 : Used for chamfering the edges.
Fillet		  : Used for filleting the edges.
Width		  : to change the width.
Thickness: allows to draw rectangle that projects in Z- 
direction by the specified value of thickness.
Elevation: allows to draw a rectangle at a specified 
distance from the XY-plane along the Z-axis.
3	 Poly line
This command is used to draw poly lines. The PLINE 
command functions like the LIKE command with 
additional option like arc, length, width, etc.
Example
Command	 : P LINE.
Start point	 : select a point.
Current the width is 0.0000.
Next point or (Arc / Half width / Length / Undo / Width):

Select P1.

Next point or (Arc / Close / Half width / Length / Undo / 
Width): Select P2.

i	 Width: To change the width of the poly line, enter W 
atlast prompt. It asks you to enter the starting 	
 width and ending width of the poly line.

ii	 Undo: This erase the most recently drawn poly line 	
segment. This can be invoked by entering U at the 
last prompt.

5  Spline (Fig 2)
Example

Command : SPLINE.

Specify first point or [Object]: Click on the first point.

Specify next point: <Ortho off>.

Specify next point or [Close/Fit tolerance] <start tangent>: 
Click on the point.

Specify next point or [Close/Fit tolerance] <start tangent>: 
Click on the point.

Specify next point or [Close/Fit tolerance] <start tangent>: 
Click on the point.

Specify next point or [Close/Fit tolerance] <start tangent>: 
Click on the point.

Specify next point or [Close/Fit tolerance] <start tangent>: 
Enter.
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Practice 1: Instructions (Fig 3)
Step 1:	Start a New file and select 1 workbook helper. 
Dwt.
Step 2:	Draw the objects below using:

DRAW / LINE.

ORTHO ON for Horizontal lines.

OBJECT SNAP = ENDPOINT.

Step 3: Save this drawing as.

Practice 2: Instructions a (Fig 4)
Step 1: Start a New file and select 1 workbook helper. Dwt

Step 2: Draw the 2 vertical and 4 horizontal lines using.

DRAW / LINE.

ORTHO (F8) = ON.

SNAP (F9) = OFF.

Step 3: Then draw the diagonal lines using.

DRAW / LINE.

ORTHO & SNAP = OOF.

OBJECT SNAP = INTERSECTION.

Step 4: Save this drawing as. ( Fig 4A)

Practice 3: Instructions
Step 1:	Start a New file and select 1 workbook dwt.

Step 2:	Using FORMAT / UNITS:

Set the units to DECIMALS.

Set the precision to 0.00.

Step 3: Using FORMAT / DRAWING LIMITS set the 
drawing limits to :

Lower left corner = 0,0.

Upper right corner = 12,9.

Step 4: Use view/zoom/ all to make the screen adjust 
to the new limits.

Step 5: Turn OFF the GRIDS (F7) SNAP (F9) and 
ORTHO (F8)

  (Your screen should be blank and your crosshair should 
move freely).

Step 6: Draw the Lines below using.

DRAW / LINE.

OBJECT SNAP = MIDPOINT.

Step 7: Save this drawing as.

Practice 4: Instructions (Fig 5)
Step 1: Using a new file and select 1 workbook helper. 
dwt.

Step 2:	Using FORMAT / UNITS

	 Set the units to ARCHITECTURAL

	 Set the precision to ½”

A warning may appear asking you if you “are 
sure you want to change the units”? Select 
the OK button.

Step 3:	Using FORMAT / DRAWING LIMITS set the 
drawing limits to.

Lower left corner = 0.0

Upper right corner = 25, 20

Step 4: Use VIEW / ZOOM / ALL to make the screen 
adjust to the new limits.

Step 5:	Turn OFF the GRIDS (F7) SNAP (F9) and 
ORTHO (F8)

(Your screen should be blank and your crosshair should 
move freely)
Step 6: Draw the Lines below using.
DRAW / LINE
OBJECT SNAP = MIDPOINT.
Step 7:	Save this drawing as.
Practice 5: Instructions (Fig 6)
Step 1: Start a New file and select 1 workbook helper. 
dwt.
Step 2: Draw the house below using at least 4 commands.
Step 3: You can change the GRID and INCREMENT 
SNAP setting to whatever you like.
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Step 4: You decide when to turn Ortho and Snap On or 
Off. Have some fun with this one.

Step 5: Save this drawing as.

Practice 6: Instructions (Fig 7)
Step 1: Start a New file and select 1 workbook helper. 
dwt.

Step 2: Draw the rectangles below using the options, 
dimension, chamfer, fillet and width.

Step 3: Save this drawing as.

Practice 7: Instruction (Fig 8)

Step 3: Using FORMAT / DRAWING LIMITS set the 
drawing limits to:

Lower left corner = 0,0.

Upper right corner = 12,9.

Step 4: Use VIEW / ZOOM / ALL to make the screen 
adjust to the new limits.

Step 5: Turn OFF the GRIDS (F7) SNAP (F9) and 
ORTHO (F8).

(Your screen should be blank and your crosshair should 
move freely).

Step 6: Draw the objects below using:

DRAW / CIRCLE (CENTER, RADIUS) and LINE.

OBJECT SNAP = QUADRANT.

7 	 Save this drawing as.

Practice 8: Instructions (Fig 9)
Step 1: Start a New file and select 1 workbook dwt.
Step 2: Using FORMAT / UNITS.
	 Set the units to FRACTIONAL.
	 Set the precision to ½”.

Step 1: Start a New file and select 1 workbook dwt.

Step 2: Using FORMAT / UNITS:

Set the units to FRACTIONAL

Set the precision to ¼”.

Step 3: Using FORMAT / DRAWING LIMITS set the 
drawing limits to:
Lower left corner = 0,0.
Upper right corner = 20,15.
Step 4: Use view/zoom/all to make the screen adjust to 
the new limits.
Step 5: Turn OFF the GRIDS (F7) SNAP (F9) and 
ORTHO (F8).
(Your screen should be blank and your crosshair should 
move freely).
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An  option. Eg. H.
Specify through point: Use one of the point fixing methods 
8	 RAY (Fig 13)
Ray creates semi infinite lines commonly used as 
construction lines.  A ray has a finite starting point and 
extends to infinity.
Command	 : Ray.
Menu		  : Draw, Ray.
Specify start 
point		  : Fix a point on the screen.
Specify through point
AutoCAD draws a ray and continue to prompt for though 
points so you can create multiple rays.  Press to end the 
command.

Specify start point or [Justification/Scale/Style]:
Scale is the distance in units between the parallel lines.  
Justification determines where the start point of a vertex 
is. Both these settings are illustrated in the diagram 
below.  Top, Zero and Bottom refer the justification.
Multiline can be closed to form enclosed to form enclosed 
shapes. A closed multiline automatically joins the 
beginning and end of the shape. When you are drawing 
a multiline shape, the command option ‘c’ closes the 
shape otherwise just press enter to finish the command.
Editing multiline
Command line: mledit
Menu: Modify, object, multiline
When the command is issued, the mulitiline edit tools 
dialogue box is displayed. The box is divided in to four 
columns. Each column helps you to edit a different type 
of intersection.
7	 Construction  line (X line) (Fig 12)
X line is a linear object, which starts at infinite and ends 
at infinite, or we can say that it is a line, which has no 
start or end point but passes through a specified point.  
These lines are used for projections. 
Command	 : X line.
Specify a point or [hor/ver/ang/bisect/offset]: use one of 
the point fixing methods or enter. 

Fig 13

Fig 12

Step 6: Draw the objects below using 

DRAW / CIRCLE (CENTER, RADIUS) and LINE.

OBJECT SNAP = CENTER and TANGENT.

Very important: Use the Tangent option at each end of 
the line.  AutoCAD needs to be told that you want each 
end of the line to be tangent to a circle.

Step 7: Save this drawing as. (Fig 10) 

6	 Multilines (Fig 11)
This command allows you to draw between 1 and 16 
lines parallel to each other.  You must tell AutoCAD the 
distance between the parallel lines.
Pull down menu		 : Draw, Multiline.
Command		  : Draw multiline, mI.
Once the command is issued, Autocad responds with

Current settings: Justification = Top, Scale = 1.00, Style= 
STANDARD.

9 Hatch (Fig 14)
Hatch is used to fill an area defined by lines arcs, circles 
or poly line with either a predefined pattern, a user defined 
pattern or a simple hatch pattern.  It is used to show the 
section of solids or objects.
Tool bar: Draw, Hatch.
Pull down menu: Draw hatch B.
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Command: Hatch or H
Step 1: Select type and pattern from predefined, user 
defined and customer select colour from gradients.
Step 2: Mouse click on add pick point.
Step 3: Click inside ABCD.
Step 4: Change angle and scale if you want click on 
preview.
If it is ok then click on in the dialogue.
Example
Command: Hatch, H (Fig 15)

Select objects: 1 found. 
Select objects: 
Properties of the rectangle ABCD = LWPOLYLINE layer: 
“0”
Space: Model space, Handle = d8a, Closed, Constant 
width 0.0000
Area 16486.7990, perimenter 551.6401.
Distance
Pull down menu: Tools, inquiry, distance.
To measure the distance between two points. 
Command: Dist. 
Specify first point: Select A.
Specify second point: Select B.
Distance = 118.6843, Angle in XY Plane = 0, Angle from 
XY Plane = 0.
Delta X = 118.6743, Delta Y = 0.0000, Delta Z = 0.0000.
Area (Fig 16)
Calculate the area and perimater of object or of defined 
areas.

Command: Hatch or H.
This allows you to hatch a region enclosed within a 
boundary by selecting the objects to be hatched. When 
you invoke the HATCH command. The hatch and gradient 
dialogue box is displayed. This dialogue box has several 
options which give various aspects of hatching.

Step 1: Select type and pattern from predefined user 
defined 	 cand custom or select colour from 
gradient

Step 2: Mouse click on add pick point.
Step 3: Mouse inside ABCD.
Step 4: Change angle and scale if you want.
Step 5: Click on preview.
Step 6: If it is ok then click on OK in the dialogue box.
List  
AutoCAD lists out the properties and the geometrical 
parameters of the selected objects.
Pull down menu :- Tools, inquiry, list. 
Command: list. 
Select objects: use any object selection method select 
rectangle ABCD.

Step 1: Pull down menu: Tools, inquiry, area.
Step 2: Command Area. 
Specify first corner point or [ Object / Add / Subtract] 
first point A.
Step 3: Specify next corner point or press ENTER for 
total: Select  next point B.
Step 4: Specify next corner point or press ENTER for 
total: Select next point C.
Step 5: Specify next corner point or press ENTER for 
total: Select next point D.
Step 6: Specify next corner point or press ENTER for 
total: Select next point E.
Step 7: Specify next corner point or press ENTER for 
total: Select next point F.
Step 8: Specify next corner point or press ENTER for 
total.
Area = 8316.3401, Perimeter = 339.4622.
REGEN.
Step 9: Command : Regen.
Step 10: This command makes Auto CAD to regenerate 
the entire drawing to update it. By using this commands, 
the circles and arcs can be smoothened.
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Construction	     Exercise 1.6.40
Interior Design & Decoration - Basic of Auto CAD software and Preliminary 
Auto CAD Software 	   

Drawing practice on AutoCAD (2D software)
Objectives : At the end of this exercise you shall be able to
•	 identify ISO axes
•	 practice ISO drawings on 2D software.

ISO metric  drawing (Fig 1)
Isometric drawing have three principal planes. They are 
isoplane right, isoplane top and the isoplane left.

ISO planes
Step 1: To turn on an isometric plane

1 	 Click Tools menu>> Drafting  Settings.

2	 In the Drafting settings dialog box, snap and grid tab, 
under snap type, select isometric sanp.

3	 Click OK.

You can cycle through the three isometric planes by 
pressing F5.

Step 2: Command: Isoplane ( or Isoplane for transparent 
use)

Enter isometric plane setting [left/top/right] <top>: enter 
an option or press ENTER.

The isometric plane affects the cursor movement keys only 
when Snap mode is on and the snap style is isometric.  If the 
snap style is Isometric, Ortho mode uses the appropriate 
axis pair even if Snap mode is off.  The current isometric 
plane also determines the orientation of isometric circles 
drawn by ELLIPSE.  You can cycle through the isometric 
planes by pressing CTRL+ E or F5.

Left
Selects the left - hand plane, defined by the 90 - degree 
and 150-degree axis pair.

Top  (Fig 2)
Selects the top face of the cube, called the top plane, 
defined by the 30- degree and 150 - degree axis pair.

Right (Fig 3)
Selects the right - hand plan, defined by the 90-degree 
and 30- degree axis pair.

When the snap style has been set to isometric, you will 
find isocircle. Option under ellipse command.  Use this 
to draw circle and arcs in isometric plane.

Example

1	 Create the isometric drawing shown in the Fig 4

Step 1
Change the isometric view by using sanpcommand.

Command: snap

Specify snap spacing or [ON/OFF/Aspect/Style /
Type]<0.5000>:s Enter snap grid style [Standard/
Isometric] <S>:i

Specify vertical spacing <0.5000>.

PROCEDURE
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Step 2: Change the isoplane to isoplane left by pressing 
Ctrl+E or F5. Now draw lines between points P1, P2, P3 
and P1.

Step 3: Change the isoplane to isoplane right by pressing 
Ctrl + E or F5. Now draw lines between points P3, P2, 
P5, and  P6.

Step 4: Change the isoplane to isoplane top by pressing 
Ctrl +E or F5. Now draw lines between points P6, and P7.

Step 5: Change the corresponding plane by pressing 
Ctrl +E or F5 and continue the procedure.

Create the isometric drawing shown Fig 5

Create the orthographic projection drawing shown in Fig 6.

Dimensioning & text 
Objectives : At the end of this exercise you shall be able to
•	 dimensioning
•	 text & text style.
Dimensioning commands
While manufacturing an object, the drawing must contain 
size description such as the length, width, height, angle, 
radius, diameter and location of the object. These are 
added to the drawing with the help of dimensioning.

1	 Dimension - linear (Fig 1)
This command is used to measure horizontal and vertical 
dimensions between two points.

Tool bar		 : Dimension, Linear

Pull Down	 : Dimension, Linear

Command	 : DIM LIN /DLI

Example

Command	 : DIM LIN / DLI

Specify first extension line origin of : Selection point A

Specify second extension line original : Select point B

Specify dimension line location or

[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: Mouse 
click on the position where the dimension is to be placed

Dimension text = 6.00

2	 Dimension - aligned (Fig 2)
This command is used to measure inclined dimension 
between two points.

Tool bar	 : Dimension, Aligned

Pull down	 : Dimension, Aligned

Command	 : DIM ALI /DAL

Example
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4	 Dimension - radius(Fig 4)

This command is used to measure the radius of an arc 
or circle.

Tool bar	: Dimension, Radius

Pull Down	 : Dimension, Radius

Command	 : DIM RA/DRA

Example:

Command	 : DIM RA / DRA

Select arc or

circle		  : Select the circle 

Dimension text = 3.00

Specify dimension line location or [Mtext /Text/Angle]

5	 Dimension - jogged (Fig 5)

Command	 : DIM ALI/DAL

Specify first extension line origin or	 : Select point A

Specify first extension line origin	 : Select point B

Specify dimension line location or

[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: Mouse 
click on the position where the dimension is to be placed.

Dimension text = 9.00

3	 Dimension - ARC length (Fig 3)

This command is used to measure the length of an arc.

Tool bar	: Dimension, Arc length

Pull Down	 : Dimension, Arc length

Command	 :DIMARC/DAR

Example

Command	 : DIM ARC / DAR

Command 	 : DAR DIMARC

Select arc or polyline arc segment

Specify arc length dimension location,

Or [Mtext/Text/Angle/Partial/Leader]: Mouse click on the 
position where the dimension is to be placed

Dimension text = 12.00

Tool bar	: Dimension, Jogged
Pull Down	 : Dimension, Jogged
Command	 : DIM JO/DJO
Example
Command	 : DIM JO/DJO
Select arc
or circle		 : Select the circle 
Specify center location override: Select center
Dimension text = 4.00
Specify dimension line location or [Mtext /Text/Angle]
Specify jog location: Mouse click on the position where 
the dimension is to be placed. 
6	 Dimension - diameter (Fig 6)
This command is used to measure the Diameter of a 
circle.
Tool bar		 : Dimension, Diameter

Pull Down	 : Dimension, Diameter
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Command	 : DIM DIA/DDI

Example:

Command	 : DIM DIA/DDI

Select arc

or circle		 : Select the circle 

Dimension text = 6.00

Specify dimension line location or [Mtext /Text/Angle] 
Mouse click on the position where the dimension is to 
be placed.

7	 Dimension - Angular (Fig 7)

This command is used to continue dimensioning after 
the first dimensioning has been executed.
Tool bar	: Dimension, Continue
Pull Down	 : Dimension, Continue
Command	 : DIM CON/DCO
Example
Command	 : DIM CON/DCO
Specify a second extension line origin or [Undo/Select] 
<Select>: Select C
Specify a second extension line origin or [Undo/Select] 
<Select>: Select D
Specify a second extension line origin or [Undo/Select] 
<Select>:  Cancel
9	 Dimension - base line (Fig 9)

This command is used to measure the Angle between 
two non parallel straight lines.

Tool bar		 : Dimension, Angular

Pull Down	 : Dimension, Angular

Command	 : DIM ANG/DAN

Example

Command	 : DIM ANG/DAN

Select arc, circle, line, or <specify vertex>: Select AB

Specify dimension line location or [Mtext /Text/Angle]: 
Mouse click on the position where the dimension is to 
be placed.

Dimension text = 41

8	 Dimension - continue (Fig 8)

This command is used to give dimension when number 
or dimensions of a part have a common datum.

Tool bar		 : Dimension, Base line

Pull Down	 : Dimension, Base line

Command	 : DIM LEA/LE

Example

Command	 : DIM LEA/LE

Specify first leader point, Select point A 

Specify next point: Select point B

Specify next point:

Specify text width <0.0000>:

Enter first line of annotation text <Mtext>: WOODEN 
BLOCK

10	Dimension - leader (Fig 10)

This command is used to give leader lines i.e. used to 
describe some features in the drawing.

Tool bar		 : Dimension Leader

Pull Down	 : Dimension Leader
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Command	 : DIM LEA/LE

Example

Command	 : DIM LEA/LE

Specify first leader point, Select point A 

Specify next point: Select point B

Specify next point

Specify text width <0.0000>

Enter first line of annotation text <Mitest> WOODEN 
BLOCK

11	Dimension - style (Fig 11 to 14)

Tool bar		 : Dimension, Dimension style
Pull Down	 : Dimension, Dimension style
Command	 : D
This command is used to select or change the properties 
of a dimension. When you enter this command the 
dimension style manager dialogue box will be displayed.  
This dialogue box provides various options for modifying 
the dimension.  Click on modify and give the new values.
Dimension style (Fig 15 to 18)
Pull down menu: Dimension, Dimension style
When you select this, a dimension style manager dialogue 
box will appear on the screen.
A dimension style is a saved set of dimension settings 
defining the appearance and behaviour of the dimensions.  
By creating dimension styles. You can set all relevant 
dimension system variables and control the layout and 
appearance of all dimesions within a drawing.
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Description
1	 Here you can set the types of arrow heads. 

(Fig 22)

Description
Sets the dimension line properties (Fig 19)

1	 Colour displayed and sets the colour for dimension 
line.

2	 Line type sets the type of the dimension line.

3	 Line weight sets the line weight of the dimension	
line.

4	 Extend beyond ticks specifies a distance to extend 
the dimension line past the extension line when 
you use oblique, architectural, tick, integral, and 
no marks for arrow heads.

5	 Base line spacing sets the spacing between the 
dimension lines of a base line dimension. Enter a 
distance.

6	 Suppress suppresses display of dimension line 
when they are outside.

Description
1	 External beyond dim lines specifies a distance to 

extension lines from the origin points that define 
the dimension.

2	 Offset from origin specifies the distance to offset 
the extension lines from the origin points that define 
the dimension.

3	 Fixed length extension lines, set the length of 	
the extension line. (Fig 21)

Description
Set the extension line properties (Fig 20)

1	 Colour displayed and sets the colour for extension  
line.

2	 Line type sets the type of the extension lines.

3	 Line weight sets the line weight of the extension 
lines.

4	 Suppress suppresses display of extension lines.

Fig 19

Fig 20

Fig 21

Fig 22
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2	 Arrow size sets the size of arrow.

Symbols and arrows tab (Fig 23)

Fig 24

Description
1	 Text style button displays the text style dialogue box, 

which you can use to define or modify text styles.  
(Fig 24)

2	 Text colour displays and sets the colour for the 
dimension text.

3	 Text height displays and sets the current dimension 
text style.

4	 Draw frame around text draws a frame around 
dimension text.

Tex tab (Fig 25 & 26)
1	 Vertical position controls the vertical justification of 

dimension text along the dimension line.

2 	 Horizontal position controls the horizontal justification 
of dimension text along the dimension line and 
extension line.

3	 Offset from dimension line displays and sets the 
current text gap, which is the distance around the 
dimension text when the dimension line is broken to 
accommodate the dimension text.

Fig 25

Fig 23

Fig 26

1	 Horizontal places text in a horizontal position.  
(Fig 27)

Fig 27

2 	 Aligned with dimension line aligns text with the 
dimension line. (Fig 28)

3 	 ISO standards aligns text with the dimension line 
when the text is inside the extension lines, but aligns 
horizontally when text is outside the extension lines. 
(Fig 29)
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Fig 28 Fig 29

Primary units tab (Fig 30)

1 	 Prefix includes the prefix you enter in the dimension 
text. You can enter text or use control codes to 
display special symbols. For example, entering the 
control code % %c displays the diameter symbol. 
(Fig 31)

2 	 Suffix includes the suffix you enter in the dimension 
text. You can enter text or use control codes to 
display special symbols.For example,entering the 
text mm results in the dimension text similar to that 
shown in the 	 illustration.

3 	 Measurement scale defines measurements scale 
options as follows: Linear scale factor sets a scale 
factor for linear dimension measurements for all 
dimension types except angular.

Fig 30

Fig 31

Control code % displays the diameter symbol.

Primary units tab

Dimensioning: Create the following exercise using 
CAD 	
commands.

Text (Fig 32)
This command is used for entering the related details 
on a drawing. Text is used for entering details in the 
title blocks, for labelling the parts of drawing, For giving 
specifications and for making annotations etc. There are 
two types of text used in Auto CAD.

Deseription
1	 Unit format sets the current for all dimension types 

accept angular. Options to select from include 
scientific, decimal, engineering, architectural, 
fractional etc.

2 	 Precision displays and sets the number of decimal 
places in the dimension text.

3 	 Fractional format sets the format for fractions. 
Options to select from include diagonal, horizontal, 
and not stacked.

4	 Decimal separator sets the separator for decimal 
formats. Options to select from include period 	
(.), comma (.), or space.
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Fig 32

1	 Single line text or D text.

2	 Multiline text or M text.

1	 Single line text or D text
Pull down		  :  Draw, TEXT, single line text

Command		  :  TEXT or DT

Current text style		 : “Standard” 

Text height		  : 0.2000

Specify start point of text or [Justify/Style]: Select start point

Specify height<0.2000>: 25

Specify rotation angle of text <0>

Type on the screen:  TEXT

2	 Multiline text or M text
Pull down		  : Draw, Text, Multi line text

Command		  : MText or  MT

Current text style		 : “ Standard”

Text height 		  : 0.20000

Specify first corner	 : Click on the first corner

Specify opposite comer or [Height/Justify/

Line spacing /Rotation/Style/Width]: click on the second 
corner Give text height, type, style, etc.

Enter the text, And press button OK.

 Plotting drawings (Fig 33 & 34)
Printing or plotting of a drawing can be done by using a 
printer or a plotter. 

Print or plot command 

Various input facilities are available for printing a drawing. 
Facilities like key board, menu bar or tool bar with mouse 
are explained below.

Text style (Fig 35) 
This command is used to change the text style.

After giving changes click on apply.
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Properties &  blocks
Objectives : At the end of this exercise you shall be able to
•	 match properties
•	 identify line weight
•	 practice block.

Match properties
This command is used to copies the properties from one 
object to one or more objects.

Step 1: Pull down menu: Modify, match properties

Step 2: Command: Match properties, MA

Step 3: Select the source object: Pick the object whose 
property to be matched.

Step 4: Select destination object(s) or [settings]: Select 
the object to which properties are to be copied or press 

Step 5: Select destination object(s) or [settings]

Change the properties
Command: CHPROP

When you select an object in the drawing area, the object 
properties window displays all the properties they have 
in common.

The properties that are in grey cannot be modified.

Line type (Fig 1)

Pull down menu	 : format, line type

Command	 : L type 

click here

Fig 35

Fig 1 Fig 3

Computer aided drafting exercise 15-16 

Plotting

Objectives: At the end of thess lessons, you shall be 
able to practice 

Plotting drawings.

After invoke this command a ‘Line type manager’ dialogue 
box will appear on the screen.

Click here

Clik ok
Select line type from here 

Click Ok in the ‘line type manager’ dialogue box.

Object snaps (Fig 2 to 5)
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Click ok Select line type from here

Fig 4

Suppose you want to draw a line from the center of the 
circle to the middle of the vertical line you extended earlier.  
AutoCAD has a feature that makes this very easy.  These 
are the object snaps (or Osnaps “Oh-Snaps”). Type os 
<ENTER>.  You will see this dialog box appear.

Block 
This is used for storing a part of drawing or entire drawing 
or symbols that are needed in the same drawing or for 
other drawing.  This is stored with a desired scale factor.  
All the objects inside a block considered as a single object.

Tool bar	 : Draw block, make

Pull down menu	 : Draw, block, make

Command	 : Block or B

When you invoke the command  BLOCK a block definition 
dialogue box is displayed.

1	 Draw a door. (Fig 6)

2	 Click on draw pull down menu, click on block, click 
on make

Fig 5

3	 Type the name in this area, door. (Fig 7)

4	 Click on select objects. AutoCAD hides the dialogue 
box. Pull a selection window around the door and 
press enter. The dialogue box will return.

5	 Click here and pick an insertion point, use object 
snap.

6	 Select.

7	 Unit offered here are the drawing units.

8	 Click on ok

Fig 7

Insert block (Fig 8)
Once the block has been created you may insert it in 
the drawing. 

•	 Click on the insert menu 

•	 Click on block 

•	 The insert dialogue box will appear 

•	 Click on the down arrow all the blocks created in the 
current drawing will be listed. Select the block name. 

•	 At this point you are returned to the drawing with the 
	 block attached to the cross hairs at the insertion point 

you defined. 

•	 Move the block in to position on the sreen. The 
command line asks for the insertion point and lists 
several options.[Scale, X/Y/Z/Rotate/Pscale/PX/PY/
PZ/PRotate]
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1	 Pull down menu: Format, point style

2	 Select new pointstyle from this box 

3	 Click OK 

Then the points are visible clearly.

Fig 8

Fig 9
Fig 10

These options refer to the scaling and rotation of the block. 
If you simply pick a point on the screen the block will be 
inserted without being scaled(at the size it was drawn)

•	 The block is now locked in to position in the drawing. 

Write block (Fig 9) 

If a block is converted in to a drawing file then you can 
use it in any other drawing. 

•	 Type WBLOCK at the command line and press enter. 

•	 The write block dialogue box appears. 

•	 Select block 

•	 Click on the down arrow and select the block name. 

At this stage AutoCAD takes the block and converts it 
to a drawing. This drawing can be treated like Aito CAD 
drawing You can open it as a separare drawing, explode 
it, edit & draw in the usual way 

Divide 
This command   is used to divide a line or arc or circle 
in to number of parts. 

1	 Command : Divied, div

2	 Select object to divide: Select the line AB

A					      B

Before divide 

A B

Before divide

If you cannot see the division on the screen, change the 
point stlyle.

Point style (Fig 10) 

Drafting of door elevation
Objectives : This shall help you to
•	 draft the door elevation using basic CAD commands.

Data : Size of the door

	 Height = 2100

	 Width = 100

Step 1: Create a new metric file.

Step 2: Draw a rectangle with the following dimensions.

	 i. Length = 100

	 ii. Width = 210

Step 3: Offset the rectangle towards the inside for 2.5 
units.

Step 4: Create another rectangle with the dimension of 
80, 170 as shown in Fig 1a.

Step 5: Create an ARC as follows with the help of start, 
End and Direction method. (Fig 2)

	 i. Chord length = 40 units

	 ii. Tangent angle = -60 deg

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.6.40

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



187

Step 6: Mirror the arc to the opposite side and trim the 
unwanted portion to get the following result. (Fig b)

Step 7: Convert the inner loop as a single element with 
the help of PEDIT.

Step 8: Offset the inner loop to 2.5, 10 & 2.5 units. (Fig c)

Step 9: Complete the model as follows with the help of 
Circle, Line, Offset and Trim. (Fig d)

Drafting of chair plan using 2D software
Objective : This shall help you to
•	 draft the door elevation using basic CAD commands.

Step 1: Create two tectangles with the following 
dimensions.

I	 Length = 15; Width = 4

II	 Length = 12; Width = 7 (Fig 1)

Step 2: Use the MOVE command to assemble the 
rectangles as follows. (Fig 2)

Second point: from

Base point: <Pick the bottom midpoint of the first  
rectangle> (Fig 3)

Offset: @2.5<270 (Fig 4)

Command: Move

Select object: select the second rectangle

Select object: <Null response>

Base point: <Pick the top midpoint>

Step 3: Use the ARC and MIRROR commands to connect 
the rectangles. (Fig 5)

Arc between P2 and P1

Command: ARC
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	 Command: OFFSET
	 Offset distance: 1
Object to offset “ <select teh bottom rectangle of teh 
created seat >
Side to offset: <pick in the outside of the seat>
Repeat the above two steps to create one more offset. 
(Fig 10 & 11)

Start Point: <Pick P2: Use ‘Mid between two points’ in 
object snap>
Second point [Centre/End]: E
End Point: <Pick P1>
Centre Point [Angle/Direction/Radius]: R
Radius: 1.5
Create one more ARC as like as above which connects 
P2 and P3. (Fig 5)
MIRROR both the arcs to the opposite side.
Command: MIRROR
Select objects: <select both the arcs>
Select objects: <Null response>
First point of mirror line: <Pick the top middle point of 
ottom rectangle>
Second point of mirror line: <Pick the bottom middle point 
of the top rectangle> (Fig 6)

Step 6:	Create the back rest. (Fig 9)

Step 4: Trim the unwanted edges to get the following 
output.
Command: TRIM
Select cutting edges: <select all> (Fig 7)

Select object to trim: <select the unwanted edges>
Step 5:	Fillet the corners with radius 2. (Fig 8)

Connect the open ends with the help of LINE. (Fig 12)

Create the connection between the seat to the back rest 
with the help of LINE. (Fig 13)
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Construction	 Exercise 1.7.41
Interior Design & Decoration - Civil Components (Ceiling & Flooring)

Design a false ceiling in a room
Objective: At the end of this exercise you shall be able to
•	 draw the different types of false ceiling using Auto CAD.

PROCEDURE

TASK 1 : Draw a detail suspended ceiling using Auto CAD (assuming the data as required) (Fig 1)

1	 Room size = 400 x 200cm.

2	 Hight of room is = 360cm.

3	 Depth of suspended ceiling = 30cm

4	 Plaster of Paris (POP) boards panel size = 50 x 
50cm

5	 ‘L’ shaped metal hangers as per the requirement

6	 Length wise wooden reapers size = 400cm

7	 Width wise wooden reapers size = 200cm

8	 Draw to scale 1:20 (or) 5cm = 1meter as shown 
other wise choose any convenient scale.
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Draw the elevation  of the false ceiling
Step1: 	 Open the Autocad Software (Fig 2)

Fig 2

Fig 3

Step 2: 	 Start a New Drawing

Step 3: 	 Type the Command: UNITS  in command line

Step 4: 	 Select the paper size (FIg 3)

		  In command line palette give or Command: 
LIMITS

Reset Model space limits: for A3  paper as shown below

Specify lower left corner or [ON/OFF] <0.00,0.00>:

Specify upper right corner <420.00,297.00>:

Step 5: 	 Give Command: ZOOM

Specify corner of window, enter a scale factor (nX or 
nXP), or

[All/Center/Dynamic/Extents/Previous/Scale/Window/
Object] <real time>: A..... (to zoom all)

Regenerating model.

Step 6: 	 Save the Drawing by selection Ctnl+S

Step 7: 	 Give Command: RECTANG

Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: Pick the corner point in the window 
screen by lift click of the mouse button

To specification next corner point select - Dimensions

Specify other corner point or [Area/Dimensions/
Rotation]: D

Specify length for rectangles: 400

Specify width for rectangles: 200
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For POP-panels

Step 8:	 Command: RECTANG (Fig 4)

Repeat the above step 7 to create another inside rect

With specify other corner point or [Area/Dimensions/
Rotation]: D

Specify length for rectangles at 50

Specify width for rectangles at 50, as shown in fig

Step 9: Type: HATCH command in command line  
(Fig 5)

Pick internal point or [Select objects/Undo/seTtings]: 
Selecting everything...

Selecting everything visible...

Select the following HATCH type

Pick internal point or [Select objects/Undo/seTtings]: 
‘_-hatchedit_pANSI31

Fig 4

Fig 5
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Step 10:	Now give Command: ARRAY for drawing 
multiple rectanguler as shown (Fig 6)

Step 11:	 To Offset the object as shown in Fig 7

TypeCommand: OFFSET

Current settings: Erase source=No Layer=Source 

OFFSETGAPTYPE=0

Specify offset distance or [Through/Erase/Layer]: 3

Select object to offset or [Exit/Undo] <Exit>:

Fig 6

Fig 7

Enter array type [Rectangular/PAth/POlar]: R

Type = Rectangular Associative = Yes
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Step 12:	Select the Line Type (Fig 8) Change the Hidden Line for Aluminium Panel.

Fig 8

Step 13:	This elevation is as it appears from below the 
ceiling.

Step 14:	For cross-section, take the orthographic 
projections from the elevation. It is a horizontal 
cross-section.

Step 15:	Take the total depth of 30 cm. from below the 
RCC slab; which is supported by brick walls.

Step 16:	Then draw the metal hangers, vertical & 
horizontal reape rs and POP panels fixed 
to the framework.  Metal hangers are 3 mm 
thickness, vertical wooden reapers (widthwise) 

are 3x3 cm and horizontal wooden reapers 
(lengthwise) are 5x2 cm size and POP panels 
are 1cm. thickness.

Step 17:	Assign proper line weights to create the 
effective appearance of the builiding.

Step 18:	Plot the drawing to a printer or to a PDF 
format. Hit the plot icon to open the plot 
settings. Choose the layout type, pen settings, 
and window view that you would like to use.

Step 19:	Take a print in A3 size paper. 

TASK 2 : Draw the aluminium section false ceiling (Fig 1)

Draw the elevation  of the false ceiling
1	 Room size = 2400 x 1200mm

2	 Height of room size = 3600mm

3	 Draw elevation the room size 400 x 200 cm.

4	 Depth of the suspended ceiling = 300mm

5	 Suspended ceiling files size = 300 x 300 x 20mm.

6	 ‘L’ wall ceiling angle = 22 x 20mm.

7	 ‘T’ grade false ceiling angle = 27 x 25mm

8	 Metal hangers as per requirement

9	 Draw to scale 1:20 or choose any convenient scale

10	Draw the elevation and section of aluminium false 
ceiling using various commands in auto CAD, refer 
the TASK 1.

11	Take a print in A3 size paper. 
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TASK 3 : Details of aluminium section false ceiling accessories (Fig 1 to 6)

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.7.41

Fig 6

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



195

Construction	 Exercise 1.7.42
Interior Design & Decoration - Civil Components (Ceiling & Flooring)

Specify the level of false ceiling and section and finishing material
Objective: At the end of this exercise you shall be able to
•	 draw different type of sections of suspended false ceiling with different material with suitable scale.

PROCEDURE

TASK 1 : Draw different types of sections of suspended false ceiling with different material with suitable scale 
	 using Auto CAD (Fig 1 to 5)
5 types are need to be drawn with different measurements 
and suitable scale use autocad software/

1	 Acoustic tile (Plain).

2	 Aluminium clad acoustic tile.

3	 Plaster ceiling.

4	 Gypsum board ceiling.

5	 Plywood finish.

From the given drag (1-5) draw as given below assuming 
the length and width as given in the diagram in AutoCad.

Step 1: 	 Open a autocad software draw the base line 
to draw the section of the ceiling.

Step 2: 	 According to the section line shown in the 
plan the width of walls, room has to be drawn 

according to the design using line, offset, trim 
commands.

Step 3: 	 Use the hatch commands to show the false 
ceiling in the section.

Step 4: 	 Activate the text commands for mentioning 
the name and size of the ceiling.

Step 5: 	 Using dimension command complete the 
dimensioning of the section drawing.

Step 6:	 Plot the drawing to a printer or to a PDF 
format. Hit the plot icon to open the plot 
settings. Choose the layout type, pen settings 
and window view that you would like to use.

Step 7:	 Take a print A3 size paper.

	 1 			   Concealed 2 spline system with  	
		  acoustic tile (Plain)

	 2 			   Concealed 2 spline system with 	
		  Aluminium clad acoustic tile
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	 3 			   Suspended plaster ceiling

	 4 			   Suspended with Gypsum board

	 5 			   Suspended ceiling with plywood 		
		  finish
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Construction	 Exercise 1.7.43
Interior Design & Decoration - Civil Components (Ceiling & Flooring)

Design a flooring pattern with different finishing material
Objective: At the end of this exercise you shall be able to
•	 draw different type of floors with different material and functions using Auto CAD.

PROCEDURE

TASK 1 : Draw the section of a timber ground floor (Fig 1)  

DATA
	 Wall 	 -  	 200 mm thick.

	 Base concrete  	 - 	 150 mm thick.

	 Sleeper walls 	 - 	 100 mm thicks, at 	
			   1500 mmc/c.	
	 Wallplate 	 - 	 100 mm thick.

	 D.P.C 	 - 	 25 mm thick.

	 Bridging joint 	 - 	 50 x 180 mm.

	 Floor boards 	 - 	 32 mm thick.

1	 Draw the section of wall above and below ground 
floor.

2	 Draw the section of a timber ground floor using 
various commands in Auto CAD.

3	 Draw the base concrete, 150mm depth.

4	 Draw the sleeper wall of height 1000mm at 1500mm 
C/C.

5	 Draw the section of wall plate 100mm x 100mm, 
over 300mm thick D.P.C on end wall and centre of 
sleeper wall.

6	 Draw the elevation of bridging joint 180mm depth 
over these wall plates.

7	 Draw the section of floor boards, 32mm thick over 
joint

8	 Finish the drawing with proper conventional symbols.

9	 Take print out in A3 size sheet.
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TASK 3: Draw the isometric view of flag stone floor (Fig 1)

DATA
	 Stone size	 -  	 60 x 45 x 20 mm

	 Depth of concrete for subgrade -100 mm 

	 Mortar bed	 - 	 20 mm thick	
				  
	 Concrete subgrade thick - 100 mm

	 Cement mortar subgrade thick - 20 mm 

1	 Draw the isometric view of flag store floor using 
various commands in Auto CAD

2	 Draw the sub grade with 100mm thick lean concrete 
as shown in figure.

3	 Draw 20mm thick lime/cement mortar over this sub 
grade

4	 Draw the stone slabs over this mortar bed as shown 
in figure.

TASK 2: Draw the isometric view of brick floors (Fig 1)

DATA
	 Concrete sub-grade thick -  	100 mm 

	 Lime/cement mortar  	   - 	12 mm        
	 supgrade thick

1	 Draw the isometric view of brick floors using various 
commands in Auto CAD. (Fig 1)

2	 Draw the sub-grade with 100mm thick lean concrete 
as shown in figure.

3	 Draw 12mm thick lime/cement mortar over this 
subgrade.

4	 Draw the isometric view of bricks laid on edges as 
shown in figure.

5	 Take print out in A 4 size paper.

TASK 4: Draw the section of cement concrete floor (Dimensions are given in) (Fig 1)

5	 Complete the drawing by printing dimension and 
other related notes.

6	 Take print out in a 4 size sheet.

DATA
	 Concrete above earth fill thick       	  - 100 mm

	 Floor finish cement plastering thick	  -	  25 mm 

1	 Draw the section of cement concrete floor using 
various comment in Auto CAD

2	 Draw section of a wall, with basement

3	 Draw a line to mark to ground level

4	 Show hard earth filling of suitable (it may varies 
thickness above ground level.

5	 Draw 100mm thick base concrete above earth fill.

6	 Draw 25mm thick floor finish with cement plastering.

7	 Take printout in A4 size paper.
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TASK 6: Draw the section of marble floor (Fig 1)

DATA
	 Sand filling above earth fill thick     	  	  - 150 mm
	 Cement concrete over sand filling thick 		  - 75 mm
	 Cement mortar thick	    - 34 mm
	 Marble thick		  - 6 mm 
1	 Draw the section of marble floor using various 

commands in Auto CAD
2	 Draw section of a wall with basement
3	 Draw a line to mark ground level.
4	 Show well consolidated earth fill above ground level.
5	 Draw 150mm thick sand filling above earth fill.
6	 Draw 75mm thick cement concrete over sand filling.
7	 Draw 34mm thick cement mortar.
8	 Shown 6mm thick marble chips is cementing 

materials as mosaic flooring.

TASK 5: Draw the section of terrazzon floor (Fig 1)
DATA
	 Sand filling above earth fill thick     	  	  - 100 mm
	 Cement concrete over sand filling thick 		  - 75 mm
	 Cement mortar thick	    - 34 mm
	 Terrzzo flooring thick		  - 6 mm 
1	 Draw the section of terrzzo floor using various 

commands in Auto CAD.
2	 Draw section of a wall with basement
3	 Show well consolidated earth fill above ground level.
4	 Draw 150mm thick sand filling above earth fill,
5	 Draw 75mm thick cement concrete over sand filling.
6	 Draw 34mm thick cement mortar.
7	 Draw a line to mark ground level
8	 Draw 6mm thick terrzzo flooring.

9	 Complete the drawing by printing dimension and 
other related notes

10	Take print out in a A4 size sheet.

TASK 7: Draw plan and detailed section of a single joist timber floor (Fig 1)

DATA
	 Room size  	 - 	 300 x 4900 mm
	 Wall	 - 	 300 mm thick
	 Bridging joist	 - 	 50 x 100 mm at 350 mm 	
				    c/c
	 Herring bone strutting	- 	 32 x 50 mm
	 Floor board	 -	 32 mm
	 Wall plate	 -	 100 x 75 mm
	 Wedge	 -	 75 x 100 mm
1	 Draw plan and detailed section of single distemper 

floor using various commands.
2	 Draw the plan of the room 3000x1900mm, width wall 

thickness 300mm.
3	 Draw wall plate 100mm wide on longer side, in 

dashed line.
4	 Draw 75mm thick wedges on shorter walls.

5	 Draw the bridging joints, 50mmm width at 350mm 
c/c in shorter span.

6	 Draw 32mm wide strut in the middle of shorter span 
and between the bridging joists.

7	 Show the boarding of 32mm thick at one corner and 
complete the drawing as shown in figure.

8	 Complete the drawing and take print in a A3 size 
paper.

To draw the section along long span (Section AA) 
(Fig 1)
DATA
	 Wedge wide	 - 	 75 mm
	 Wedge height	 - 	 100 mm 
	 Bridging joists wide	 - 	 50 mm 
	 Bridging joists depth	 - 	 100 mm
	 Other wedges	 -	 350 mm c/c
	 Struts	 -	  32 x 50
	 Wedge	 -	 32 mm

9	 Complete the drawing by printing dimensioning and 
other related notes.

10	Take print out in a A4 size paper.
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1	 Draw the section along long span (section AA) using 
in AutoCAD

2	 Draw the section of wall.
3	 Draw the wedge 75 mm 100 mm height, attached to 

the wall
5	 Draw bridging joists 50 mm wide, 100 mm depth, 

first one attached to the wedge and others, 350 mm 
c/c

6	 Draw the struts 32 X 50 mm diagonally between the 
joists

7	 Draw the floor board 32 mm thick on the bridging 
joist.

8	 Draw the ceiling joining the bridging joist at bottom 
and complete the drawing

9	 Complete the drawing and take print out in A4 size 
sheet

To draw the section along shorter span (Section 
BB) (Fig 1)

DATA
	 Wall plate wide	 - 	 75 mm
 	 Wall plate height	 - 	 100 mm 
	 Bridging joists height	 - 	 100 mm 
	 Borad thick 	 - 	 32 mm
1	 Draw the section of wall.
2	 Draw wall plate 75 mm wide, 100 mm height, inside 

the wall
3	 Draw bridging joists 100 mm over this wall plate
4	 Draw a 32mm thick borad over the joist, starting from 

the side of wall.
5	 Show air space as shown in figure.
6	 Draw ceiling under the bridging joist and complete 

the drawing.
7	 Complete the drawing and take print out in A4 size 

sheet
8	 Use the hatch commands to show the rcc, rubble 

masonry in the section and take the printout in A4 
size paper.
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Construction	 Exercise 1.7.44
Interior Design & Decoration - Civil Components (Ceiling & Flooring)

Specify the starting point of flooring
Objective: At the end of this exercise you shall be able to
•	 draw detail of starting point of flooring. 

PROCEDURE

Draw a detailed of starting point of floor covering for claying of granite/marble floor using AutoCAD

1	 Starting point of floor

2	 Draw 230mm with 2.5cm DPC a plinth level along 
with stone foundation 450 mm thick below.

3	 Draw sub floor total depth of 900mm bottom soling is 
40 mm aggregate/random ribble of 150mm.

4	 Rammed earth filling 600mm thk. Flat brick soling 
75mm thk. (When black cotton soil is present)

5	 Base of 100 mm thk. Cement concrete in 1:4:8 and 
smeared with 1:2:4 concrete 

6	 Draw floor covering or flooring of 20mm thk. Of 
desired tile granite/marble.

7	 Draw the ground floor and upper floor of the flooring 
using various commands in AutoCAD (Fig 1 and 2)

8	 Draw the sectional view 

9	 Complete the drawing by printing dimension and 
other related notes.

10	Take print in A4 size paper.

Specify the dimension & sizes of floor
Objective: At the end of this exercise you shall be able to
•	 components of various types of spaces floor
•	 draw the specified dimensions of drawing.

TASK 1 :  Mention the floor covering for various types of spaces as mentioned below

1 	 Reception of office space.

2	  Dancing floor.

3 	 Living room of resistance.

4	 Toilets space.

5	 Kitchen space(countertop)

6	 Industrial space.

7	 Auditorium space(Theatre space)

8	 Restaurant space.

Space can have varied form of flooring 
depending on the user and function.

9	 Suitable flooring convenient to the space occupied 
needs to be considered.
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TASK 2 :  Draw commercial complex with specified dimensions (see drawing) using Auto CAD

1	 Draw the commercial complex plan (Fig 1)

2	 Draw the plan of the commercial complex using 
various commands in AutoCad.

3	 Draw magazine floor above used for extension 
activity (Fig 2 & 3) 

4	 Draw the sectional – B-B view (Fig 4)

5	 Draw the sectional – C-C view (Fig 5)

6	 Complete the drawing by printing dimension and 
other related notes

7	 Take print out in A3 sheet.
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Construction	 Exercise 1.8.45
Interior Design & Decoration - Joinery Details and Paints

Drafting details drawing of different types of joints
Objectives: At the end of this exercise you shall be able to
•	 draw the isometric views of lengthening joints	                           
•	draw the isometric views of angle and widening joint
•	 draw the isometric views of bearing joints.

Draw the details of the different types of joints as per drawing. TASK 1  to TASK 15 : Using AutoCAD.
Take a print in A4 size paper.

PROCEDURE

TASK 1 : End Half - Lap Joint

1	 Draw the isometric views end of Half-lap Joint

2 	 Draw two wooden pieces 48x48x250mm = 2nos

3 	 Draw a depth of lap 24mm

4	 Complete the views of end Half-lap Joint (Fig 1).

TASK 2  : Tongue and groove joint

1	 Draw the isometric views of tongue and groove.

2 	 Draw two wooden pieces 90x30x450mm

3	 Draw the tongue and groove 10x10mm

4	 Draw the complet tongue and groove Joints (Fig 1) 

TASK 3 :  Mitre bridle joint
1	 Draw the isometric views of mitre bridle joint

2	 Draw the two wooden pieces, 50x30x150mm

3	 Draw the mitre 45°

4	 Draw the bridle 50x10

5	 Draw the complete the mitre bridle joint Fig 1
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TASK 4 :  Single Notched Joint 
1 	 Draw the isometric view of single notched joint

2	 Draw the lower edge of the joist being cut to fit over 
the wall plate

3	 Draw a isometric view of wall plate of size 150 x 100 
mm

4	 Draw isometric view of joist of size 50 x 120 mm

5	 Draw cutting edge 20mm notch in the joist

6	 Complete the views of single notched joint (Fig 1)

TASK 5 :  Double notched Joints 

1	 Draw isometric view of double notched joint

2	 Draw similarly Fig No.1

3	 Draw the cutting edge in the wall plate 20mm thick 

4	 Complete the views of double no tched joint (Fig 1)

TASK 6 : Single cogged Joint 
1	 Size of notch 40 x 50 x 20 mm

2	 Draw the isometric view of single cogged joint

3	 Draw one notch in lower wall plate

4	 Draw similarly notch in joist

5	  Complete the Isometric view of single cogged joint                  
(Fig 1).

TASK 7 : Double cogged joint 
1	 Draw the isometric view of double cogged joint

2	 Draw two notches in the lower piece of timber on 
either side of uncut portion in the middle 

3	 Draw a notch on upper piece of timber to receive the 
cog of the lower piece.

4	 Complete the view of Double cogged Joint (Fig 1).

TASK 8 : Through housing joint

1	 Draw an isometric view of through housing

2	 Draw the two wood piece of 90x20x140mm

3	 Draw the depth of housing 10mm

4	 Complete the isometric view of through housing

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.8.45
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TASK 9 : Half lap Joint
1	 Draw an isometric view of Half lap joint
2	 Draw isometric view of 80 x 40 mm rectangular piece  
3	 Draw another piece in the same size at right angle to 

previous piece (80 x 40mm)
4	 Draw cut out half of the thickness of each timber 

piece 
5	 Complete the Drawing of Half lap joint (Fig 1)
6	 Draw the elevation Longitudinal Half lap joint.

TASK 10 : Dovetail Half lap Joint
1	 Draw an isometric view of Dovetail halved joint

2	 Draw 150 x 100 mm timber piece in isometric view.

3	 Draw another piece of timber in same size at right 
angle to previous timber piece

4	 Draw the upper edge being cut 150mm on one side 
and other side tapered of size 110mm

5	 Draw similarly the top piece of lower edge to fit into 
the lower piece

6	 Complete the Drawing of Dovetail Halved Joints            
(Fig 1).

TASK 11 : Lapped Dovetail Joints 

1	 Draw an isometric view of lapped dovtail joint

2	 Draw Two pieces joined at corner in isometric view                      
(130 x 100 x 20mm)

3	 Draw 10mm and 20mm size alternately on one edge

4	 Draw another cutting edge as per given Dimension 
to fit into corner joint

5	 Complete the drawing of lapped Dovetail Joint           
(Fig 1).

TASK 12 :  Single Dovetail Joint

1	 Draw an isometric view of single dovetail joint.

2	 Draw isometric view of timber piece size  
90 x 44 x 32mm

3	 Draw 1/4th size (11 mm) on both ends.

4	 Draw 6mm socket on both ends

5	 Complete the Drawing of single Dovetail Joints               
(Fig 1)
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TASK 13 : Mortice and Tenon Joint  
1	 Draw the isometric view of Mortice and Tenon joint.

2	 Draw a timber piece of size 90x35x33 mm in 
isometric view.

3	 Draw a tenon 35x11mm.

4	 Similarly draw a timber piece of size 66 x 32mm at 
top.

5	 Draw a 35x11mm size mortice.

6	  Complete the drawing of mortice and Tenon joints                    
(Fig 1).

TASK 14 : Draw Haunched mortise and tenon joint between Top rail and style to a scale 1:10
Data
Size of vertical style 100 x 50 mm

Size of top rail 100 x 50 mm 

1	 Draw isometric view of vertical style

2	 Draw mortice on top of vertical style

3	 Draw Haunch 40mm Deep and 16mm thick 

4	 Draw an isometric view of top rail 100 x 50 mm

5	 Draw shoulder on both side 17mm wide

6	 Draw tenon 100 mm length

7	 Draw the wedges.

8	 Complete the drawing of Havnched mortise and 
tenon joint between the top rail and style (Fig 1).

TASK 15 : Draw isometric view of Double mortise and tenon joint  between middle rail and style
Data
Size of vertical style as per (Fig 1)

Size of middle rail 200 x 50 mm

1	 Draw isometric view of vertical style

2	 Draw two mortice in the vertical style

3	 Draw the distance between the mortice 40mm deep

4	 Draw  groove at right side for panel (12mm)

5	 Draw an isometric view of middle rail 200 x 50 mm

6	 Draw 12mm groove at top for panel fixing.

7	 Draw each 70mm depth tenon 

8	 Draw 40 mm depth Haunch

9	 Draw wedges to tighten the joints

10	Complete the Drawing of double mortice and tenon 
joints between middle rail or Lock rail and style.  
(Fig 1). 
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Construction	 Exercise 1.8.46
Interior Design & Decoration - Joinery Details and Paints

Drafting panelled & glazed door with wire gauge shutter
Objective: At the end of this exercise you shall be able to
•	 draw the plan, section and elevational views of panelled, glazed with wire gauged door using AutoCAD                          

PROCEDURE

TASK 1 : Draw the elevation and vertical section of panelled and glazed with wire gauge door

Data
Door opening 1200 x 2100 mm

Frame size

Head = 120 x 75 mm

Post = 110 x 75 mm

Top Rail = 100 x 40 mm

Lock Rail = 150 x 40 mm

Bottom Rail = 200 x 40 mm

Hanging style and meeting style = 100 x 40 mm

Front shutter = wire gauge

Back shutter = panelled + glazed

1 	 Draw the details of the panelled, glazed and wire 
gauge door as per the drawing Fig 1 using various 
commands in AutoCAD.

2	 Draw half elevation with wire gauge and the balance 
half with panelled and glazed Fig 1.

3	 Develop the vertical section and horizontal section 
and complete the drawing.

4	 Take a print in A3 size paper.
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Construction	 Exercise 1.8.47
Interior Design & Decoration - Joinery Details and Paints

Model of carpentry joints, demonstration of stair case
Objectives: At the end of this exercise you shall be able to
•	identify basic carpentry joints
•	 identify the joints for specific uses
•	 demonstrate the stair case.

PROCEDURE
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TASK 1: Identify the basic carpentry joints

2	 Get it checked by the instructor

3	 Record it table 1

TASK 2: Demonstration of stair case

Instructor shall display and demonstrate to 
the students regarding the stair case with 
help of respective models and brief their 
name and use.

1	 Trainees will note down all the displayed stair case 
parts name and uses.

Instructor shall display and demonstrate to 
the students regarding the basic joints related 
with contruction work.

1	 Trainees will note down all the displayed joint name 
and uses.

Table 1
Identify the joint

	 Fig No. 1	 Name of the joint	 Uses
	 a
	 b
	 c
	 d
	 e
	 f
	 g
	 h
	 i

2	 Get it checked by the instructor

3	 Record it Table 2
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Skill sequence

Specific use of carpentry joints related with construction work
Objective: 
•	 name and use of joint in building work.

1	 Mortise and tenon joint used in framed doors, frames 
for cabinets.

2	 Stub mortise and tenon joint used in framed lock rail 
for doors and furniture.

3	 Double mortise and tenon joint used in framed 
bottom rail for doors.

4	 Task tenon and mortise joint used in framed by 
wooden floors and furniture.

Table 2
Identify the stair case parts name (Fig 1)

	 Part No.	 Name of the part	 Uses
	 1
	 2
	 3
	 4
	 5
	 6
	 7
	 8
	 9
	 10
	 11
	 12
	 13
	 14
	 15
	 16

5	 Hunched mortise and tenon joint used in framed by 
top rail for doors and table.

6	 Dove tail joint used in framed by door frame and 
table, drawer.

7	 Rebated, tongue and groove joint used in framed by 
ledged doors and table top.

8	 Table scraf joint used in hand rail and roof.

Refer the details of stair case in the Exercise. No: (1.4.25 to 1.4.27)
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Construction	 Exercise 1.8.48
Interior Design & Decoration - Joinery Details and Paints

Practicing process & techniques of paints, polishing & varnishing on surfaces 
use power point skill presentation
Objectives: At the end of this  exercise you shall be able to
•	 practice the process of painting techniques
•	 practice the process of polishing & varnishing on surfaces
•	 prepare the power point presentatin for paint, polish and varnish.

TASK 1: Slide preparation for painting

PROCEDURE

Generate power point presentation refer to -  Exercise No. 1.5.36 and 1.5.37

Slide 1

Slide 2

Slide 3 
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Slide 4  

Slide 5  

Slide 6  

Slide 7  Slide 11  

Slide 8  

Slide 9  

Slide 10  
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Slide 15  

Slide 1  

Slide 2  

Slide 3

Slide 4

Slide 12  

Slide 13  

Slide 14  

TASK 2: Slide preparation for Polishing
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TASK 3: Slide preparation for Varnishing

Slide 5  

Slide 6  

Slide 7  

Slide 8

Slide 9

Slide 1  Slide 2
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Slide 3  Slide 4

Slide 5

Here the below link you can download and view the above PPT slideshow

https://www.nimilearningonline.in/ppt/interior_2sem_2.5.46.ppsx
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Construction	 Exercise 1.8.49
Interior Design & Decoration - Joinery Details and Paints

Recognize the tool & equipments uses in paints
Objective: At the end of this  exercise you shall be able to
•	 name the basic tools used in painting.

PROCEDURE

Basic painting tools and uses, generate power point presentation refer Exercise 1.8.48

Sl.No. Tool Name Figure of tool Uses

1 Paint brushes Handle the painting part

2 Paint roller Used to paint large are quick and evenly

3 Scraper Used to remove old wall paper and paint 
from the wood rough surfaces

4 Putty knife Used for spreading and smoothing filler

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



219

5 Plumb line 
painting tool

Used to mark a vertical guideline for tasks 
such as hanging wall covering

6 Wall paper 
brush painting 
tool

Smooth out pasted wall coverings once in 
position

7 S c i s s o r 
painting tool

Making long clean cuts in wall coverings 
small scissors used for precise cuts

8 Seam roller It is rolled along the seam between sheets 
of non textured wall covering to give a 
smooth finish

9 Paste brush Used to apply wall paper and evenly

10 Drill and drill 
bits

Used on wood surfaces masonry bits used 
for harder surface
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11 Combination 
of plier

Used to grip straighten and bend metal and 
to cut wire

12 Screw driver Used on slot head and puillips head screws

13 Cable and 
pipe detector

Used to check the water pipes, electrical 
cable in wall and prevent accidents that can 
be ex-pensive to repair work

14 Used to tackle most decorating tasks quickly 
and easily nail punch used to drive nail and 
pin heads below the surface

15 Wire brush Used to scrap rough surfaces to remove 
rust loose flakes and other debris

16 A d j u s t a b l e 
spanner

Used to tighten and loosen nuts and bolts

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.8.49
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17 Sprit level Used to test perpendicularity of wall and 
windows

18 Tape measure Used for longer measurements

19 Bench firmer 
chisel

Used for general chiseling purpose

20 Wood file Used for smoothing roughly prepared 
surfaces

21 Try square Used to check the trueness and flatness of 
surface

22 Hand saw Used for sawing light work on wood

23 Gravity feed 
gun with cup 
on top

Provides most uniform film thickness and 
obtain a smooth finish

24 T y p i c a l 
p r e s s u r e 
feed gun with 
remote cup

Used to atomise paint and apply on a 
surface
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Construction	 Exercise 1.8.50
Interior Design & Decoration - Joinery Details and Paints

Estimate quantity of materials used on surface and labour cost for painting
Objective: At the end of this  exercise you shall be able to
•	 estimate quantity of materials and labour cost for painting
•	 estimate quantity of materials and labour cost for polish and varnishing.

PROCEDURE

TASK 1: Estimate materials Quantity and Labor cost for surface painting (Fig 1)

Calculation of painting area = Height x Width = SQ Feet
100 SQ FT	 = 1 liter (Enamel paint (or 

		      Emulsion paint)
For Example wall size	 =   10’ x 20’

Area	 = 10’ x 20’ = 200 SQ ft (or)
			   = 3000x6000= 18,000,000 sq mm
			       (or) 180,000 sq cm 
200 SQ ft Emulsion paint (or) 
Enamel paint	   = 2 litres

SL NO Name of material Quantity Approximate Rate 

1 painting chopping knife 2 Nos 50 x 2   = 100

2 Emery sheet grid No: 80, 120.220 2 Nos each 10 x 6   =   60

3 Wall putty 5 kgs		     50 x 5   = 250

4 Putty knife 50 mm 100 mm	  2 Nos   	     50 x 4   = 200

5 Sponge 2 Nos 		      15 x 2   =   30

6 Wall primer or oil primer 2 litres 	      375 x 2 = 750

7 Emulsion paint or enamel paint  3 litres  	       500 x 2 = 100

8 Turpentine oil			   1 No each              50 x 2   = 150

9 Brush 2 /4  1 No each	        50 x 1   =   50

100 x 1 = 100
10 Banyan Waste 1 Kg 		          50 x 1   =   50

                                                                                                                                                      Total =    2740/-

Total materials cost = 2740/-

Cost of 
materials

Over head cost 
of material

Wags for painter 

Other 
expenses Rent, 
Electricity 
Maintenance 

Detail of the estimate 
Cost of materials	 = 2740.00

Over head 10 %	 =   274.00

Wages for painter 2 x 900	 = 1800.00

Other cost rent and Electricity	 =   150.00

Administrative cost	 =   100.00

Profit 20 %	 = 1013.00

Total prime cost  	 = 6077.00

Prime cost of selling                   	= 6077/-

	 Estimation of the prime cost approximately

Cost of
Administration

Profit 20 %

Prime cost of
selling prince

Raw material for surface
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TASK 2: Estimate the material and labour cost for polish or varnish (Fig 1)

 Name of materials Quantity Approximate rate
1 Chopping knife 1 No. 1 x 50   =     50

2 Water emery sheet (grid 80, 120, 220, 320 each) 2 Nos. each 10 x 6   =     60

3 Wood putty  1/2 kg 50 x 1/2  =     25 

4 Putty knife 50 mm, 100 mm each 2 Nos. each 50 x 2   =   100

5 Wood sealer 1 Litre 150 x 1 =   150

6 Polish wood 1 Litre 200 x 1 =   200

7 Cotton waster ½ kg 100 x 1 =   100
8 Brush 50 mm, 25 mm each 1 No. 50 x 2   =   100
9 Thinner 1½ kg 100 x 11/2 =150

10 Cotton 1/4 kg 80 x 1/4 =      20
                                                                                                                                                 Total =     955/-

				    Details of the estimate
Cost of materials         		  =   955. 00

Over head cost 10 %  		  =     96. 00

Wages for Wood polish worker 	

(1 day = 1000)						    
2 days x 1000			   = 2000. 00

Other cost rent and Electricity 	 =   150. 00

Administrative cost 		  =   100. 00 

						      = 3301. 00

Profit   20 %             	              =   660. 00

						      = 3961. 00

Prime cost of selling 	 Rs. 	 = 3961/-       

Estimation of the prime cost approximately
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Construction	 Exercise 1.9.51
Interior Design & Decoration - Civil Components (Partition)

Design the full height and low height partition wall with different construction 
and finishing material
Objectives: At the end of this exercise you shall be able to	
•	 draw the full height partition wall plan and scetion using AutoCAD
•	 draw the low height partition wall plan and section using AutoCAD.

PROCEDURE

TASK 1 : Prepare plan, section of full height aluminium partition wall as per given sketch Fig 1&2 using 		
		  AutoCAD

		                                      Data of finishing material	                                                               Part no

	 1	 44.5 x 101.6 x 1810	 Horizontal SG Top                                 1                              

	 2	 44.5 x 101.6 x 2010	 Vertical SG Allum section                      2

	 3		  44.5 x 101.6 x 1600	 Vertical DG Allum section                      3 

	 4		  44.5 x 101.6 x 440	 Horizontal DG MID Allum section          4

	 5		  44.5 x 101.6 x 320	 Vertical Allum section                            5

	 6		  44.5 x 101.6 x 1630	 Vertical DG Part section Allum              6 

	 7		  44.5 x 101.6 x 1810	 Horizontal SG Part section Allum          7

	 8		  44.5 x 101.6 x 1630	 Horizontal SG Part section Allum          8

	 9		  M8 Hex Nut STD	 As required	

	 10		 M8 STUD, STD	 As required 

	 11		  As required self tapping screw STD	 As required

	 12		 As required Self tapping screw STD	 As required

	 13		 As required equal angle 25x25x2 - Aluminium	 As required

	 14		 As required particle board 12mm STD	 As required

	 15		 As required packing rubber STD	 As required

	 16	 As required glazing clips STD	 As required

1	 Draw the plan. 

2	 Draw the aluminium partition wall plan section using 
various commands in AutoCAD.

3	 Draw the section view.

4	 Complete the drawing by printing dimension and 
other related notes.

5	 Take a print A3 size paper.
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TASK 2 : Draw the plan and section of low level partition wall with aluminium construction using AutoCAD 		
               Fig 1&2

1	 Draw the plan.

2	 Draw the low level partition wall plan and section 
using various commands in AutoCAD.

3	 Draw the section view.

4	 Complete the drawing by printing diemension and 
other related motes.

5	 Take a print A3 size paper. 	
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	  	                                       Data for finishing material	                                                         Part no

	 1	 44.5 x 101.6 x 1810	 Horizontal SG Top Allum section           1

		 2	 44.5 x 101.6 x 1630	 Vertical SG Allum section                      2

	 3		  44.5 x 101.6 x 1600	 Vertical DG Allum section                      3

	 4		  44.5 x 101.6 x 440	 Horizontal DG MID Allum section          4

	 5		  44.5 x 101.6 x 1810	 Vertical Allum section                             5

	 6		  MS Hex Nut - STD	 As required

	 7		  MS STUD - STD	 As required

	 8		  Self tapping screw STD	 As required	

	 9		  Equal angle 25x25x2 - Aluminium	 As required

	 10		 Glass 5mm STD	 As required	

	 11		  Particle board 12mm STD	 As required	

	 12		 Packing rubber STD	 As required	

		  13	 Glazing clips STD	 As required	
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Skill sequence

Aluminium partition wall
Objectives: At the end of this exercise you shall be able to
•	 identify different types aluminium partition sections used in partition frame
•	 make frames by using aluminium angles piece and screws (invisible method)
•	 fix glasses in partition frame using glazing clips and rubber packing
•	 fix particle board in partition frame by using glazing clip.

1	 Identify aluminium partition sections to make partition 
frame. (Fig 1)

2	 Mark to required length and mark with try square, cut 
exactly perpendicular, if not the squareness of the 
frame will effect.

3	 Cut the aluminium angle less than the width of the 
section.

4	 Mark centre line at B/2 and S/2 in section and angle 
piece.

5	 Mark hole centre from centre line to D/2+E/2 distance 
either side and mark from the edge of angle piece of 
R/2 distance. (Fig 2)

6	 Drill primary hole of f3 mm holes on angle piece for 
guiding self tapping screw to fix on frame sections.

Fig 1
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7	 Mark the angle position on frame section as per 
drawing.

8	 Fix angle piece on frame by self tapping screw. 
(Fig 3)

9	 Insert joining member as shown in Figure. (Fig 4)

10	The angle piece will be inside the joining member 
and fixed by self tapping screws as shown.

11	Similarly assemble all section members to complete 
frame structure.

12	Fix the partition frame on to wall and floor by grouting.

Thus angle pieces will not be visible and only heads of 
the screws will appear from outside.

Now assemble glazing clips on both the grooves of the 
bottom partition first and only one glazing clips on one 
side groove of the remaining three sides.

Apply rubber adhesive in the middle slot of the rubber 
packing and insert it in the edges of the required size 
glass as supplied.

Hold the glass alongwith the rubber packing vertically 
above the gap between two glazing clips and press it 
down against the glazing clips till it rests on the collar of 
the rubber packing. (Fig 5)

Now fix the glazing clips on the other groove of the top 
section so that the glass remains in vertical position.

Finally fix the glazing clips on other groove of sections 
on sides similarly.

Particle board (Novapass) is to fixed between glazing 
clips, rubber packing is not required. You can fix the 
particle board on partition with glazing clips as described 
above.
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Construction	 Exercise 1.9.52
Interior Design & Decoration - Civil Components (Partition)

Draw plan, Sectional plan front elevation of block board partition wall with 
specification and dimension
Objectives: At the end of this exercise you shall be able to	
•	 draw the elevation section, block board partition wall
•	 draw the wooden panelling with specification and dimension using auto CAD.

PROCEDURE

TASK 1 : Draw the plan, section and elevation of block board partition wall with specification and 		
	             dimension using AutoCAD (Fig 1)
Specification and dimension:
Vertical corner ground wooden pieces	 = 5x5cm
Vertical middle wooden pieces	 = 10x5cm
Horizontal top and bottom wooden		
pieces	 = 5x5cm
Horizontal middle wooden pieces	 = 10x5cm
Block boards		
	                                                         = 100x40x2cm
1	 Draw to scale 1:20 (or) 5 cm = 1 meter as shown, 

otherwise choose any convenient scale.

2	 Draw block board partition using various commands 
is AutoCAD refer to Ex.No. 1.7.41

3	 First draw the front elevation, then the plan and 
the cross-section taking the help of orthographic 
projections.

4	 Take the outer dimensions of widthxheight = 300x300 
cm. then draw the inner parts.

5	 The dotted lines in the elevation show the framework 
for panelling.

6	 Complete the drawing by printing dimension and other  
related.

7	 Take print A3 size paper. 

Fig 1
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TASK 2: Draw wooden panelling which is a slap type of partition, using assumptions and proper                                                                                                                                           
                 dimensions (Fig 1)

Specification and dimension
Room size		  = 300cm width and 200cm height.

Particle board 	 = 185x90x1cm thick.

Bead			   = 2.5x2.5cm

Wooden stud	 = 10x5

1	 Draw to scale1:20 (or) 5 cm=1 meter as shown 
otherwise choose any convenient scale.

2	 Draw the slap type partition, plan, elevation and cross 
section using various commands in AutoCAD.

3	 First draw the front elevation, then the plan and 
the cross-section taking the help of orthographic 
projections.

4	 Draw the outer dimensions of widthxheight=300x200 
cm. and draw the inner parts.

5	 Complete the drawing by printing dimension and other 
related motor.

6	 Take a print A3 size paper.
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Construction	 Exercise 1.10.53
Interior Design & Decoration - Plumbing and Sanitation, Lighting, Electrical & 
Air Conditioning

Layout the plumbing/Drainage/Sanitary plan
Objectives: At the end of this exercise you shall be able to
•	draw layout the plumbing and drainage plan using AutoCAD
•	 draw sanitary plan using AutoCAD
•	 understand the different waste disposal systems.    

PROCEDURE

Draw the details of the different types buildings layout the plumbing / drainage / sanitary plan as per 
drawing TASK 1 to TASK 8 using AutoCAD. Take a print in A4 size paper

TASK 1 : Prepare the detailed plan of plumbing layout through AutoCAD. (Fig 1)

1		 Line sketch showing arrangements of pipe line
2		 Give standard dimensions for the building elements

3		 Develop the working plan of plumbing layout through 
AutoCAD.
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TASK 2 : Draw the drainage pipes in the proper sequence as well as expand the abbreviations and mention 	
  the (a) diameter of pipes (b) Source of water - sanitary water supply. (Fig 1)

1		 Prepare the details of drainage layout as per given 
drawing using AutoCAD.

TASK 3 : In the given drawing of 2BHK flat, the 1) Sewage pipes 2) Water distribution pipes (Fig 1).

1		 Draw the layout and plan of task 3 to 8 showing all 
details as per given using AutoCAD.

2		 Mark the dimensions and complete the drawing.

TASK 4 : Draw a section of typical WC showing the pipe layouts data has to be taken from the figure below. 
(Fig1)
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TASK 5 : Draw the given figure. Use the color codes and represent a) Fresh water inlet pipe b) Waste water 		
		  pipe. (Fig 1)

TASK 7 : Identify vent pipe, soil branch, water closet, clean outs and main in given figure of soil pipe layout	.	
	            Draw the given figure, layout of soil pipe. (Fig 1) 

1 		 Draw the topmost pipe which branches out is known 
as vent pipe and its branch as vent branch.

2 		 Draw the pipe when goes underground it joins the 
main sewer and clean out is associated with it.

TASK 6 : Draw the representation of soil pipe, mention its (a) color code (b) diameter of pipe. (Fig 1)
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TASK 8 : Draw the residence drainage plan. It is assumed that the drainage and sewer lines are combined. 
(Fig 1) (Note - Use the suitable symbols for plumbing)

Laying of rain water pipe
Objectives: At the end of this exercise you shall be able to
•	 fix rain water pipe (PVC).

1 		 Measure and mark out the centre line of the pipe by 
chalk line and plumb.Fig.1.

2 		 Check the pipe, bend, shoe for visible defects.

3 		 Fix the brackets at required length.

4 		 Take the measurements of pipe line considering the 
bend will be inserted in pipe and shoe will be atleast 
50mm above the ground formation level.

5 		 Make hole in parapet wall larger than bend’s outside 
diameter.

6 		 Fix the bend in concrete 1:2:4 at the hole.

7 		 Cure the concrete.

8 		 Joint pipes from bottom of bend.

9 		 Fix brackets loosely.

10 	Fix shoe to pipe and bracket.

11 	Test verticality of pipe with plumb bob.
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Construction	 Exercise 1.10.54
Interior Design & Decoration - Plumbing and Sanitation, Lighting, Electrical & 
Air Conditioning

Make top plan, side & front elevation of santitary fittings with dimension
Objectives: At the end of this exercise you shall be able to
•	 draw the different sanitary fittings in building using AutoCAD
•	 draw the arrangement of sanitary fittings in toilet and bathroom.

TASK 1 : Draw the detailed drawings of the sanitary fittings in toilet and bathrooms (Fig 1) 

1 		 Draw the details of sanitary fittings as per given 
drawing using AutoCAD and take a print in A3 size 
paper.

PROCEDURE
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TASK 2 : Prepare the drawing showing the arrangement of sanitary fittings in toilet and bathrooms                                    	
  (Fig 1 to 17) 

1		 Draw the plan of toilet with (1) ordinary W.C and 
(2) European W.C (3), bathroom with separate 
W.C (4) combined bath and W.C (5) public levatory 
showingall details as per given drawing using Auto 
CAD.

2		 Show the arrangement of sanitary fittings in the plan.

3		 Mark the dimensions and complete the drawing.

4		 Take a print in A3 size paper.
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Construction	 Exercise 1.10.55
Interior Design & Decoration - Plumbing and Sanitation, Lighting, Electrical & 
Air Conditioning

Free hand sketches of graphic symbols for plumbing
Objectives: At the end of this exercise you shall be able to
•	 draw free hand sketches of graphical symbol of plumbing using CAD
•	 draw with dimensions approximate.

PROCEDURE

TASK 1 : Draw the plumbing symbol given below using CAD (Fig 1) 
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TASK 2 : Draw and write the correct name of given plumbing symbol (Sl.No 1 to 18) 

	 Sl.	 Symbol	 Name of plumbing	
	 No.		  Fixture

	 Pumps symbol

	 Sl.	 Symbol	 Name of plumbing	
	 No.		  Fixture	
	

Compressed 
Symbol

Tank symbol

	 Heat Exchanger 
symbol

	 1

	 2

	 3

	 4

	 5

	 6

	 7

	 8

	 9

	 10

	 11

	 12

	 13

	 14

	 15

	 16

	 17

	 18
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Construction	 Exercise 1.10.56
Interior Design & Decoration - Plumbing and Sanitation, Lighting, Electrical & 
Air Conditioning

Layout plan of false ceiling with lighting position
Objective: At the end of this exercise you shall be able to	
	• draw paln of false ceiling layout and lighting position using AUTOCAD.

PROCEDURE

Draw the layout plan of the false ceiling layer with lighting position using CAD (Fig 1)
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DATA
Sizes of rooms are given in the plan
Draw the layout of the plan

Draw the false ceiling layout

Draw the lighting position

Setp 1:	 Open the AutoCad software.

Step 2: 	 Draw the building outline of the office by using 
the “Line” command.  Click the “Line” icon to 
activate the command.  Left -click to start and 
end the line.

Step 3: 	 Offset the building outline the desired 
thickness of the exterior wall.  Use the “Offset” 
command.

Step 4: 	 Draw all interior walls by using the same “Line” 
and “Offset” commands.

Step 5: Use the “Trim” command to trim any messy 
intersections on the exterior or interior 
conditions.  Left-click the “Trim” icon to activate 
the too.  Select the “cutting edge” line followed 
by the line that you would like to trim off.

Step 6: 	 Cut openings for doors and windows by 
drawing lines and then trimming away the 
opening.

Step 7: 	 Draw the doors and windows where the new 
openings exits.

Step 8:	 Activate the text command to enter the names 
of rooms and their sizes.

Step 9: Activate the dimension icon and click the 
edges of each wall that you would like to 
dimension to.  This will give the drawing a 
more professional look and also gives people 
a sense of the space.

Step 10:	 Insert the false ceiling design and lighting 
position and prepare the details.

Step 11:	 Using ploylne command draw a line over the 
outer wall and using area command find the 
area of the building.

Step 12:	 Plot the drawing to a printer or ta a PDF 
format.  Hit the plot icon to open the plot 
settings. Choose the layout type, pen settings, 
and window view that you would like to use.

Step 13:  Print the layout plan in A3 size paper.  
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Construction	 Exercise 1.10.57
Interior Design & Decoration - Plumbing and Sanitation, Lighting, Electrical & 
Air Conditioning

Layout of electrical Accessories plan & elevation
Objective: At the end of this exercise you shall be able to	
	• draw paln and elevation of electrical layout.

PROCEDURE

TASK 1: Draw the layout of electrical accessories plan & elevation using AutoCAD
Draw the electrical layout as given in Fig 1 using 
AutoCAD with proper scale and take the print of layout 
plan in A3 size paper.
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Data
Switch boxes

Ceiling light

Local area network

Back light

Closed circuit television

Tube light

1		 Draw the plan

2		 Draw the symbols of fittings

3		 Draw the summarise the points of electrical fittings

LEGEND
S.No Particulars Short form
1 Switch box SB
2 Ceiling light CL
3 Local area network LAN
4 Back light BL
5 Closed circuit television CCTV
6 Fan F
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Construction	 Exercise 1.10.58
Interior Design & Decoration - Plumbing and Sanitation, Lighting, Electrical & 
Air Conditioning

Free hand sketches of graphic symbols for electrical
Objectives: At the end of this exercise you shall be able to
•	 draw free hand sketches of electrical symbol using CAD
•	 draw with dimensions approximate.

PROCEDURE

Draw the details of the different types of electrical graphic symbols as per drawing Task 1 to Task 4 
using AutoCAD. Take a print in A4 size paper.

TASK 2 : Draw additional electrical symbols  

TASK 1 : Draw basic electrical symbols  

	 1

	 2

	 3

	 4

	 5

	 6

	 7

	 8

	 9

	 10

	 Sl.No.	 Symbol
	 1	 Switch  (Open)

	 2 	 Switch (Closed)

	 3	 Push-Button Switch

	 4	 Resistor

	 5	 Capacitor

	 6	 Diode

	 7	 LED

	 8	 Transistor

	 9	 Battery

	 10	 Cell

	 1

	 2

	 3

	 4

	 5

	 6

	 7

	 8

	 9

	 10

	 11

	 12

	 13

	 14

	 Sl.No.	 Symbol
	 1	 Wire

	 2 	 Ground

	 3	 Fuse

	 4	 Circuit Breaker

	 5	 Inductor

	 6	 Transformer

	 7	 Relay

	 8	 Power Source

	 9	 Bell

	 10	 Buzzer

	 11	 Lamp

	 12	 Loudspeaker

	 13	 Antenna

	 14	 Generator
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TASK 3 : Draw electrical and electronic symbols  

TASK 4 : Draw electrical symbols related with lighting  

	 1

	 2

	 3

	 4

	 5

	 6

	 7

	 8 

	 9

	 10

	 11

	 12

	 Sl.No.	 Symbol
	 1	 Diode

	 2 	 Capacitor

	 3	 Inductor

	 4	 Resistor

	 5	 DC voltage source

	 6	 AC voltage source

	 7	 And gate

	 8	 Nand gate

	 9	 Or gate

	 10	 Nor gate

	 11	 Xor gate

	 12	 Inverter (Not gate)
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Construction	 Exercise 1.10.59
Interior Design & Decoration - Plumbing and Sanitation, Lighting, Electrical 
& Air Conditioning

Layout plan of window and split A/C with Specification 
Objectives: At the end of this exercise you shall be able to
•	 draw layout plan of window A/C using AutoCAD	 	
•	draw layout plan of split A/C using AutoCAD
•	 specification of window A/C and split A/C.

PROCEDURE

TASK 1 : Draw diagram for air conditioning cycle with the help of requirements given below data.

1		 Draw the details of air conditioning cycle as per 
given drawing using auto CAD and take a print in A4 
size paper.

TASK 2 : Draw the cycles of operations in air conditioning with suitable parts (summer AC/winter AC).

1		 Draw the details of cycles of operations in air 
conditioning as per given drawing using AutoCAD 
and take a print in A4 size paper. (Fig 1)

1 2 3

456

7

1. Cleaning of air
2. Cooling or heating of air
3. Humidification or dehumidification of air
4. Circulation of air through ducts
5. AC space
6. Foul air taken by exhaust fans
7. Mising of outside air and used air 
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TASK 3 : Prepare the detailed lay out of the window A/C.

1		 Draw the layout of window A/C as per given Fig 1 
with proper scale and all details using AutoCAD and 
take a print in A4 size paper.

TASK 4 : Prepare the detailed layout of the split A/C.

TASK 5 : Specification of window and split A/C 

1		 Draw the layout of split A/C as per given Fig 1 and 
with proper scale all details using AutoCAD and take 
a print in A4 Size paper.

Specification of window A/C.
Cooling capacity of window AC

Ton of AC Compressor Kilo Calorie Fan motor HP Room temperature

0.5

1.0

1.5

2.0

0.75

1.5

2.0

2.5

6000 BTU/Hr

12000BTU/Hr

18000BTU/Hr

24000BTU/Hr

1/32 HP

1/16 HP

1/5 HP

1/5 HP

72°F

72°F

72°F

72°F
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For 1 ton window A/C

Name of window AC Heigth Length Breadth Grill temp. Room temp

Usha AC

Feddars AC

Kelvinator AC

GE AC

Voltas AC

47 cm

45 cm

48 cm

48 cm

47 cm

70 cm

68 cm

72 cm

72 cm

70 cm

55 cm

52 cm

55 cm

55 cm

52 cm

58°F

56°F

58°F

58°F

56°F

72°F

70°F

72°F

72°F

70°F

Technical specifications of split air-conditioner 

Cooling capacity

TR 1.0 1.5 2.0

BTU/Hr. 12000 18000 24000

Kcal/Hr. 3000 4500 6000

Power spply
Volt

Phase
Cycle

230
1
50

230
1
50

230
1
50

Power input Watts 1140 1850 2470

Running current Amps 6.0 8.5 11.0

Energy Efficient 
Ratio

BTU/W 10. 9.7 9.7

Air circulation at high 
speed

M3/min
CFM

10M3/min
350

13
450

15
525

Thermosensor Theromostat

Condenser & evapo-
rator

H.P
Mfd

1/6
2.5

1/5
2.5

1/4
4

Compressor Type Rotary
Reciprocating

Rotary
Reciprocating

Reciprocating

Refrigerant R22 R22 R22

Cooling unit fan 
speed-mode

3 3 3
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Construction	 Exercise 1.11.60
Interior Design & Decoration - Commercial Interior Guidelines and Design

Office design layout plan
Objective: At the end of this exercise you shall be able to	
	• draw plan of the office layout using AutoCAD.

PROCEDURE

TASK 1 : Draw the plan of office layout with required measurements through AutoCAD (Fig 1 & 2)
1		 Draw the office plan.
2		 Draw the ground floor plan and first floor plan of the 

office building using AutoCAD.
3		 Complete the layout plan by printing dimension and 

other related notes. 

Step 1  :	 Open the AutoCad software.
Step 2  : 	Draw the building outline of the office by using 

the “Line” command.  Click the “Line” icon to 
activate the command.  Left -click to start and 
end the line.
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Step 3 : 	 Offset the building outline the desired 
thickness of the exterior wall.  Use the “Offset” 
command.

Step 4 : 	 Draw all interior walls by using the same “Line” 
and “Offset” commands.

Step 5 : Use the “Trim” command to trim any messy 
intersections on the exterior or interior 
conditions.  Left-click the “Trim” icon to activate 
the too.  Select the “cutting edge” line followed 
by the line that you would like to trim off.

Step 6  : 	Cut openings for doors and windows by 
drawing lines and then trimming away the 
opening.   If you want a 3’-0” door (90 cm), 
draw a line perpendicular to the wall, set it 
3’0”, and trim way the excess lines.

Step 7  : 	Draw the doors and windows where the new 
openings exits.

Step 8   :	Activate the text command to enter the names 
of rooms and their sizes.

Step 9 : Activate the dimension icon and click the 
edges of each wall that you would like to 
dimension to.   This will give the drawing a 
more professional look and also gives people 
a sense of the space.

Step 10 :	Using ploylne command draw a line over the 
outer wall and using area command find the 
area of the building.

Step 11 :	Plot the drawing to a printer or to a PDF 
format.   Hit the plot icon to open the plot 
settings. Choose the layout type, pen settings, 
and window view that you would like to use.

Step 13 :	Take printout in A3 size paper.
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Office elevations
Objective: At the end of this exercise you shall be able to	
	• draw elevations of the office using AutoCAD.

TASK 1 : Draw the office elevations using AutoCAD (Fig 1)

1		 Draw the elevation of the office building using 
AutoCAD.

2		 Complete the drawing by printing dimension and 
other related notes.

3		 Draw the base line to draw the elevation of the office.

4		 Draw the projected lines from the plan to create front 
view of the office using line command.

5		 Draw the elevation of the office using modify 
commands like offset, trim, fillet, extend to complete 
the outline.

6		 Using block, insert block commands prepare the 
doors and windows in elevation.

7		 Assign proper line weights to create the effective 
apperance of the building.

8		 Plot the drawing to a printer or to a PDF format. Hit 
the plot icon to open the plot settings. Choose the 
layout type, pen settings and windows view that you 
would like to use.

9		 Take print in a A3 size sheet.
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TASK 2 : Draw the section of the office using AutoCAD (Fig 1)

1		 Draw  the section view

2		 Draw the section of the office building as shown in 
Fig 1 through AutoCAD.

3		 Draw the section of the office

4		 Draw the base line to draw the section in the plan, 
the width of walls, rooms has to be drawn according 
to the disign using line, offset, trim commands.

5		 Use the hatch commands to show the R.C.C. rubble 
masonry in the section.

6		 Activate the text commands for mentioning the name 
and size of the rooms.

7		 Using dimension command complete the 
dimensioning of the section drawing.

8		 Plot the drawing to a printer or to a PDF format. Hit 
the plot icon to open the plot settings. Choose the 
layout type, pen settings and windows view that you 
would like to use.

9		 Take printout in A3 size paper.
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TASK 3 : Draw the sectional elevation of the chairman cabinet from the plan. Using AutoCAD
1 		 Draw the plan given of the chairman cabinet.
2 		 Draw the sectional line AA’ and BB’ in the plan 

(vertually, horizontally).(Fig 1)
3 		 Draw sections with required details and measurement 

in required scale using various commands in 
AutoCAD.

4		 Complete the drawing by printing dimension and 
other related notes

5		 Take printout in A3 size paper.

		  Dimensions have to be assumed.
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Construction	 Exercise 1.11.61
Interior Design & Decoration - Commercial Interior Guidelines and Design

Working details to furniture layout of office design project
Objective: At the end of this erercise you shall be able to	
	• office design furniture details and electrical using AutoCAD.

PROCEDURE

TASK 1 : Draw the Furniture layout using AutoCAD

1		 Prepare the office furniture layout showing all details 
as per given Fig 1 and 2 through AutoCAD.

2		 Mark the dimensions complete the layout plan

3		 Take a print on A3 size paper.
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TASK 2 : Draw the layout plan of false ceiling with lighting position (Refer to exercise no. 1.10.56)  using 		
          AutoCAD

TASK 3 : Draw the electrical layout through AutoCAD (Refer to exercise no. 1.10.57)

Construction : Interior Design & Decoration  (NSQF - Revised 2022) - Exercise 1.11.61
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Construction	 Exercise 1.11.62
Interior Design & Decoration - Commercial Interior Guidelines and Design

Free hand sketch for office design project details
Objective: At the end of this exercise you shall be able to	
	• understand theory of furnishing fabric upholster.

PROCEDURE

TASK 1 : Draw the freehand sketch of  typical furniture used in office (Fig 1)

Data has to be assumed
Assumption
The modular sections vary depending upon the 
manufacturing company. The particular unit is made 
for using a computer and working space. This metal 
modular furniture is made of the following.

1 		 Hollow corner section of 5x5 cm.

2 		 Hollow square tubes of 60x5 cm. and 90x5cm with  
provision for fixing fascia tiles and electrical wiring.

3 		 Separate drawers & shelves unit 75 cm. height, 
which can be fixed to the hollow sections.

4 		 Separate worktops of 1cm. thickness, which can be 
fixed to the hollow sections.

5 		 The entire unit is fixed with standard screws and 
metal angles.

Drawing  method
Steps
1 		 Draw to scale : 1:20 (or) 5 cm = 1 meter as shown 

otherwise choose any convenient scale.

2 		 The drawing is in isometric view using CAD.

3 		 First, draw the modular frame as shown in 
isometric view. The inner lines are shown for proper 
understanding of the frame. The corners are of 
standard size.

4 		 Then, draw the assembled unit with fascia tiles, 
workshop and shelves. The height of the workshop 
is 75cm. The width of the trawers and shelves is 50 
cm.
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		  Style and theme depends on the students 
creativity and requirements

1		 Students creativity matters based on their 
understanding of furniture styles.

2 		 Prepare the drawing sheet (A2) by given figures in 
sequence.

3 		 Use drawing pencil (HB) to draw the given figures in 
a sketch format.

TASK 2 : Design furniture for an antique shop located in your area

4 		 Ensure that the drawn figure is proportionate. (i.e) 
neither very big or nor very small)

		  Note: While drawing ensure that 30cm sale is 
not used to draw the figures instead it should 
be done roughly with bare hand. (Figs 1 & 2)

TASK 3 : Draw any four type of window treatments (blends) used in interiors.

1		 Draw the diagrams as given in the Fig 1 (Freehand 
sketches).
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Construction	    Exercise 1.11.63
Interior Design & Decoration - Commercial Interior Guidelines and Design 	   

Rendering with Gradient & Hatches
Objectives : At the end of this exercise you shall be able to
•	 render with gradient
•	 render with hatches.

A gradient fill is a solid hatch fill that gives the blended 
color effect of a surface with light on it.  The color in 
gradient fill makes a smooth transition from light to dark 
or from dark to light. 

In a two color gradient fill the color with the transition 
from light color to dark and from first color to the second 
color.  The hatch and gradient dialog box includes the 
same options.

The following options are only for gradient tab.

Color: Specifies whether to fill the hatch boundary with 
a monochromatic or two-color blend.

One color: Specifies a fill that uses a smooth transition 
between a color and a specified tint (the color mixed with 
white) or between a color and a specified shade (the 
color mixed with black).  (GFCLRSTATE system variable)

Two color: Specifies a fill that uses a smooth transition 
between two colors.  (GFCLRSTATE system variable)

Color swatches: Specifies the colors for the gradient fill 
(either one color or two colors).  Click the browse button 
[...] to display the select color dialog box, where you can 
select an AutoCAD color index (ACI) color, true color, 
or color book color.  (GFCLR1 and GFCLR2 system 
variables)

Shade and tint slider: Specifies the tint (the selected 
color mixed with white) or shade (the selected color mixed 
with black) of a color to be used for a gradient fill of one 
color. (GFCLRLUM system variable)

Gradient patterns: Displays fixed patterns for gradient 
fills.  These patterns include linear sweep, spherical, 
and parabolic.

Orientation: Specifies the angle of the gradient and also 
whether it is symmetrical.

Centered: Specifies a symmetrical gradient configuration.  
If this option is not selected, the gradient fill is shifted up 
and to the left, creating the illusion of a light source to the 
left of the object.  (GFSHIFT system variable)

Angle: Specifies the angle of the gradient fill.  The 
specified angle is relative to the current UCS.  This option 
is independent of the angle specified for hatch patterns.  
(GFANG system variable) (Fig 1).

TASK 2 : Creat the image by using gradient

Consider the below image Fig 1.

Step 1: 	Select the gradient icon from the drop-down list 
of the hatch.

PROCEDURE

TASK 1 : Gradient

	 Command alias	 Button	 Classic menu
	 Gradient		  Draw => Gradient

Step 2: 	Pick internal points of any object or select 
objects. Here, we have picked an internal point 
outside the circle.

Step 3: A gradient will be created inside the rectangle, 
as shown below Fig 2.

Lets consider another gradient pattern. It will look like 
the below image Fig 3.

We can also select the desired patterns from the list of 
patterns as shown below Fig 4.
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TASK 3 : Hatch

	 Command alias	 Button	 Classic menu	 Ribbon/application menu
	   H	 Draw => Hatch	 Home => Draw => Hatch

Fig 4

Fig 1

Drafters and designers use repeating patterns called 
hatching to fill regions in a drawing for various purposes.  
In a cross section view hatch patterns helps the viewer 
differentiate between components of an assembly and 
indicate the material of each.

The following options are displayed. (Fig 1)

Type and pattern: Specifies the hatch’s type, pattern, 
color, and background color.

Type: Specifies whether to create a predefined, user-
defined, or custom hatch pattern.

Predefined patterns are stored in the acad. pator acadiso.
pat  files supplied with the program.

User-defined patterns are based on the current linetype 
in your drawing.  A custom pattern is a pattern that is 
defined in any custom PAT files that you have added to 
the search path.

Pattern: Displays a selection of ANSI, ISO, and other 
industry-standard hatch patterns.  Select SOLID to create 
solid fill.  The pattern option is available only when type 
is set to predefined. (HPNAME system variable)

[...] Button

Displays the hatch pattern palette dialog box, in which 
you can preview images for all predefined patterns.

Color
Overrides the current color with a specified color for hatch 
patterns and solid fills.  (HPCOLOR system variable)

Background color:Specifies the background color 
for new hatch objects.  Choose none to turn off the 
background color.  (HPBACKGROUND COLOR system 
variable)

Swatch:Displays a preview of the selected pattern.  Click 
the swatch to display the hatch pattern palette dialog box.

Custom pattern:Lists the available custom patterns.  
The most recently used custom patterns appear at the 
top of the list.  The custom pattern option is available only 
when type is set to custom. (HPNAME system variable)

[...] Button:Displays the hatch pattern palette dialog box, 
in which you can preview images for all custom patterns.

Angle and scale:Specifies an angle and scale for the 
selected hatch pattern.

Angle: Specifies  an angle for the hatch pattern relative to 
the X axis of the current UCS.  (HPANG system variable)

Scale:Expands or contracts a predefined or custom 
pattern.  This option is available only when type is set 
to predefined or custom.  (HPSCALE system variable)

Double: For user-defined patterns, draws a second set 
of lines at 90 degrees to the original lines, creating a 
crosshatch.  This option is available only when type is set 
to user defined.  (HPDOUBLE system variable)

Relative to paper space: Scales the hatch pattern 
relative to paper space units.  This allows you to display 
hatch patterns at a scale that is appropriate for your 
named layout.  This option is available only from a named 
layout.
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Spacing: Specifies the spacing of lines in a user-defined 
pattern.  This option is available only when type is set to 
user defined.  (HPSPACE system variable)

ISO pen width: Scales an ISO predefined pattern based 
on the selected pen width.  This option is available only 
when type is set to predefined and pattern is set to one 
of the available ISO patterns.

Hatch origin: Controls the starting location of hatch 
pattern generation.  Some hatches, such as brick 
patterns, are meant to be aligned with a point on the 
hatch boundary.  By default, all hatch origins correspond 
to the current UCS origin.

Use current origin: Uses the hatch origin point stored 
in the HPORIGIN system variable.

Specified origin: Assigns a new hatch origin using the 
following options.

Click to set new origin: Specifies the new hatch origin 
point directly.

Default to boundary extents: Calculates a new origin 
based on the rectangular extents of the boundary for the 
hatch object.  Choices include each of the four corners 
of the extents and its center.  (HPORIGINMODE system 
variable)

Store as default origin: Stores the value of the new 
hatch origin in the HPORIGIN system variable.

Boundaries: The following options are displayed.

Pick points: Determines a boundary from existing 
objects that form an enclosed area around the specified 
point.  While picking internal points, you can right-click in 
the drawing area at any time to display a shortcut menu 
that contains several options.

Select: Determines a boundary from selected objects 
that form an enclosed area.

When you use the select objects option, interior objects 
are not detected automatically.  You must select the 
objects within the selected boundary to hatch or fill 
those objects according to the current island detection 
style.  Each time you click select objects, hatch clears 
the previous selection set.  While selecting objects, you 
can right-click at any time in the drawing area to display 
a shortcut menu.  You can undo the last selection or all 
selections, change the selection method, change the 
island detection style, or preview the hatch or gradient fill.

Remove: Removes from the boundary definition any of 
the objects that were added previously.

Recreate: Creates a polyline or region around the 
selected hatch or fill, and optionally associates the hatch 
object with it.

Display boundary objects: Displays the boundary grip 
controls for the selected hatch so that you can use to 

grip-edit both the boundary and the hatch object.  When 
you select or use the display boundary objects option 
to select a non-associative hatch, the hatch boundary 
grips are displayed.

When you select an associative hatch, it displays only a 
single grip point of the hatch.  To display the boundary 
grip controls of the objects associated with the hatch, 
use the display boundary objects option.  You can only 
edit an associative hatch by grip-editing the associated 
boundary objects.

Options: Controls several commonly used hatch or fill 
options.

Annotative: Specifies that the hatch is annotative.  This 
property automates the process of scaling annotations so 
that they plot or display at the correct size on the paper.  
(HPANNOTATIVE system variable)

Associative: Specifies that the hatch or fill is associative.  
A hatch or fill that is associative is updated when you 
modify its boundary objects.  (HPASSOC system variable)

Create separate hatches: Controls whether a single 
hatch object or multiple hatch objects are created when 
several separate closed boundaries are specified.  
(HPSEPARATE system variable)

Draw order: Assigns a draw order to a hatch or fill.  You 
can place a hatch or fill behind all other objects, in front 
of all other objects, either behind the hatch boundary, 
or in front of the hatch boundary.  (HPDRAWORDER 
system variable)

Layer: Assigns new hatch objects to the specified layer, 
overriding the current layer.  Select use current to use 
the current layer.  (HPLAYER system variable)

Transparency: Sets the transparency level for new hatch 
or fills, overriding the current object transparency.  Select 
use current to use the current object transparency setting.  
(HPTRANSPARENCY system variable).

Inherit properties: Hatches or fills specified boundaries 
using the hatch or fill properties of a selected hatch 
object.  After selecting the hatch object whose properties 
you want the hatch to inherit, right-click in the drawing 
area and use the options on the shortcut menu to switch 
between the select objects and pick internal point options.  
The HPINHERIT system variable controls whether the 
hatch origin of the resulting hatch is determined by 
HPORIGIN or by the source object.

Islands: Specifies the methods used to hatch or fill 
boundaries within the outermost boundary.

Island detection: Controls detection of internal 
c losed boundar ies ,  a lso  ca l led  as  is lands. 
(HPISLANDDETECTIONMODE system variable).

i	 Select ANS132 hatch and click ok (Fig 2 & FIg 3).

ii	 Specify the scale as 25.

iii	 Choose add pickpoints and click the internal points 
of walls.
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TASK 4 : Create the image by hatch command

Fig 2

Fig 5

Fig 6

Consider the below image Fig 1.

Step 1:  The steps to fill hatch pattern are listed below
	 Select the hatch icon from the ribbon panel, as 

shown in the below image Fig 2.Type on the 
command line or command prompt and press 
Enter.

Step 2:  Pick internal points of any object 
	 or 
	 select

Here, we have picked an internal point inside a circle. 
We can click any point inside a circle.

A batch pattern will be created inside the circle, as shown 
below Fig 3.
To modify the lines we have increased the hatch pattern  
scale. The Fig 4 will now appear as Fig 4.
We can also select the desired patterens from the list of 
patterns, as shown below Fig 5.

The greater like hatch pattern scale, the higher will be the 
distance between the lines in the hatch pattern.
When we click on the arrow near the hatch icon, a  
drop-down list appears, as shown in the below image 
Fig 6.
Boundary: The boundary command creates a separate 
region or polyline from the enclosed area.

Fig 2 Fig 3
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